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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully
complying with safety standards. To maintain this condition and to ensure safe operation, you must
observe all instructions and warnings provided in this manual. If you have any questions regarding these
safety instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions
and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product"” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories. For product-specific
information, see the data sheet and the product documentation.

Safety labels on products

The following safety labels are used on products to warn against risks and dangers.

Symbol Meaning Symbol Meaning

Notice, general danger location | O ON/OFF Power

Observe product documentation

Caution when handling heavy equipment d) Standby indication

| 18 ko |
f Danger of electric shock -—= Direct current (DC)

1171.0000.42 - 08 Page 1



Basic Safety Instructions

Meaning Symbol Meaning
Caution ! Hot surface A~ Alternating current (AC)
Protective conductor terminal -~ Direct/alternating current (DC/AC)
To identify any terminal which is intended for
connection to an external conductor for
protection against electric shock in case of a
fault, or the terminal of a protective earth
Earth (Ground) I:l Class Il Equipment
to identify equipment meeting the safety

requirements specified for Class Il equipment
(device protected by double or reinforced
insulation)

Frame or chassis Ground terminal

EU labeling for batteries and accumulators

For additional information, see section "Waste
disposal/Environmental protection", item 1.

Be careful when handling electrostatic sensitive
devices

EU labeling for separate collection of electrical
and electronic devices

For additional information, see section "Waste
disposal/Environmental protection”, item 2.

Warning! Laser radiation

For additional information, see section
"Operation", item 7.

Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks

and dangers.

serious injury.

A WARNING

serious injury.

A CAUTION

moderate injury.

Indicates a hazardous situation which, if not avoided, will result in death or

Indicates a hazardous situation which, if not avoided, could result in death or

Indicates a hazardous situation which, if not avoided, could result in minor or

Indicates information considered important, but not hazard-related, e.g.
messages relating to property damage.

In the product documentation, the word ATTENTION is used synonymously.

These signal words are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the signal words described here
are always used only in connection with the related product documentation and the related product. The
use of signal words in connection with unrelated products or documentation can result in misinterpretation
and in personal injury or material damage.

1171.0000.42 - 08
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1.

Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, use only
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea
level. A tolerance of +10 % shall apply to the nominal voltage and +5 % to the nominal frequency,
overvoltage category 2, pollution degree 2.

Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
even death.

Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the mains-supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with a protective conductor contact and protective conductor.

Intentionally breaking the protective conductor either in the feed line or in the product itself is not
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords
or connector strips are implemented, they must be checked on a regular basis to ensure that they are
safe to use.

If there is no power switch for disconnecting the product from the mains, or if the power switch is not
suitable for this purpose, use the plug of the connecting cable to disconnect the product from the
mains. In such cases, always ensure that the power plug is easily reachable and accessible at all
times. For example, if the power plug is the disconnecting device, the length of the connecting cable
must not exceed 3 m. Functional or electronic switches are not suitable for providing disconnection
from the AC supply network. If products without power switches are integrated into racks or systems,
the disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cables on a regular basis to
ensure that they are in proper operating condition. By taking appropriate safety measures and
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.
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11.

12.

13.

14.

15.

16.

17.

18.

Basic Safety Instructions

The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher
fuse only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages V,s > 30 V, suitable measures (e.g. appropriate
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be
taken to avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC 60950-1 / EN 60950-1 or IEC 61010-1 / EN 61010-1 standards that
apply in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the protective conductor terminal
on site and the product's protective conductor must be made first before any other connection is
made. The product may be installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the
product, as well as the product itself, is adequately protected from injury or damage.

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1). Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.qg. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.
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Basic Safety Instructions

2. Before you move or transport the product, read and observe the section titled "Transport".

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection”,
item 1.

5. Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

7. Laser products are given warning labels that are standardized according to their laser class. Lasers
can cause biological harm due to the properties of their radiation and due to their extremely
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the
product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22,

EN 55032/CISPR 32)

— Class A equipment:
Equipment suitable for use in all environments except residential environments and environments
that are directly connected to a low-voltage supply network that supplies residential buildings
Note: Class A equipment is intended for use in an industrial environment. This equipment may
cause radio disturbances in residential environments, due to possible conducted as well as
radiated disturbances. In this case, the operator may be required to take appropriate measures to
eliminate these disturbances.

— Class B equipment:
Equipment suitable for use in residential environments and environments that are directly
connected to a low-voltage supply network that supplies residential buildings

Repair and service

1. The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.
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Basic Safety Instructions

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, protective conductor test,
insulation resistance measurement, leakage current measurement, functional test). This helps ensure
the continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.
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Instrucciones de seguridad elementales

Waste disposal/Environmental protection

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection
point or via a Rohde & Schwarz customer service center.

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but
must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for
take-back obligations and disposal obligations for manufacturers within the EU. Contact your
Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de seguridad.
Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario debera
atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas
Rohde & Schwarz esta siempre a su disposicion en caso de que tengan preguntas referentes a estas
informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
esta destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacién del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacién, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacién debida en la documentacién del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacién del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. ej. las
referentes a la proteccion de personas, que encontraran en el capitulo correspondiente de la
documentacién del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacion de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la hoja de datos y en la
documentacidn del producto.

Sefializacion de seguridad de los productos

Las siguientes sefiales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros.

Simbolo Significado Simbolo Significado
Aviso: punto de peligro general | O Tension de alimentacion de PUESTA EN
/ y L MARCHA / PARADA
Observar la documentacion del producto
Atencion en el manejo de dispositivos de peso d) Indicacion de estado de espera (standby)
A elevado
| 18 kg |
C Peligro de choque eléctrico f— Corriente continua (DC)
2 Advertencia: superficie caliente ~ Corriente alterna (AC)
. Conexioén a conductor de proteccién —~_ Corriente continua / Corriente alterna (DC/AC)
Conexion a tierra I:l El aparato esta protegido en su totalidad por un
aislamiento doble (reforzado)
Conexi6n a masa Distintivo de la UE para baterias y
acumuladores

Mas informacién en la seccién
"Eliminacién/proteccién del medio ambiente",
punto 1.
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Instrucciones de seguridad elementales

Simbolo Significado Simbolo Significado

Aviso: Cuidado en el manejo de dispositivos
sensibles a la electrostéatica (ESD)

Distintivo de la UE para la eliminacion por
separado de dispositivos eléctricos y
electronicos

Mas informacion en la seccién
"Eliminacion/proteccion del medio ambiente",
punto 2.

Advertencia: rayo laser

Mas informacion en la seccién
"Funcionamiento", punto 7.

Palabras de sefial y su significado

En la documentacioén del producto se utilizan las siguientes palabras de sefial con el fin de advertir contra
riesgos y peligros.

A PELIGRO Indica una situacién de peligro que, si no se evita, causa lesiones
graves o incluso la muerte.

Indica una situacion de peligro que, si no se evita, puede causar

A ADVERTENCIA lesiones graves o incluso la muerte.

Indica una situacion de peligro que, si no se evita, puede causar
lesiones leves 0 moderadas.

A ATENCION

Indica informacién que se considera importante, pero no en relacion
con situaciones de peligro; p. €j., avisos sobre posibles dafios
materiales.

En la documentacion del producto se emplea de forma sindénima el
término CUIDADO.

Las palabras de sefial corresponden a la definicion habitual para aplicaciones civiles en el area
econdémica europea. Pueden existir definiciones diferentes a esta definicién en otras areas econémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefial aqui descritas
sean utilizadas siempre solamente en combinacidn con la correspondiente documentacion del producto y
solamente en combinacion con el producto correspondiente. La utilizacion de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.
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Instrucciones de seguridad elementales

Si no se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicion de funcionamiento se define por principio la posicion con el suelo de la caja para
abajo, modo de proteccién IP 2X, uso solamente en estancias interiores, utilizacién hasta 2000 m
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de
+10 % sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de sobrecarga
eléctrica 2, indice de suciedad 2.

No sitte el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacion del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacion de modo distinto al indicado en la documentacién del producto, se pueden
causar lesiones o, en determinadas circunstancias, incluso la muerte.

No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacién del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

Antes de la puesta en marcha del producto se deberd comprobar siempre que la tension
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccion | con alimentacién moévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcién intencionada del conductor de proteccién, tanto en la toma de
corriente como en el mismo producto. La interrupcion puede tener como consecuencia el riesgo de
gue el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacién de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, o bien si el
interruptor existente no resulta apropiado para la desconexion de la red, el enchufe del cable de
conexion se debera considerar como un dispositivo de desconexion.

El dispositivo de desconexion se debe poder alcanzar facilmente y debe estar siempre bien accesible.
Si, p. €]., el enchufe de conexion a la red es el dispositivo de desconexién, la longitud del cable de
conexion no debe superar 3 m).

Los interruptores selectores o electrénicos no son aptos para el corte de la red eléctrica. Si se
integran productos sin interruptor en bastidores o instalaciones, se debera colocar el interruptor en el
nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacion adecuadas, de que el cable de conexién a red no pueda ser dafiado o de que nadie
pueda ser dafiado por él, p. €]. al tropezar o por un choque eléctrico.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Instrucciones de seguridad elementales

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como méximo (utilizacién de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tension Uyt > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicion adecuados, seguros, limitacion
de tensién, corte protector, aislamiento etc.).

Para la conexion con dispositivos informéticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacion y
la conexién deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacion debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafios.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningn objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacion contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. ej. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningan concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.
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Instrucciones de seguridad elementales

Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados —los llamados
alérgenos (p. €j. el niquel)—. Si durante el manejo de productos Rohde & Schwarz se producen
reacciones alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las
causas y evitar cualquier molestia o dafio a la salud.

Antes de la manipulacion mecéanica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacion/proteccion del medio ambiente", punto 1.

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacion de evaluar y sefializar las areas de trabajo en las que exista un riesgo elevado de
exposicién a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafios a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

Los productos con laser estan provistos de indicaciones de advertencia normalizadas en funcién de la
clase de laser del que se trate. Los rayos laser pueden provocar dafios de tipo biolégico a causa de
las propiedades de su radiacion y debido a su concentracién extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcion aparte de las descritas en la
documentacién del producto, a fin de evitar lesiones (p. €]. debidas a irradiacion laser).

Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogia con EN

55022 / CISPR 22, EN 55032 / CISPR 32)

— Aparato de clase A:
Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos
conectados directamente a una red de distribucion de baja tensién que suministra corriente a
edificios residenciales.
Nota: Los aparatos de clase A estan destinados al uso en entornos industriales. Estos aparatos
pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles
perturbaciones guiadas o radiadas. En este caso, se le podra solicitar al operador que tome las
medidas adecuadas para eliminar estas perturbaciones.

— Aparato de clase B:
Aparato adecuado para su uso en entornos residenciales, asi como en aquellos conectados
directamente a una red de distribucion de baja tension que suministra corriente a edificios
residenciales.
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Instrucciones de seguridad elementales

Reparacion y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacién para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicion de resistencia de aislamiento, medicion de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe seguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafio seco y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.

En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacion las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevacion adecuado (p. €j. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.
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Instrucciones de seguridad elementales

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. €j. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafios personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacion utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafios.

Eliminacién/proteccién del medio ambiente

1.

Los dispositivos marcados contienen una bateria o un acumulador que no se debe desechar con los
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminacién se debe
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atencion al
cliente de Rohde & Schwarz.

Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar,
sino que deben ser recogidos por separado.

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacion de residuos y asume
plenamente los deberes de recogida y eliminacién para los fabricantes dentro de la UE. Para
desechar el producto de manera respetuosa con el medio ambiente, dirijase a su servicio de atencion
al cliente de Rohde & Schwarz.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. €j. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacién adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacion del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.

Se puede encontrar mas informacion sobre la proteccién del medio ambiente en la pagina web de
Rohde & Schwarz.
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Quality management
and environmental

management

Sehr geehrter Kunde,

Sie haben sich fur den Kauf
eines Rohde & Schwarz Produk-
tes entschieden. Sie erhalten
damit ein nach modernsten Fer-
tigungsmethoden hergestelltes
Produkt. Es wurde nach den
Regeln unserer Qualitats- und
Umweltmanagementsysteme
entwickelt, gefertigt und gepruft.
Rohde &Schwarz ist unter ande-
rem nach den Managementsys-
temen 1ISO9001 und ISO 14001
zertifiziert.

Der Umwelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche
Weiterentwicklung nachhaltiger
Umweltkonzepte

1 ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear customer,

You have decided to buy a
Rohde & Schwarz product. This
product has been manufactured
using the most advanced meth-
ods. It was developed, manufac-
tured and tested in compliance
with our quality management
and environmental manage-
ment systems. Rohde & Schwarz
has been certified, for exam-
ple, according to the ISO 9001
and ISO 14001 management
systems.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

1 ISO 14001-certified
environmental management
system

Certified Quality System

IS0 9001

Certified Environmental System

IS0 14001

Cher client,

\ous avez choisi d'acheter un
produit Rohde & Schwarz. Vous
disposez donc d'un produit
fabriqué d'aprés les méthodes
les plus avancées. Le dévelop-
pement, la fabrication et les
tests de ce produit ont été effec-
tués selon nos systémes de
management de qualité et de
management environnemental.
La société Rohde &Schwarz a
été homologuée, entre autres,
conformément aux systémes
de management ISO9001 et
ISO 14001.

Engagement écologique

1 Produits a efficience
énergétique

1 Amélioration continue de la
durabilité environnementale

1 Systéme de management
environnemental certifié selon
ISO 14001
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Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00
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Acoustic Measurements on Mobile Phones

The acoustic transmission and reproduction quality of a mobile phone is its
most important characteristic in everyday use. Even the most visually
appealing design and wonderfully sophisticated operating concept are not
much use, when the user cannot or can hardly understand what is being said
at the other end.

Instruments and methods for measuring acoustic characteristics are therefore
essential tools for assessing the quality and suitability of a mobile phone.

R&S UPV-K92 provides all tests specified in TIA-1042 version 1.0 (3GPP2
C.S0056-0 Version 1.0). It uses the NORMAL real speech signal for sending and
receiving frequency response and loudness rating measurements and the
ECHOLOSS speech signal for the echo loss measurement.

An additional test case for peak acoustic level is provided. This test uses the
PEAKLEYV test signal.

For sending measurements, the frequency response of the artificial mouth needs
to be equalized. For the equalization of arbitrary signals like the NORMAL speech
signal, R&S UPV-K92 provides an off-line filtering tool that compensates the
frequency response of the artificial mouth used in order to generate an
acoustically correct spectrum of the test signal at the mouth reference point
(MRP).

With update key UPV-K9201 present, the program provides in addition all
testcases according to TIA-1042-A:2013-03 (3GPP2 C.S0056-A v1.0). This
version is harmonized with 3GPP TS 26.132 and uses Single Talk speech signal
according to ITU-T P.501 for frequency response tests and a dynamically
compressed real speech signal for echo loss tests.

The new testcase “Speech Quality in sending in the Presence of Ambient Noise”
requires additional option UPV-K98 and UPV-K101, additional hardware UPP200
with UPP-B8 and UP-Z8A as well as additional acoustic equipment not supplied
by Rohde & Schwarz.
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2 Preparation and Start of the Application Software
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Required Measuring Instruments and Accessories

The Audio Analyzer R&S UPV with the following options is required for the
measurements:

e Base Software for Mobile Phone Tests R&S UPV-K9
e CDMA2000® Mobile Phone Tests R&S UPV-K92

The CDMA2000® 1xRTT mobile phone under test is connected via the RF
interface using either the Universal Digital Radio Communication Tester
R&S® CMU200, called herein below CMU200, or the Wideband Radio
CommunicationTester R&S® CMW500, called herein below CMW500.. This
tester simulates a base station for the mobile phone so that a call can be
set up. Tests with wideband EVRC codec (SO68 and SO73) are only
possible using the CMW500.

The CMU200 must be equipped with the options CMU-B83 v22
(CDMA2000 1xRTT Signalling Unit), CMU-B85 v22 (8k/13k QCELP, 8k
EVRC, EVRC-B Speech Codec) and the appropriate software options
CMU-K8x for the band used (CMU-K83: 450MHz bands, -K84: Cellular
bands, -K85: PCS bands, -K86: IMT-2000 bands). The firmware version in
the CMU200 must be 3.50 or higher.

The CMW500 must be equipped with the options CMW-B400B (Audio
Board), CMU-B405A (Speech Board), CMW-B200A, CMW-B220A and
CMW-PK80.

Acoustic devices such as an artificial mouth, artificial ear and other
accessories are required for the measurements. The following equipment
from Briel & Kjeer or G.R.A.S. is normally used:

Table 1 Third party acoustic test equipment

Device

Description

Type (examples)

Telephone test head
(Only for TIA-1042)

Device for fixing the DUT in the
prescribed position

B&K 4602B

Wideband ear simulator
(Only for TIA-1042)

IEC 711 type occluded ear simulator
with adapters for connection to the
ear piece of the DUT

B&K 4195 (type 3.2)

Artificial mouth
(Only for TIA-1042)

Special loudspeaker for simulation
of the mouth

B&K 4227 or
G.R.A.S. 44AB or
44AA (with power

amplifier)

Head and torso simulator Head and torso simulator with B&K 4128D

artificial ear (type 3.3) and artificial

mouth, may be used alternatively to

the abovementioned devices
Second (left) artificial ear Required for handsfree tests and B&K 4159C
for head and torso adjustment of the background noise (included with
simulator field for “speech quality in presence 4128D-002)

of ambient noise”

Handset fixture for Head
and Torso simulator

Required to position the handset on
the artificial head, and to apply a
defined force with the earpiece
against the pinna

B&K 4606 (included
with 4128D)

E-2
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Device Description Type (examples)

Drive amplifier for artificial | Required for delivering the current B&K 2735

mouth into the 5 Ohms load of the
loudspeaker. Should have roughly
0 dB voltage gain.

Measurement microphone | 2" measurement microphone with B&K 4939 with
preamplifier for measurement of B&K 2670 or
artificial mouth output during G.R.A.S. 40BF with
calibration. G.R.A.S. 26AC

Acoustic calibrator Sound level calibrator for calibrating B&K 4231

the measuring microphone

4" Adapter for calibrator For inserting ¥4” microphones into B&K DP0O775
the 4231 calibrator

Microphone power supply Power supply and preamplifier for B&K 2829, 5935L or
the measuring microphone 2690A0S2

or G.R.AS. 12AR or
12AA

Note: With the amplifier set to 0 dB, the microphone power supply B&K
2690A0S2 produces too much noise for measuring idle noise and
distortion. It is therefore advisable to set a gain of 20 dB.

Natural speech signals have a high crest factor (approx. 24 dB peak-to-rms
value). Therefore, the R&S UPV generator cannot deliver enough peak
power to drive the artificial mouth even using the impedance transformer
that is supplied along with option R&S UPV-K9. Thus, it is necessary to
connect the artificial mouth via an additional audio power amplifier. The
generator 1 output of the R&S UPV is connected to the power amplifier
input, and the power amplifier output is connected to the artificial mouth.

Any standard small audio power amplifier can be used for this task. An
output power of only a few watts is sufficient. The most important factor is
the long-term stability of the gain of this amplifier. The voltage gain should
be set in to about 0 dB and must remain unchanged after mouth calibration.
An amplifier with a means of holding the gain control steady or at least with
a lock knob for the volume control is preferred in order to avoid any
unwanted gain variation.

For use with Digital Radio Communication Tester CMU200, a cable with
male (analyzer) and female (generator) XLR connector is supplied for
connection to the "Speech" connector of the Digital Radio Communication
Tester CMU200.
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UPV Analyzer Generator

Fig. 1 Assignment of 9-contact speech connector on CMU front panel

This cable is configured for connection to link handler #1 in the CMU200.
Depending on the CMU200 hardware, link handler #2 in the CMU200 can
also be used for CDMA2000, in particular if the CMU200 also supports
GSM and/or WCDMA. In this case, the supplied adapter must be inserted
between the cable and the speech connector on the CMU200.

Caution: Ifthe CMU CODEC calibration fails, the adapter has most likely
to be inserted.

The CMU connects pin 1 of the R&S UPV generator output to
the equipment grounding conductor of the mains. If an external
power amplifier is used, care must be taken that the external
power amplifier does not connect R&S UPV generator output pin
2 to the equipment grounding conductor of the mains. If
available, a balanced connection to the power amplifier should
be preferred.

An external power amplifier should be switched on after the
R&S UPV-K9y program has been started, and switched off
before the program is ended. This prevents the artificial mouth
from undue power loading by setups which are loaded external
to the application.

An external USB keyboard and a mouse must be connected to
the R&S UPV.

Caution: R&S UPV-K9y does not support the use of headphones. Do not
connect headphones to the R&S UPV during mobile phone
tests. High level signals may be present at the headphone
connector.

The program required and the associated files are in the folder “UPV-K9y
Software” on the installation CD supplied with the R&S UPV-K92 option.
The audio analyzer must meet the following firmware requirements:

e R&S UPV firmware version 3.3.4.822 or higher
e Option R&S UPV-K9 installed

10 E-2
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e Option R&S UPV-K92 installed.

e Testcases according to TIA-1042-A:2013-03 (3GPP2 C.S0056-A v1.0)
require update key UPV-K9201. This update key is automatically delivered
with every new UPV-K92 option after release of this software version. For
older installations this update key can be ordered separately and retro-fitted.

For the testcases “speech quality in sending in the presence of ambient noise”
narrowband and wideband the following additional equipment and options are

required:

Table 2

the presence of ambient noise

Description

Instrument Type

Test equipment from R&S required for speech quality tests in

Ordering Number

R&S® UPV-K98

Background noise control software
acc. ETSI ES 202 396-1

1424.2003.02

R&S® UPV-K101

Measurements using background
noise acc. ETSI TS 103 106 and
EG 202 396-3

1424.2203.02

R&S® UPP200

Audio Analyzer two channels

1411.1003.02

R&S® UPP-BS

Eight-channel generator

1411.2700.02

R&S® UP-Z8A

8-channel analog cable for
R&S®UPP-B8

1411.3206.02

The following equipment not supplied by Rohde & Schwarz is also required:

Table 3

presence of ambient noise

Device

Description

Third party equipment required for speech quality tests in the

Type (examples)

2 Pairs of full-range
speakers

Frequency response at least
100 Hz to 10 kHz

Behringer Truth
B2031A

Subwoofer

Frequency response at least
40 Hz to 120 Hz

M-Audio SBX-10

5 Speaker cables

XLR male — XLR female
length approx. 10m

4 Speaker stands

The base plane of the speaker
should be adjustable such that the
tweeter of the speaker is at the
same height as the artificial ears of
the head-and-torso simulator. With
the B2031A speakers, the tweeter is
about 31 cm above the base. With
the Bruel & Kjaer HATS, the
entrance of the artificial ear is about
60 cm above the base.

Installing the Software

The application program requires option keys K9 and K92 to be installed.
Testcases according to TIA-1042-A:2013-03 (3GPP2 C.S0056-A v1.0) require

11 E-2
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option key K9201 to be installed. The keys are installed in the factory in case
a new R&S UPV is ordered together with these options. If the options are
ordered separately, the keys as well as the installation manual are part of
the delivery.

It is recommended to copy the files MCRInstaller.exe,
CRRuntime_12_3 mlb.exe, RsVisaTarget 307.msi, UPV-K9y 30065.msi
and dotnetfx35.exe from the folder “UPV-K9y Software” on the installation
CD to drive D: on the R&S UPV hard disk drive, e.g. to a folder named
“D:\R&S Software\UPV-K9y\Version 3.0.0". First, start “MCRInstaller.exe” to
install the Matlab runtime for the offline filter tool. Run also
“CRRuntime_12_ 3 mlb.exe”. “RsVisaTarget 307.msi” needs only to be run
on UPVs with operation system Windows XP. Once installed, it must not be
uninstalled. Next, run the file “UPV-K9y 30065.msi” to start the installation.
Follow the instructions of the installer on the screen.

Verification of the Installation

After the installation, check the existence of the folder “MATLAB” in
“C:\Program Files”, and of the subfolder “UPV-K9y Mobile Phone Tests” in
“C:\Program Files\Rohde&Schwarz”.

If the software reports a missing key code at the first start, delete folder
“D:\Phone” (if existing) and install the missing key code before starting the
software again.

Test Setup

In the setups using the input switcher, each device type (e.g. free field
microphone, right artificial ear, left artificial ear, decoder output) is always
assigned to the same switcher input. Therefore connections which are not
required for a specific setup do not have to be removed. The schematics
below, however, show only the connections required for the specific setup.

1-—

RF to Mobil
o Mobile -0

v h
Microphone
UPV Seooly
Fig. 2 Test setup and connection of external components with
CMU200
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Microphone
Power
Supply

Fig. 3

Test setup and connection of external components with
CMW500

RF to Mobile

Microphone 2 }
Power
suppy |- FF

Mic

DF _‘ﬂ

Fig. 4 Test setup and connection of external components with input

switcher UPZ and CMU200
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m—
RF to Mobile #:q

Microphone E )
Power
Supply FF
Mic
DF B
r—— —_ﬁ

Fig. 5 Test setup and connection of external components with input
switcher UPZ and CMW500

RF

TRIGGER IN

T

&,
clae
e s

seemmeen 99 @ “ g

'E'“ (XX 8 {jpp.:._._J

iab]

TRIGGER OUT

Fig. 6 Test setup and connection of external components for the
adjustment of the background noise field
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TRIGGER IN

- S SF S S S SrSrs
E I J

Fig. 7 Test setup and connection of external components with input
switcher UPZ for the adjustment of the background noise field

TRIGGERIN

TRIGGEROUT

Fig. 8 Test setup and connection of external components with
CMU200 for measurements with background noise field

15 E-2



1402.0643.12

Acoustic Measurements on Mobile Phones

TRIGGER IN

TRIGGEROUT =

Fig. 9 Test setup and connection of external components with
CMWS500 for measurements with background noise field

Micraphane
Power

TRIGGER

TRIGGEROUT

Fig. 10 Test setup and connection of external components with CMU200
and input switcher UPZ for measurements with background noise field
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1 [
Pawer _‘_q Mic

Supply | q DF

- f?.-;..-;-l-;-l=-.;--:_§-u

= USB/

-- ————: - =
eSSl N RS 23

TRIGGER IN

[ [
o g h 1

K
o8 orv ey 15 2]
- i
LAN._ R T r———— .I“ A
L e S g, ]
— % 8866 |UPP J
TRIGGEROUT T -

Front
Left

- -

Fig. 11 Test setup and connection of external components with
CMW500 and input switcher UPZ for measurements with
background noise field

Starting the Application Software

After installation, the program can be started by double-clicking the Icon
“UPV-K9y Mobile Phone Tests” or by clicking “R&S UPV Applications ->
UPV-K9y Mobile Phone Tests” in the “Programs” menu.

At the fist start of the program, selection windows appear for the standard
according to which the measurements should be made, and for the artificial
ear and artificial mouth used.

@ Standard M=l

Fleaze select a standard below:

TIA-1042-4-2013 Handget M arrow j

[ Allow only selected measurements

[ Do not show this dislog again

Cancel | k. I
/'

o

Fig. 12 Query window for selection of applied standard

If “No Standard” is selected in the standard selection window, all
measurements appear in the “Measurement” menu. If a standard is
selected, all measurements appear in the “Measurement” menu, but
compliant measurements are checked. If “Allow only standard
measurements” is checked, non-compliant measurements are suppressed
in the Measurement menu.

“TIA-1042:2005” comprises sending and receiving tests (frequency
response and loudness rating) for CDMA2000 and AMPS, weighted
terminal coupling loss and the maximum acoustic pressure test from annex
B. “TI1A-1042:2005 and Auxiliaries” comprises in addition sidetone masking
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rating, sending and receiving distortion and idle channel noise tests
according to 3GPP standard. These tests are not specified in TIA-1042 and
offered for information only.

“TIA-1042-A-2013 Handset Narrow” and “TIA-1042-A-2013 Handset Wide”
offer all testcases according to the updated standard for narrowband and
wideband connections, respectively. “TIA-1042-A-2013 Handset Narrow
and Auxiliaries” and “TIA-1042-A-2013 Handset Wide and Auxiliaries”
provide additional testcases according to 3GPP TS 26.132 Release 11.

While 3GPP2 C.S0056-A and TIA-1042-A-2013 do not specify testcases for
handsfree devices, the present software provides tests for handheld
handsfree, desktop handsfree and vehicle-mounted handsfree devices
according to 3GPP TS 26.132 Release 11 in Standards “CDMA2k HHHF
Narrow”, “CDMA2k HHHF Wide”, “CDMA2k DTHF and VMHF Narrow” and
“CDMA2k DTHF and VMHF Wide”.

Select Ear Simulator

Type 1

Type 3.2 Low Leak

Twpe 3.2 High Leak

Type 3.3

Type 3.4

Electic connection

[ nduction coil

[T Do not show this dislog again

Cancel | Ok I

4

Fig. 13 Query window for selection of artificial ear
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Select mouth type

Thiz dialog zelects the artificial
mauth far handzet and headzet
measurenents.

LRGP ITU-T P.51

HATS ITU-T P.58

Genernc speaker

Electric connection

For all handz free measurements
the hands free zettingz apply.

[ Do ot show this dislog again

Cancel k. |
r

Fig. 14 Query window for selection of artificial mouth

System Simulator

CMU A CBT

Chw

Electric

[ Da not show this dislog again

Cancel | ] 3 I

4

Fig. 15 Query window for selection of system simulator

When the checkbox “Do not show this dialog again” is checked, the
corresponding selection window will not appear at the program start in
future. However, the selection is still available in the “Options” menu (see
below). After the last of the three selection windows has been closed, the
main window of the R&S UPV-K9 opens.
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@Ul’"ﬂ' K9y cdmaz0D0{R) Mobile Phone Tests (D:\Phone’\Results.xml})

File Data Calib M

Test results overew

dards Config. Meas, Sequence Report Options Help

Select | Date and tine M tile | Test object | Verdi | Main Resut -
|| [T 0227205130632 3GPP2 Sending Handset Namowband UE 2 PASS Sending Loudness Rating
|| M 02/27/20151307:34 3GPP2 Weighted Terminal Coupling Loss. NB UE 2 PASS Echoloss=498dB
|| M 02/27/2015130933 3GPP2 Idie Channel Noise Sending NB UE 2 PASS Idie Channel Noise Sendr
| | M 02/27/205131008 3GPP2 STMR NB. Nominal Volume Setting UE2 FAIL  Sidetone Masking Fiating :
| | [T 02/27/2M51311:08 3GPP2 Talker Sidetone Delay UE 2 PASS (rll)
|| M 0227205131142 3GPP2 Receiving Handset NB, nom. Vol UE 2 FAIL RLR =-10.7 d&
|| C o2ems1nzs 3GPP2 |dle channel noise recening. max. vol  UE 2 FAIL  Idie Channel Noise Recen
|| M o2emsi1nze 3GPP2 Sending Handset Namowband UE 2 PASS Sendng Loudness Rating
|| ™ 02/27/2M513133 3GPP2 Weighted Tesminal Couplng Loss, N UE 2 PASS Echoloss=451dB
|| M 2emsinen 3GPP2 Idie Channel Noise Sending NB UE 2 FAIL  Idie Channel Noise Sendr
|| [T 02/27/20151314:47 3GPP2 STMR NB. Nominal Volume Setting UE 2 FAIL  Sidetone Masking Fiating :
| | T ozensinsn 3GPP2 Talker Sidetone Delay LE 2 PASS  frul]) =
|| [T 02/27/201514:3429 3GPP2 Receiving Handset NB, nom. Vol UE 2 FAIL RLR =-356 dB
|| M 0227205143533 3GPP2 |die channel noise recenang. max. vol ~ UE 2 PASS Idie Channel Noise Recen
| | [T 02/27/201514:3552 3GPP2 Sending Handset Namowband UE 2 FAIL  Sendng Loudness Rating
| | M 02/27/201514:3651 3GPP2 Weighted Terminal Coupling Loss. NB UE 2 PASS Echoloss=922dB
|| [T 02/27/201514:3753 3GPP2 Idie Channel Noise Sending NB UE 2 PASS Idie Channel Noise Sendr
| | T ozeremsisssos 3GPP2 STMR NE, Mominal Volume Setting UE 2 FAIL  Sidetone Masking Rating -
|| [T 02/27/201514:33:09 3GPP2 Talker Sidetone Delay UE 2 FAIL  frwall
| | T 27205150001 3GPP2 Receiving Handset NB, nom. Vel UE 2 FAIL RALR =-356dB
|| [T 02/27/2015150:06 3GPP2 Idie channel noise recenang. max. vol ~ UE 2 PASS Idie Channel Morse Recen
|| T 0227/2m5150M:23 3GPP2 Sending Handset Namowband UE2 FAIL Sending Loudness Rating
| | T ozerremsisoez 3GPP2 Weighted Teminal Couplng Loss. NB UE 2 PASS Echo Loss =52.2d8
| | T 0227201515035 3GPP2 Idie Channel Noise Sending NB UE 2 PASS Idle Channel Noise Sendr
| | T 0227201515090 3GPP2 Receiving Handset NB. nom. Vol UE 2 FAIL ALRA =-356dB
| | T ozeremsisinis 3GPP2 Idle channel noise recenang. max. vol  UE 2 PASS Idie Channel Noise Recen

T mo7sme1s1n e WPP? Sending Handest Namnuihand 1IF 2 Fall  Sendinn | nidnecs Ratinn 2

| oy
|TL4-1042:4-2013 Handset } Electiic connection replac |

| o, | | e |

1402.0643.12

Fig. 16 Main window

Initially the data grid in the center of the screen which shows the result
overview is empty. The screenshot in Fig.6 shows an example after a
number of measurements have been made.
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3 Operating Concept
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R&S mobile phone tests consist of at least two components. R&S UPV-K9
provides the main user interface window, general settings, calibration
routines, data handling, automatic sequencing and reporting tools.

Separate options for different standards (R&S UPV-K92 for CDMAZ2000
tests) provide test macros for basic measurement types defined in the
standards. Each measurement type provides a set of parameters
(R&S UPV setup files, limits etc.) which are defined in separated
measurement definition files, one for each test case.

Options (General settings)

The “Options” menu in the main window allows to change a set of general
settings like ear type and mouth type used which are valid for all or at least
a plurality of the tests.

Standard

“Standard” allows to select one of the available standards. Measurements
belonging to this standard will be checked in the measurement menu. If
“Allow only standard measurements” is checked, it is not possible to start
single measurements which do not belong to the standard.

Select standard at startup

If “Select standard at startup” is checked, the selection window for the
standard is opened at each start of the program.

Ear simulator

“Ear simulator” allows to select the type of ear simulator used for handset
and headset tests. For details on the handling of calibration data see
section 4 “Calibration” below.

Select ear simulator at startup

If “Select ear simulator at startup” is checked, the selection window for the
ear simulator is opened at each start of the program.

Artificial mouth

“Artificial mouth” allows to select the type of artificial mouth used for
handset and headset tests. For details on the handling of calibration data
see section 4 “Calibration” below.

Select artificial mouth at startup

If “Select artificial mouth at startup” is checked, the selection window for
the artificial mouth is opened at each start of the program.

System simulator

“System simulator” allows to select the type of system simulator used. For
details on the handling of calibration data see section 4 “Calibration” below.
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Select system simulator at startup

If “Select system simulator at startup” is checked, the selection window for
the system simulator is opened at each start of the program.

Hands free settings

“Hands free settings” allows selecting the acoustic instruments used for
hands free testing. It is possible to use an ITU-T P.51 artificial mouth
together with a free field microphone, a HATS with one artificial ear or a
HATS with two artificial ears. If two artificial ears are used, the decoder has
to be disconnected from analyzer input 2 and the second artificial ear has to
be connected to it for receiving measurements. Do not forget to re-connect
the decoder for any measurement in sending direction. Alternatively a UPZ
input switcher can be used for automatic connection of the sound sources
to the UPV analyzer inputs.

Activation signal for distortion tests

In the sub-menu to “Activation signal for distortion tests”, signals can be
imported to the test system. If more than one imported signal is available, it
is possible to choose one of them for actual use.

Import Activation Signal

Browvse to an appropriate wave file.

The file must be recorded in mono with 48 kHz
zample rate.

Maximum permizsible lenagth iz 10 zeconds.

File Marme Browse

LeAUPS U serbalett]_1_48kHz waw

Sample R ate I 43000 Hz

= Iono ) Steren

Druration I 2595 Secondsz
Average Level I 2119 dBFS
Active Level I 1979 dBFS

¥ Equalize for Selected Artificial Mouth

[ Immediately select thiz activation signal

Cancel (]9 |
Y

Fig. 17 Window for import of activation signals

Use the “Browse” button to select a wave file which fulfills the conditions
shown on top of the window. The selected signal is analyzed and checked
for appropriateness. Note that a high crest factor of the signal may
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overdrive the codec or artificial mouth. If “Equalize for Selected Atrtificial
Mouth” is activated, the file is immediately equalized for the selected
artificial mouth when the “Ok” button is clicked. Otherwise or when the
mouth calibration has been re-done or a different artificial mouth has been
selected in the meantime, the signal is equalized automatically immediately
before the sending distortion test starts.

If “Immediately select this activation signal’ is checked, the signal is
selected for use when the “Ok” button is clicked.

Show Operator Instructions

If “Show operator instructions” is checked, instructions to the operator are
displayed in a window before the measurement starts. The operator may be
prompted to position the mobile in a defined way or to set the volume to a
certain setting

Auxiliary delay measurements

For the alignment of the acquisition with the arrival of the test signal at the
analyzer input, an auxiliary end-to-end delay measurement is performed
before the main measurement. The item “Auxiliary delay measurements —
Configure” allows to select the measurement method (sine burst or cross
correlation), the test signal for the cross correlation method (composite
source signal or real speech word “five”) and the re-use of a delay value
which has been measured for the same device under test on the same path
for a previous test. A maximum age has to be specified for the use of
existing delay values to avoid the use of outdated values.

Auxiliary Delay Measurement

Meazurement method
IErDss-cnrreIatiDn j
Croze-Comelation Test Signal
IFieaI gpeech, word "five"' j

¥ PFe-use existing delay value
b aRirum age of exizting walue

00 = s=econds

Cancel | Ok I

4

Fig. 18 Window for configuration of auxiliary delay measurements

The recommended method for auxiliary delay measurement is cross-
correlation using the real speech word “five” as test signal. Re-use of
existing delay results speeds up the tests, which is particularly helpful in
automatic test sequences. It avoids changing of the test setup when uplink
and downlink delay values are required for echo loss and stability loss tests.
However, if changes are done in the setup which could have an influence
on the end-to-end delay, like changing the device under test, the codec or
codec rate etc, the auxiliary delay measurement has to be re-run. If a
different device under test is selected in menu item “Data — Test object —
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Select ...”, the memorized auxiliary delay values are automatically
invalidated. In all other cases the operator has to invalidate them using
menu item “Auxiliary delay measurements — Invalidate all existing values”.

CMU remote control

If it is intended to remote control a R&S CMU200 from a sequence of this
program, menu item “CMU remote control” can be used to select the
communication interface (GPIB or RS-232) and, if multiple devices are
found, to select one of them.

MU
—CHMU Remate Cantral
aff vaGPE | viaR5-232 |
GFIB
Diotiee [GFIB0::19: RiohdetSchwarz.CMU 200-1100.0008.02.108662//5.13 =
—R5-232
COM Interface[COMB: FiohdelS chwarz,CMU 200-1100.0008.02, 1 DBB25.13 =]

Cancel | Ok I y

e

Fig. 19 Window for configuring the CMU remote control

For remote control via RS-232, an external USB-to-serial converter has to
be connected and installed. For remote control via GPIB, the R&S VISA has
to be installed. The installer for the R&S VISA is distributed with the Option
R&S UPV-K92. For details of the remote control see section 8 and the
operation manuals of the R&S CMUZ200.

CMU subsystem

In “CMU subsystem”, one of the communication standards can be selected.
This allows sequences to be run in different communication standards
without changing the subsystem in every single CMU control instance in the
sequence.

Noise Calibration Configuration

In “Noise Calibration Configuration” parameters for the background noise
field used for the “Speech Quality in Presence of Ambient Noise” test can
be set.

The configuration of the noise field calibration comprises

1. Choice of the calibration method

2. Speaker configuration and setup

3. Bandwidth and tolerance settings
4

. Switcher usage
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5. Other settings.

It is done in the 'Noise Calibration Configuration' window. This window is
opened with item 'Noise calibration configuration' in the “Options” menu.
The figure below shows the default settings. If any item has been changed
then user can retain the default settings by selecting the button "Set to

default".

Noise Calibration Configuration = = -
Murmber of fulkange speakers pairs [Q _l Modify speaker delay 1=
Number of subwoofers = Additional delay FL fooo Hms
Subwaoler connected lo UPP Channel  [7 =] Additional delay AL [17o0 = me
Masium output level [1378 = @y Addibonal delay FR [100 = me
Ear equalization D - Additional delsy AR m —
Bandlimit low [ano0 =] He Max kerations duing equalzation 3 =]
Bandlimit high 2000000 = Hz Usze Pink Noize for all equalizations 7
Flatness start at 50,00 o Ambiance used for equalization | k_MNoize O shcente
Flatness end at 10000.00 = Hz Pirik Noise level [6500 =] despta)
Crossoves Frequency [2000 = Hz Pink Noize duration [3000 =+,
Flatness width 600 =l 48 Pink Noize filename [Plnl Noise 6Bit1 20sFilbered wav J
Min distance HATS to speaker s Hm Final test of all ambiances v
Max distance HATS to speaker m m Ignore uncritical level wamings I
Max level deviation m 4B Achon on final flatness devistion [Prompt Zl
Max THD [20m =] @ Use All speaker Equalzation v
Min Sound Pressure Level [eo00 =] dpst All Speakers Post Equakzation |Fast recommended by R&S) =l
Use Input Switcher UFZ v Report intermediate steps r
Set lo defauk Cancel

Fig. 20 Noise Calibration Configuration Window, Default state.

The configuration is saved in the settings of the UPV-K9y program, so that
any modification will be effective and re-used as long as the speaker
configuration and calibration methods do not need to be changed.

Choice of calibration method

Three different calibration methods are available which differ in time
consumption and accuracy:

Pink Noise Equalization (recommended by Rohde & Schwarz) equalizes
speaker and room with an uncorrelated, non-periodical Pink Noise signal
and uses this equalization for all ambiances. It offers the best compromise
between calibration time and accuracy. After room equalization with the
pink noise signal only an individual level correction has to be done for each
ambiance.

Use Pink Noise for all equalizations [

Arnbiance used for equalization |W|:|rk_N oize_(ffice_Callzenter J

500 5 dBsplia)
w0 =,

|F'ir'|kN oize BRIt 20zFilterad way

Firk Moige level

Fink. Moize duration

Fink Moize filename
Fig. 21 Configuration Window, calibration method Pink Noise.

Although it is not recommended to change the default settings, a user can
select level and duration of the Pink Noise. Specifying a longer duration

25 E-2



1402.0643.12

Acoustic Measurements on Mobile Phones

results in longer calibration time but might increase the accuracy especially
at low frequencies. Instead of using the recommended WAV file the user
could provide an own noise file.

Shared equalization with one ambiance (recommended by
ETSI ES 202 396) equalizes speaker and room with one of the ambiances
and uses this equalization for all other ambiances, too. Because the real
ambiances do not contain the same energy in each frequency band, the
equalization is optimal only for the selected ambiance.

Use Pink Moize for all equalizations [~

Ambiance used for equalization wiork Moise Office Callcenter

Pirk Moize lewvel Al Ambiences -
Pub_Moize W2

Fink Maize duration COutzide_Traffic_Road
Qutzide_Traffic_Crogzroads =

Pirk Maize fil Train_Station

e A Fullsize_Car1_130Krrk

Final test of all ambiances Cafeteria_Maize

Menza b

Fig. 22 Configuration Window, calibration method shared ambiance.

This method takes the same calibration time as Pink Noise but normally
offers worse accuracy. After room equalization, the individual level
correction has to be done for each ambiance.

Individual equalization of each ambiance results in best equalization
accuracy but makes the calibration process more than 3 times longer
(about 8 hours). It could be considered if the room and speaker setup will
never be changed.

Uze Pink Moize for all equalizations [~

Ambiance used for equalization Al Ambiences j

Pink Moize level E5. 00 3 dB zpl[&)
Fink Moize duration 20.00 El z

Fink, Moize filename |F'ir'|kN nize1 BRIt 20zFilkerad. way

Fig. 23 Configuration Window, calibration method individual ambiance.

Speaker configuration and setup
Currently two different speaker configurations are allowed for background
noise generation:

Murmber of fulllange speakers pairz E

Murnber of subwoofers IEl

Subwoofer connected to UPP Channel E

Fig. 24 Configuration Window, speaker configuration.

4 full range speakers (2 pairs) with 1 subwoofer or 4 full range speakers
without subwoofer. A subwoofer must be used if the full range speakers do
not pass frequencies down to 50 Hz. The full range speakers are connected
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to UPP channel 3...6. The optional subwoofer is connected to channel 7.
UPP channel 10 is reserved for connection to UPV output.

If a subwoofer is used, the crossover frequency between full range
speakers and subwoofer can be adjusted:

Crozzover Frequency 12000 3: Hz

Fig. 25 Configuration Window, speaker crossover frequency.
To avoid overdriving maximum input voltage of the speakers (or amplifiers),
the operator can adjust the UPP maximum (RMS) output level:

b aimum autput lesvel 1278 = dBv

Fig. 26 Configuration Window, speaker maximal output level.

At the beginning of the calibration process, checks for each speaker are
performed to achieve a minimum sound preasure level and to detect
speaker overdrive by measuring THD. The operator is instructed to
increase the speaker (or amplifier) gain if the required sound level could not
be reached. The required sound pressure level can be set in the range from
80 to 99 dBspl:

kMin Sound Pressure Lewvel 2000 3: dBepl

Fig. 27 Configuration Window, speaker Min Sound Pressure Level.

For speakers that generate higher harmonic distortion than 10% (-20 dB),
the tolerable THD can be increased (to e.g. -10 dB):

Max THD 000 3: 48

Fig. 28 Configuration Window, speaker Max THD.

To detect left/right speaker connection faults, the calibration process needs
to know the rough speaker-to-microphone distances. If the test room is
much larger or smaller than the recommended size, the operator has to
adjust the minimum or maximum speaker distance:

KMin diztance HATS to speaker 1.50 El: m
M ax distance HATS to speaker 2580 3: m

Fig. 29 Configuration Window, expected HATS to speaker distance.

Bandwidth and tolerance settings

The bandlimits specify the frequency range where the equalization will be
performed.

Bandlimit o 40.00 =1 Hz
Bandlimit high 20000.00 == Hz
Fig. 30 Configuration Window, Bandlimit.
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The 'low' value additionally enables a highpass filter. To include the lowest
third octave (50 Hz), the lower bandlimit should be lower or equal to a half
third octave (f / 1.122) below. To exclude the 40 Hz third octave from
equalization, the bandlimit low should be set to 44.5 Hz

Flatness check is limited to the frequency range between start and end.

Flatnesz start at 5000 Y

Flathess end at 10000.00 < Hz

Fig. 31 Configuration Window, Flatness range.

According to ETSI ES 202 396 the equalization must be flat to +/-3 dB, thus
the flatness width must not be greater than 6 dB.

Flatness width .00 3: dB

Fig. 32 Configuration Window, Flatness width.

To achieve an even better flatness this value might be reduced by 1 or 2
dB, if room and speaker setup are able to fulfil such narrow flatness.

Switcher Usage

To reduce user interaction during calibration and measurement an R&S
Input switcher UPZ can be used. This allows hard wired connection to be
established between each signal source and the UPZ while the calibration
process automatically switches the required UPZ input channels to UPV
input

Uz Input Switcher LUPZ v
Fig. 33 Configuration Window, Use Input Switcher UPZ.

Other settings

All other configuration settings normally need not to be changed. User
should modify these settings only to change the default behaviour of the
calibration.

E ar equalization §
Bandlimit lov LF

FF
B andlimit hiak

Fig. 34 Configuration Window, Ear equalization.

Instead of using ID ear equalization (Independent of Direction), 'free field
(FF)' or 'diffuse field (DF)' ear equalization can be selected.
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M odify speaker delay [w

Additional delay FL oo = me
Additional delay AL 1700 = ms
Additional delay FR 11 = s
Additional delay RR ENaE

Fig. 35 Configuration Window, Modify speaker delay.

To avoid coherent superposition of sound from two speakers reproducing
the same signal, the determined speaker delay is individually increased.
Only experienced users should modify these settings to fix acoustical
problems!

b ax iterations during equalization IE

Fig. 36 Configuration Window, Max iterations during equalization.

To achieve flat frequency response, several iterations of equalization are
performed for single and pair of speakers. Iteration is terminated if flatness
is better than 1 dB or 'Max iterations during equalization' is reached. This
value can be selected between 1 (no iteration) and 5.

Prompk -

FPrampt
Retry bwice

Fig. 37 Configuration Window, Action on final flatness deviation.

Action on final flatness deviation

Ilze All speaker Equalization

This item specifies how the calibration process should behave if — after all
iteration steps — the flatness deviation is higher than 'Flatness width'. By
default it would prompt the operator how to proceed (retry, ignore or abort).
To avoid this interruption of calibration process, the operator can predefine
if (and how often) the measurement should be retried.

M ax lewvel dewiation 030 3: dE

Fig. 38 Configuration Window, Max level deviation.

During level adjustment the sound pressure level of each speaker is
iterated to the requested value. This iteration terminates if the level
deviation is below the selected 'Max level deviation'. To achieve higher level
accuracy this value can be decreased; however, this might increase the
count of iteration steps and total calibration time.

lgnore uncritical level warnings ~

Fig. 39 Configuration Window, Ignore uncritical warnings.

To avoid interruption of calibration process, by default only errors are
reported to user. Warnings about uncritical deviations (e.g. noise floor,
flathess of unequalised room, level deviation during single speaker
adjustment) are suppressed, but entered in report.

To get uncritical warning as soon as they appear, this tick box has to be
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deactivated.
IJze All zpeaker Equalization v
All Speakers Post Equalization Fazt [recommended by BE&S]

Repart intermediate steps sccording to B3 202 336-1

Fast [recommended by B&S]

Fig. 40 Configuration Window, Use All speaker Equalization.

If the sound super positioning of all speakers degrades the flatness to more
than 6 dB (or the selected 'flatness width') a post equalization process
should be used to improve this flatness. Otherwise the calibration would fail!

Instead of using the R&S recommended algorithm, the post equalization
can be done according to ES 202 396-1.

Final test af all ambiances ™

Fig. 41 Configuration Window, Final test of all ambiances.

After successful calibration a final level and equalization test of all
ambiances should be performed. Additionally this test adjusts the total level
setting to minimum deviation.

Disabling this test reduces the total calibration time.

The final test of successfully calibrated noise field (but without level
optimization) can be performed separately from the calibration process by
executing the calibration and skipping all calibration steps.

Repart intermediate steps o

Fig. 42 Configuration Window, report intermediate steps.

In case of problems during the calibration process the operator can activate
a detailed reporting that logs all intermediate steps.

Selecting 'Report intermediate steps' does not increase total calibration time
but the number of pages in the report.

UPP Remote Control

This dialog allows to detect and connect a UPP with option UPP-B8 on the
LAN, to be used as playback system for the background noise generation.

UPP

TCRAP
’7UF‘F’ hiost namme or [P address |

find devices... I I ﬂ Cancel | Ok I

Fig. 43 Window for connecting to a UPP on the LAN

A click on the “find devices...” button searches the local area network for
audio analyzers and fills the combobox next to the button with the computer
names and IP addresses of the found devices. Select the appropriate
instrument in the combobox and click “Ok”.
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To establish a remote control connection between UPV and UPP do the
following:

1. Once the “LAN” LED on the UPP is on, press button “CASCADE / LAN
RESET” once and wait until the “CASCADE” LED is blinking.

2. Press the “CASCADE / LAN RESET” button again.

3. Click the “Find” button in the UPP remote control window on the
UPV.

4. Now the computer name on the UPP appears in the UPP remote
control window. Select it and close the window with “Ok”.

Input Switcher

“Input Switcher” allows configuring the use of an R&S UPZ input switcher
connected to the R&S UPV RS-232 port, to switch analyzer input 2 between
sending tests and binaural receiving tests.

Switcher Settings

Use UPZ input switcher to connect second artificial
[ ear for binaural measurements and calibration
[&nalyzer Input 2]

Use UPZ input switcher faor all connections
[tnalyzer Inputs 1 and 2]

Output & | Output B

Decoder output connected to UFZ input no. I 33:

"UF'Z output connected to analyzer input 2

2nd artificial ear connected ta UFZ input no. I 1 5:

Cancel | Ok I

4

Fig. 44 Switcher window

If only the first tick box is activated, the switcher is only used to switch the
second analyser input between decoder output and second artificial ear. In
this case the channel assignments in the “Switcher Settings” window are
applied.

If the second tick box is activated, the switcher is used for all signal sources
and both UPV analyser inputs.

The following table shows the assignment of the signal sources to the
switcher channels when the second tick box is activated.

Channel Signal Source
1 Second (left) artificial ear
2

First (right) artificial ear

Decoder output

Diffuse field microphone

3
4 Free field microphone
5
6

UPP-B8 output channel 10

Table 4 Input switcher channel assignment
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Connect switcher output A to UPV analyser input 1 and switcher output B to
UPV analyser input 2.

Report settings

“Report settings” allows defining the type of information which should
appear in the reports. For details on reporting, see section 8 below.

Generate temporary export files

If “Generate temporary export files” is checked, some of the measurement
macros create “result.exp” with result value and verdict, and, if applicable,
“curve.exp” or “abscurve.exp” and “relcurve.exp” files with curve data in
ASCII format. This function is provided for compatibility with R&S UPL-B9.

Generate temporary image files

Iltem “Generate temporary image files” causes the measurement macros to
store a screenshot of the measurement window after completion of the test
to a file “Image.TIF” for use by a remote controlling host.

Store results of further measurements

If “Store results of further measurements” is checked, curves and
calculated values like loudness ratings are also stored for additional
measurements started with the “Add Measurement” key. They will appear in
reports of the respective measurements.

Do not change scale for further meas.

Menu item “Do not change scale for further meas.” deactivates the
automatic Y-axis scaling if the curve of an additional measurement leaves
the plot area partially or totally.

Store loaded curve data to results

If “Store loaded curve data to results” is checked, curves loaded from file
with the “Load Curve” softkey are stored to the results database and will
appear in reports of the respective measurements.

Enable remote control

Menu item “Enable remote control” activates the interface of the program
for remote control using the client “ControlK9.exe”.
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Calibration Devices

R&S UPV-K9 allows to simultaneously storing calibration values for multiple
individuals of the same type. This allows switching devices without the
requirement for re-calibration. However, regular re-calibration is
recommended in order to assure the correct function of the used devices.

@UPH‘—K'J? cdmaz000{R) Mobile Phone Tests {D:'Phone'Res

File Data | Calibration Measurement Standards  Config, Meas, ¢

Sl Microphone .

[~ Artifical Ear g
I— DRP ko ERP correction » T erminal
r Free field equalization C &l Hoize
r Ciffuse field equalization * | Momina
r 1D (Independent of Direckion) Equalization  * Lone De
[ Artificial Mouth T
r Artificial Mouth (Hands Free) Y ol o

el noize |
r Codec g andzet M
r Induction coil T erminal
I— Electric connections C el Moize
r cdmaz000 ref, spectrum * | Momina
r ijpnﬁl S S22 e, e : chone De
F Backaround noise Field 4 :a:,jz:t,
r Mew Device andzet M
r Select Device T erminal
r Delete Device el Maize
r Showe all values M amina
r Show selected devices btone De
= e o o

Fig. 45 Calibration menu

For every device to be calibrated, an entry must be created using
“Calibration > New device” in the main menu. This menu item opens an
entry window to specify the calibrated device. A category of device must be
chosen from the combo box on top. Type, manufacturer and serial number
are entered into the text boxes below. The entries are confirmed by clicking
on the “Save and close” button.
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@) Calibrated Deyice =10 x|

Uzage

| =l
Tupe

M anufacturer

Senal Murber

Cancel | | Save and cloze Q

Fig. 46 Input window for information about calibrated device

Before a device can be calibrated or used, it must be selected with
“Calibration > Select device” in the main menu. Clicking on this item opens
a window with a table of all entered devices.

Select Calibrated Devices

¢ | Manufacturer  Type Senal No. Date and Time Calb. value Fiename |
» Embient noise feld) Drefaut 08/29/2007 17-21 [rwall) D:AIGPPACa
Decoder Defaut 07/13/2006 17:50 (7] D:AIGPPACa
Diffuse field microphone Defaut 0741372006 1757 i) D:\3IGPPACa
Electiic connection replacing decodes Dedaut 0741372006 17:54 rwall) D:A3GPPACa
Electic connection replacing ear Defaut 10/11/2007 11:36 Irwal]) D:AIGPPACa
Elechic connection replacing encoder Defaul 07/13/2006 1754 i) DA3GPPACa
Electic connection replacing mouth Defauk 0711372006 17-51 [rwdl] D-\3GPPACa
Encoder Defaut 071372006 17:51 [rwall) D:AIGPPACa
Free field microphone Drefaut (06/07/2006 15:50 [rwall) D:AIGPPACa
Generic speaker Defaut 071372006 16:33 (7] D:AIGPPACa
HATS ITU-T P.58 Art. Mouth Defaut (06/07/2006 1547 i) D:\3IGPPACa
HATS Type 3.3 At Ear Defaut 06/07/2006 15:52 i) D:A\3GPPACa
| |HATS Type 3441t Ear Defaut 06/07/2006 1554 (i) DAIGPPACa
Induction coil [input) Defaur 07/13/2006 18:04 [rwal] D:A3GPPACa
Ingut chgkal Diefauk DB/07/2006 1549 [null) DAIGPPACa
LRGP ITU-T P.51 Art. Mouth Defaut 071372006 17:59 [rwall) D:AIGPPACa
Output dhgital Drefaut (06/07/2006 15:50 [rwall) D:AIGPPACa
Second Type 33 At Ear Defaut 071172007 1509 (7] D:A3GPPACa_ |
Second Type 34 At Ear Defaut 071172007 1509 i) D:\3GPPACa
Type 1 At Ear Defaut 06/07/2006 15:51 i) D:A\3GPPACa
- | Tvoe 3.2 Hioh Leak Art.Ear Dedaul 06/07/2006 15:51 Irwalll [ D:A3G F'F'\E:I
[Eoect usage type fist = gz Comcel | [ 0K Jl

Fig. 47 Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected.
Subsequently the table is reduced to available devices in this category. At
first startup, there is only a “Default” device for each category, but when
more devices have been created with the “New device” function, a choice
will be available in this view. In this state a row in the table can be marked
with a mouse click on its left end. A mouse click on the button “Select’
selects this device for the associated usage.
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Select Calibrated Devices

Usage Maru: |SIHNII | Date and Time | Calib. value
Type 3.2 Low Leak At Ea 1708754 04/22/2009 14:25 [rdl]
Type 3.2 Low Leak At Ea 07.13/2006 17.57 [rdl]
Type 3.2 Low Leak At Ea RADDSE & A 26740 & 4636 04/22/2009 14:27 [rdl]

»
[Tye 3210w leak at. car =l Select | Cancel | [ Ok JI

Fig. 48 Selection window for particular device type

Subsequently this procedure may be repeated for other categories. Finally
all selections are confirmed by clicking the “Ok” button.

All calibration data are stored on the R&S UPV hard disk and are therefore
automatically available again after every restart. The calibration values for
the R&S UPV-K9 option are stored independently of other options.

All calibration routines below require as pre-requisite that a device for the
respective usage has been generated and selected.

To simplify the procedure for the case that it is not intended to use multiple
devices of the same category or to include information about the used
devices into a report, there is a “Default” device selected for each device
type or category after the first start of the program.

An overview all selected calibration devices together with the calibration
values is given under the menu item “Calibration - Show selected
devices”.

Microphone Calibration
» Insert the measuring microphone fully into the adapter of the sound
level calibrator and switch on the calibrator.

Note: After inserting the microphone, wait about 10 s to allow for
static pressure equalization.

> Call the test routine with “Calibration = Microphone = Free field” or
“Calibration > Microphone - Diffuse field” from the main menu,
depending on the microphone.
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Microphone calibration

Connect microphone 1o analyzer input 1.
Insert microphone into calibrator using
adapter UC0210 and switch on calibrator.

[ Calibration level increased by 20 dB [not walidated]

[ Delay start by I I:IE: zeconds

Cancel | )3

Fig. 49 Initial window of microphone calibration

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in the
calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa, display
= 120 mV/Pa). If a conditioning amplifier with 20 dB gain (recommended
value) is used, the displayed sensitivity must be about 10 times higher. If
the voltage measured is below 3 mV, an error message is displayed.
Possible error sources are, for example, a switched-off microphone power
supply or a disabled calibrator. In this case, the program requests that the
test be repeated. After switching on the microphone power supply, wait
approx. 20 s before restarting the measurement with the “Ok” button.

Calibration of Artificial Ear

Prior to the measurements, the absolute sensitivity of the microphone in the
artificial ear must be determined using a sound level calibrator such as the
Briel & Kjeer 4231 with a sound pressure level of 94 dBSPL or a sound
pressure of 1 Pa at 1 kHz.

Calibration of Ear Type 1

Note: The use of artificial ear type 1 is not foreseen in TIA-1042. However,
R&S UPV-K9 offers the use of this device regardless whether it is
supported by the particular standard applied.

> Switch off the microphone power supply.

Note: The 200 V polarization voltage of the microphone may cause
a slight electric shock. The current is harmless, but the
microphone preamplifier may be damaged.
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» Remove the microphone from the artificial ear.

» Screw back the microphone capsule and switch on the operating
voltage.

> Insert the microphone fully into the adapter of the sound level
calibrator and switch on the calibrator.

Note: After inserting the microphone wait about 10 s to allow for
static pressure compensation.

> Select “Calibration = Artificial ear > Type 1” from the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in the
calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa, display
= 120 mV/Pa). If a conditioning amplifier with 20 dB gain (recommended
value) is used, the displayed sensitivity must be about 10 times higher. If
the voltage measured is below 3 mV or fluctuating by more than 0.2 dB, an
error message is displayed. Possible error sources are, for example, a
switched-off microphone power supply or a disabled calibrator. In this case,
the program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20s before restarting the
measurement.

The reference value measured is stored in a file on the hard disk and used
for all subsequent measurements when the same artificial ear type 1 is
used as currently selected.

Calibration of Ear Type 3.2 Low Leakage

» Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

> Select “Calibration > Artificial ear > Type 3.2 Low Leak” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the program
requests that the test be repeated. After switching on the microphone power
supply, wait approx. 20 s before restarting the measurement.

The measured reference value is stored in a file on the hard disk and used
for all subsequent measurements when the same ear type 3.2L is used as
currently selected.
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Reading the Calibration Data of Ear Type 3.2 LL

The frequency response of the artificial ear of type 3.2L is supplied on a
floppy together with the artificial ear. The data is used for transforming the
measurement values from the drum reference point to the ear reference
point.

» Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_LL.ADA” from the manufacturer’s calibration disk to a
USB stick or a CD-ROM or make this file available on a network drive via
LAN.

> Call the routine “Calibration - DRP to ERP Correction > Type 3.2 Low
leak”. Browse to the file “OES_LL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer, or
when the “Phone” directory has been renamed or removed.

Calibration of Ear Type 3.2 High Leakage

» Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

> Select “Calibration - Artificial ear > Type 3.2 High Leak” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the program
requests that the test be repeated. After switching on the microphone power
supply, wait approx. 20 s before restarting the measurement.

The measured reference value is stored in a file on the hard disk and used
for all subsequent measurements when the same ear type 3.2H is used as
currently selected.

Reading the Calibration Data of Ear Type 3.2 HL

The frequency response of the artificial ear of type 3.2H is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

» Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_HL.ADA” from the manufacturer’s calibration disk to a
USB stick or a CD-ROM or make this file available on a network drive via
LAN.

» Call the routine “Calibration - DRP to ERP Correction > Type 3.2 High
leak”. Browse to the file “OES_HL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer, or
when the “Phone” directory has been renamed or removed.
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Calibration of Ear Type 3.3

> Connect the sound level calibrator tightly to the artificial ear using the
adapter UA-1546 and switch the calibrator on.

> Select “Calibration - Artificial ear > HATS Type 3.3” from the main
menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The type 3.3 ear calibration requires the calibrator with adapter UA-1546 to
be held manually against the ear. If the HATS is installed remote from the
R&S UPV, the checkbox “Delay start by ... seconds” can be checked and a
time interval can be entered by which the start of the calibration
measurement is delayed. The countdown is displayed on the R&S UPV
screen.

Microphone calibration

Connect artificial ear to analyzer input 1.
Fut art. ear on calibrator with adapter part
lA1546 and switch on calibrator.

[ Calibration level increased by 20 dB [not walidated]

[V Delay start by I EE: zeconds

Cancel | )3

Fig. 50 Ear calibration window with delayed start

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the program
requests that the test be repeated. After switching on the microphone power
supply, wait approx. 20 s before restarting the measurement.

The measured reference value is stored in a file on the hard disk and used
for all subsequent measurements when the same ear type 3.2L is used as
currently selected.

Reading the DRP-ERP Correction Data of Ear Type 3.3

Call the routine “Calibration - DRP to ERP Correction > Type 3.3 >From
ITU-T P.57 Table 2b”. This procedure needs only be repeated when the
“Phone” directory has been renamed or removed.

Alternatively it is also possible to load individual DRP-ERP correction data
from a calibration disk. This option is not conformant with the standards.
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Reading the Diffuse Field Equalization Data of Ear Type 3.3

3GPP C.S0056-A (TIA1042-A), diffuse field equalization is applied to
receiving frequency response results with handset and headset UEs. Call
the routine “Calibration - Diffuse field equalization > Type 3.3 >From
ITU-T P.58 Table 3”. This procedure needs only be repeated when the
“Phone” directory has been renamed or removed.

Alternatively it is also possible to load individual diffuse field equalization
data from a calibration disk. This option is not conformant with the
standards.

Calibration of Ear Type 3.4

> Remove the pinna and the ear canal simulator, connect the sound
level calibrator tightly to the artificial ear using the short steel adapter
and switch the calibrator on.

> Select “Calibration - Artificial ear > HATS Type 3.4” from the main
menu.

For Head Acoustics HMS |II, calibrator B&K 4231 must be used in
conjunction with the short steel calibration adapter.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the program
requests that the test be repeated. After switching on the microphone power
supply, wait approx. 20 s before restarting the measurement.

The measured reference value is stored in a file on the hard disk and used
for all subsequent measurements when the same ear type 3.4 is used as
currently selected.

Reading the DRP-ERP Correction Data of Ear Type 3.4

Call the routine “Calibration - DRP to ERP Correction > Type 3.4 - From
ITU-T P.57 Table 2b”. This procedure needs only be repeated when the
“Phone” directory has been renamed or removed.

Alternatively it is also possible to load individual DRP-ERP correction data
from a calibration disk. This option is not conformant with the standards.

Reading the Diffuse Field Equalization Data of Ear Type 3.4

From Release 10 of 3GPP TS 26.132, diffuse field equalization is applied to
receiving frequency response results with handset and headset UEs. Call
the routine “Calibration > Diffuse field equalization > Type 3.4 > From
ITU-T P.58 Table 3”. This procedure needs only be repeated when the
“Phone” directory has been renamed or removed.

40 E-2



1402.0643.12

Acoustic Measurements on Mobile Phones

Alternatively it is also possible to load individual diffuse field equalization
data from a calibration disk. This option is not conformant with the
standards.

Calibration of Artificial Mouth for Handset Tests

Before a mobile phone can be tested, the absolute sensitivity and frequency
response of the artificial mouth have to be measured and corrected with the
aid of a previously calibrated pressure-field microphone. The measuring
microphone removed from artificial ear type 1 can be used for this purpose
or an additional microphone capsule is screwed to the microphone
preamplifier. The standard microphone is used as a reference for
determining the frequency response of the mouth. The frequency response
of the microphone can be ignored in the test frequency range (100 Hz to
8 kHz) (see also calibration certificate of microphone capsule).

Since interfering sound falsifies the corrections, the artificial mouth must be
calibrated in the sound-proof test chamber.

First of all, the measuring microphone has to be calibrated.

> Select a reference microphone type with “Calibration > Artificial
mouth = Select reference mic”.

For the selected microphone type, a device must be selected and calibrated
(see above). This device must be connected to R&S UPV analyzer input 1
via power supply/conditioning amplifier.

If the selected reference microphone is a diffuse field or pressure field type
(e.g. B&K 4131 or 4134) or a microphone from a Type1 artificial ear, fit the
microphone at right angles to the mouth at the mouth reference point
(MRP) using the gauge supplied with the mouth (positioning at right angles
is necessary because diffuse field or pressure-calibrated microphones have
a flat frequency response to sound from random incident direction and
therefore exhibit an emphasis on high frequencies with frontal sound
incidence).

If the selected microphone is a free field microphone, it must be mounted in
the axis of the sound outlet of the artificial mouth.

> Call the calibration routine with “Calibration = Artificial mouth >
LRGP ITU-T P.51” or “Calibration = Artificial mouth > HATS ITU-T
P.58” from the main menu.

The sound pressure generated at the MRP is set to exactly -4.7 dBPa in an
automatic measurement routine at 1 kHz. The generator voltage required is
stored in a file on the hard disk and used as a reference for all subsequent
settings with the same artificial mouth. If the sound pressure cannot be adjusted
to -4.7 dBPa, an error message is displayed with a request to check the
connection of the artificial mouth and to repeat the measurement. A possible
error source would be that the transformer supplied is not connected between
the generator and the artificial mouth.

The uncorrected frequency response of the artificial mouth is measured and
displayed. Next, the frequency response is measured with the inverse
frequency response correction automatically selected in the generator
(equalization). Residual errors caused by nonlinearities of the speaker in
the mouth are measured and taken into account in the final equalization file
as fine correction.

To verify the results, the absolute sound pressure versus frequency is
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measured at a sound pressure of 4.7 dBPa (reference value for most of the
measurements). The absolute sound pressure at each frequency must be
within a tolerance band of £0.2 dB. Correct calibration without interfering
sound yields an almost straight line in the middle between the two limit
lines.

Before sending tests can be performed, a reference spectrum calibration of
the sending signal at the Mouth Reference Point is required which equalizes
the speech signal “Normal” according to the measured frequency response
of the artificial mouth and measures the resulting acoustic spectrum at the
MRP.

Speech Spectrum Calibration

For tests using speech signal “Normal” or natural voice according to ITU-T
P.501 as test signal, the spectrum of the test signal has to be measured
and stored as reference spectrum for the transfer function (gain)
calculation. For sending and sidetone tests, the signal has to be filtered in
addition with the inverse frequency response of the artificial mouth. A
calibrated reference microphone must be placed at the Mouth Reference
Point (MRP) for this purpose. It is recommended to perform the reference
spectrum calibration directly after the mouth calibration, using sub-menu
item “Calibration—> Artificial Mouth > ... 2 With cdma2000 Ref. Spectrum”
or “Calibration> Artificial Mouth > ... > With P.501 Ref. Spectrum”,
respectively.

The reference spectrum calibration for the receiving direction does not
require external equipment or wiring. The reference signal at the output
from the R&S UPV generator to the speech input of the system simulator is
measured via internal connection to the R&S UPV analyzer input. For
narrow-band tests in receiving direction, a band-limited version of the test
signal is used. Each version of the test signal has to be calibrated
separately.

@UPU—KQV cdmaZ000{R) Mobile Phone Tests {D:\Phone’Results.xml})
File Data | Calibration Measurement Standards  Config, Meas. Sequence Repork  Options  Help
W Selective
el Microphons b | Test object |
L N
r (T =l T . , andset Marowband LUE 2
O o tf? lE:P c°r|fe°t_'°" > [Teminal Coupling Loss, B UE 2
r Ff:f e 'Z‘T_m”_ » el Noise Sending NB LE 2
[N ?[I) ;ISZ = :quta I?al;on IR , Mominal Yolume Setting LUE 2
r Ff.n. Tpen :n of Direction) Equalization ’ Lone Delay UE 2
r B Handset MB, nom. aol. UE 2
Artificial Mouth {Hands Free) 3 B .
r p ' el noise receiving, max. vol. UE 2
r Cod ec. ’ andset Marowband LE 2
r ; L;‘,m“ o , [Terminal Coupling Loss, NE_ UE 2
[T BT conneetons el Moise Sending NB UE 2
r cdma2000 ref. spectrum L T I S UE 2
r P.801 5T Speech Ref. Spectrum 4 Receiving » I N,
r AMPS 3 Sending Handset Art. Maouth LRGP ITU-T P51
r Background noise Field » Sending Handsfree * Ak, Mouth HATS ITU-T P.5&
I— Nelw Dewc? - st Marowband Glener-lc Speaker.
r Select Dew@ T erminal Coupling Loss, b Electric Connection
r ;’: Ete Te‘”lce el Noise: Sending NB LE 2
I how i l\ra uzsd i Maominal Yolume Setting LE 2
r Show selected devices Ltone Dielap UE 2
[ T P e v e -

Fig. 51  Submenu for reference speech spectrum calibration
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Calibration of CMU Speech Codec

The calibration of the speech coder and decoder is necessary to be able to
calculate absolute loudness. Calibration has to be performed only once and
must be repeated only if the CMU used is replaced.

Note that encoder and decoder are handled as separate devices but
calibrated with one routine.

Auxiliary settings required for calibration can be found in the CMU under
"Service Cfg.”. Call the calibration routines with “Calibration - Codec” from
the main menu.

The following information is displayed:

Establish call and set 'Bit Stream’ to 'DecoderCal'l

Fig. 52 Message box during decoder calibration

Set up a call to the mobile phone. Set bit stream or voice setting on the
CMU to "Decoder Cal" and then click the “OK” button.

The actual voltage at the decoder output of the CMU is now measured for a
digital full-scale signal and the required correction value is calculated and
saved in the R&S UPV. The following request is then displayed:

Set 'Bit Stream’ ko ‘EncoderCal'l

Fig. 53 Message box during encoder calibration

After the “OK” button has been clicked, the input sensitivity of the speech
coder is measured and the input voltage required for digital full scale is
measured at the speech coder and saved in the R&S UPV.

Calibration of CMW Speech Codec

The CMW500 does not provide the “Decoder Cal’ and “Encoder Cal”
functionalities. Instead the maximum peak input and output voltage can be
set in the user interface.
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= Speech Analysis

..... Routing AF1
----- Signaling Ho Connection
E- Control

E-""Input Level Full-Scale (Peak) 0.100 v

- Output Level Full-Scale [(Peak) 0.300 v

Fig. 54 Setting of the full-scale peak input and output values in the CMW
user interface

“Calibration — Codec — CMW” opens windows where these values can be
entered in unit mV in the mobile phone test program.

Calibration of Noise Field for “Speech Quality in Presence
of Background Noise” Test

Connections

Rear — "

Right +% Rear |
©-0 Left
A

Micraphone
Power

Supply
' ]
TRIGGERIN . Ay
o e T
Ea UPV 2 L
—'.-— :-JI— il 10 Front Front
-------- .'0“ .4 Right Left
r -] - = ‘-
u‘? sess UPp )
TRIGGEROUT "l

Fig. 55 Test setup and connection of external components for the
adjustment of the background noise field.

Connect

LAN socket of UPV to LAN socket of UPP

UPP trigger output to UPV trigger input

UPP-Z8A output 3 to input of front left active speaker
UPP-Z8A output 4 to input of rear left active speaker
UPP-Z8A output 5 to input of front right active speaker
UPP-Z8A output 6 to input of rear right active speaker

N o o ks~ o=

UPP-Z8A configured subwoofer output (by default 7) to input of
active subwoofer

8. Right artificial ear to UPV analyzer input 1 via microphone power
supply

9. Left artificial ear to UPV analyzer input 2 via microphone power
supply
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For the delay measurements, the operator will be prompted to modify the
input connections: a connection has to be made from UPP-Z8A output 10 to
UPV input 1, and both artificial ears have to be connected subsequently to
UPV analyzer input 2.

Optionally a UPZ input switcher can be used (see chapter 'Switcher
Support').

Establishing the remote control connection between UPV and UPP

After power up of both instruments and the interconnection with a LAN
switch cable, first an IP connection has to be established between UPV and
UPP.

1. Start the UPV-K9x program and open window “Options — UPP
remote control”.

2. Once the “LAN” LED on the UPP is on, press button “CASCADE /
LAN RESET” once and wait until the “CASCADE” LED is blinking.

3. Press the “CASCADE / LAN RESET” button again.

4. Click the “Find” button in the UPP remote control window on the
UPV.

5. Now the computer name on the UPP appears in the UPP remote
control window. Select it and close the window with “Ok”.

Prerequisites

The calibration of both artificial ears of the HATS is required for performing
the calibration of the background noise field.

Switcher Support

If “Input Switcher UPZ” is enabled in “Noise Calibration Configuration”, the
calibration process will try to connect all required signal sources
automatically to UPV input instead of prompting the operator to change
cabling. This presumes:

e UPV is connected to UPZ via serial cable (RS232) OR USB cable
(do not connect USB if you want to use RS232!);

e USB-to-serial device driver is installed (only if using USB
connection);

e UPZis powered ON (green 'ON'-LED on switcher front panel)
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Power
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Fig. 56 Test setup and connection of external components with input
switcher UPZ for the adjustment of the background noise field.

When starting the calibration process, a dialogue is displayed to instruct the
operator how to connect the input switcher's analogue input and output
connections. The connections to UPZ input channel 3, 4 and 5 are not
necessary for the calibration, but will be needed for later measurement
(note: only 1 microphone need to be connected to input channel 4 or 5,

respectively).

Switcher UPE

Please connect input switcher UPZ to UM

- switcher output channel 1to UMY analog input channel 1

- switcher output channel 2 to UMY analog input channel 2

Flease connect switcher input channels

- connect HATS output left ear to UPZ input channel 1

- connect HATS output right ear to UPZ input channel 2

- connect decoder output (ChYW, CRMU or CBT) to UPE input channel 3
- connect free field reference ricrophone to UPZ input channel 4

- connect diffuse field reference rmicrophone to UPZ input channel 5

- connect UPP-B2 output channel 10 to UPE input channel 6

EXH

8] 34

Fig. 57 Switcher support, analogue connection instructions.

or — if switcher could not be detected — how to establish the control

connection from UPV to UPZ:
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Snitcher UPE =

Input Switcher UPE not connected or switched off, Please check

- USE or Serial connection rmust be established between UPY and UPZ

- Powver cable must be connected to UPZ

- UPZ rmust be turned OM (rear panel)

- if using COM interface 'Used for' must be set to "Switcher' (Config Panel
- if using U3E interface 'USE Serial Port’ dewvice driver must be installed
'‘Cancel will continue without switcher; cabling must be dane manually!

Retry Cancel

Fig. 58 Switcher support, control connection instructions.

If the switcher cannot be enabled at this point, “Cancel” will disable switcher
for the current calibration. The cabling has to be done manually. The
corresponding setting in configuration window will not be changed. On next
start of calibration it will again be attempted to use the switcher.

The calibration process checks the connection to UPZ whenever the
switcher needs to be operated. If switcher control fails while calibration is
running (e.g. by unplugging the control or power cable), the user will be
prompted to establish the analogue connections manually. This allows the
calibration to terminate correctly:

Switcher UPZ [E3]

Suwvitcher not available; please establish UPV input connections rmanually:
- connect UPP-BE output channel 10 to UPY analog input channel 1
- connect HATS output right ear to UPY analog input channel 2

O

Fig. 59 Switcher support, error message if switcher failed during calibration.
Starting the calibration process

Before calibration can be started user has to select the reference
microphone:
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Measurernent  Standards  Config, Meas, Sequence  Report  Options  He
v Selective

Microphone ¥ Test object
Artificial Ear p Fresence of
) Presence of
DRP to ERP correction wsence of Am
Free field equalization P zzence of Am
Diffuse field equalization p zence of Am
N L ezence of Am
ID Independent of Direction) Equalization * seence of Am
Artificial Mouth b heance of Am
Artificial Mouth {(Hands Free) » eence of Am
Cadec y EENCE of Am
exence of Am
Induction cail
Electric connections *
cdrma20in ref, spectrum *
P.501 5T Speech Ref, Spectrum 3
ApAPS 3

-

Background noise field Select Reference Mic

Mew Dewvice Office Room

Fig. 60 Selecting the reference microphone for the background noise
calibration process.

Calibration is started by selecting the 'Office Room":

Background noise field * Select Reference Mic

Mew Dewvice Office Room

Fig. 61 Starting the background noise calibration process.

A brief set of cabling instructions appears first of all:

- -

Setup speakers and HATS according to ETSI Standard E5 202 396-1
Connect UPP generator

- channel 3 to speaker Front Left

- channel 4 to speaker Rear Left

- channel 5 to speaker Front Right

- channel 6 to speaker RearRight

- channel T to subwoofer (optional)

Ok

Fig. 62 Cabling instructions for the speakers.

Stopping and resuming the calibration process

The calibration process can be stopped at any time. All of the calibration
data recorded up to this point are then available and can be viewed in the
report.

48 E-2



1402.0643.12

Acoustic Measurements on Mobile Phones

To abort a running calibration (e.g. to improve the loudspeaker positions) is
possible in the following ways:

e |If a dialog box appears, click the "Abort" or "Cancel" button

8l

L] Moise Floor to high; 36.51371 dEspl(a); should be below 30 dBspl{a)!
. Improve noise absorption.

Abort I Retry | Ignore |

Fig. 63 Dialogue with 'Abort' button to abort calibration.

Delay Measurement =] |
‘: Speaker Front Right: delay cannot be neqgative (-1 ms).

Check connection of UPY analvzer channel 1; must be connected to UPP generator channel 1010
Complete Delayw measurement will be repeated!

"" Cancel |

Fig. 64 Dialogue with 'Cancel’ button to abort calibration.

e If measurement is running, click the "Cancel" button and confirm
with 'Break’:

x|

ﬂl Measuring ﬁ

BGMoize, noise floor measurement

‘ Cancel |

Repeat curent sequence |

Break Measurement

Would wou really like to brealk
the running measurement?

Return to
Break b eazurement

.

Fig. 65 Window during running measurement and 'Cancel'
confirmation dialogue.

After calibration has been stopped, a dialog box informs the operator about
the calibration section that was aborted.
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E5c

Background Maise Field Calibration aborted while level adjusting
Cwtside_Traffic_Road!

Ok

Fig. 66 'Calibration aborted' message, e.g. when level adjusting
Outside_Traffic_Road.

A calibration that had been aborted can be resumed at certain resuming
points. When restarting a calibration that partly had been finished the
calibration process will prompt the user at every resuming point

e to resume the calibration at this point (recalibrate this and the
following)

e to skip this calibration section
e to abort the calibration

By skipping all successfully terminated calibration sections, the calibration
process will be resumed at the beginning of the section where it had been
aborted. For details please see chapter 'Calibration Sections and Resuming
Points'.

Preparatory Measurements for Delay Measurement

Before the delay measurement is performed, additional plausibility checks
are carried out at each speaker to ensure that the wiring is correct and that
the sound pressure level is high enough.

Measurement of Sound Pressure

The unweighted sound pressure level should reach at least 80 dBspl (or the
value selected as 'Min sound pressure level' in configuration window, if
modified) at normal drive level.

8 x

] Level koo low on UPY channel 2 (70,2 dBspl)!
. Increase amplifier gain For Speaker Front Right by at least 9.8 dE!

Retry I Cancel |

Fig. 67 Message for insufficient level.

If this sound pressure is not reached, an error message appears which
cannot be ignored. After the gain factor of the external amplifier or active
speaker has been increased, the measurement can be repeated (by
selecting 'Retry").

Measurement of Level Change at Microphone Amplifier Output

During this measurement 2 different levels are successively applied to each
speaker. The output at the microphone amplifier (measured by UPV input
channel 2) is expected to change by the same amount (5 dB).
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sl x

Lewel sweep Failed on UPY channel 21
! Speaker Front Right not connected to UPP generator channel 5 or switched off,
Right Artificial Ear not connected to UPY analyzer channel 2

or power supply off
Cancel |

Fig. 68 Message for insufficient sound pressure level increase.

If the amplifier output does not change with the UPP output level, this may
have the following causes:

e the microphone amplifier is switched off
e the HATS ear is not connected to the correct amplifier channel

e the microphone amplifier is not connected or is incorrectly
connected to UPV input channel 2

e the desired speaker is switched off

o the desired speaker is not connected to the correct UPP output
channel

e the requested sound pressure level cannot be output by the
speaker (speaker gain to high or 'Maximum output level' to high),

After the error has been rectified, the measurement can be repeated by
selecting 'Retry'. If the configuration has to be changed, the calibration must
be aborted (‘Cancel’ button).

Measurement of Level Change at Reference Input

During this measurement 2 different levels are successively applied to UPP
output channel 10. The input level at UPV input channel 1 is expected to
change by the same amount (5 dB).

a x

] Level sweep Failed on UPY channel 11
L3 PP generator channel 10 not connected ko UPY channel 1.

Cancel |

Fig. 69 Message for insufficient level change at reference input.

If the reference input does not change with the UPP output level, there is no
connection between UPV channel 1 and UPP output channel 10.

After the error has been rectified, the measurement can be repeated by
selecting 'Retry'.

Delay Measurement

The delay measurement determines the time it takes for the sound to travel
from the speaker membranes to the left and right ear of the HATS. The
travel time and therefore the distance of the full-range speakers from the
HATS is measured by means of cross-correlation of the acoustic (sound
pressure) signal and the electrical reference signal.

Since the delay measurement is quite complicated owing to the required
cabling modifications, it can be skipped if a valid delay calibration is already
available and if the speaker layout and the HATS position have not been
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changed in the meantime. The latter is not recognizable by the calibration
process; it is therefore the responsibility of the user to repeat the delay
calibration if necessary.

Delay compensation =]

'.o.' Currently these distances between HATS and speakers are set:
W L7194 m from HATS to Speaker Front Left
1515 from HATS to Speaker Rear Left
1772 mifrom HATS to Speaker Front Right
1601 rr from HATS to Speaker Rear Right
1500 rm fram HATS to Subwoofer
Recalibration is required if position of HATS ar any speaker has been
rodified since last Calibration
Recalibrate delays?

Yes Mo Cancel

Fig. 70 Message querying the start of the delay calibration.

To perform the delay measurement, the reference signal from channel 10
of the UPP generator is connected to analyzer channel 1 of the UPV, and
the signal from the respective ear is connected to analyzer channel 2 (via a
preamplifier). Dialog boxes show which ear is currently being measured and
therefore must be connected (to UPV input channel 2. If the R&S input
switcher UPZ is used, the connection will be switched automatically without
any user interaction.

Delay Measurement =1 |

1 Connect UPP generator ch10 ko UPY analvzer chl,
Right Ear ko UPY analyzer chz,

Fig. 71 Instruction for connections during delay measurement.

This box must be confirmed after reconnection of the UPV analyzer; then
the measurement and the generator signal are started.

Connection problems can be determined from the measured value obtained
during the delay measurement:

e Checking of the delay differences between the measurement
channel and reference channel

Delay Measurement 8 x|

' Speaker Front Right: delay cannot be negative (-1 ms),
Check connection of UPY analyzer channel 1; must be connected to UPP generator channel 10!
Complete Delay measurement will be repeated!

Cancel |

Fig. 72 Plausibility check for the delay result.

If the reference channel has a greater delay than the measurement
channel, it is not connected to the reference signal but instead to
the 2nd channel of the microphone amplifier.
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Distance between the speaker and associated HATS ear is too
large

Delay Measurement =1 |

Speaker Fronk Right: delay too long (10 ms),
! 5 Left and right ear seems to be swapped or
distance to Right microphone o long {343 m)!
Check ear conneckions and position of Speaker Front Right

Cancel |

Fig. 73 Message for unexpectedly long delay.

If the measured distance is greater than the expected maximum
distance, the longer indirect sound path to the ear located opposite
may possibly have been measured. In this way it is possible to
detect inadvertent swapping of the HATS ears. The 'Max distance
HATS to speaker' can be adjusted in the configuration window after
cancelling the calibration.

Distance between the speaker and associated HATS ear is too
small

Delay Measurement =]

Speaker Front Right: delay cannot be measured; seems to be too shark (3 ms),
! Check distance to Right microphone {1,029 m)
and sound level of Speaker Fronk Right

Retry Ignare

Fig. 74 Message for unexpectedly short delay.

If the distance is less than the intended minimum distance, the
speaker is too close to the HATS. This warning can be ignored, if
the measured distance matches the actual position of the speaker.
The 'Min distance HATS to speaker' can be adjusted in the
configuration window after cancelling the calibration.

The measurement can be repeated after the cabling or the amplifier level
has been corrected.

If the R&S Input switcher UPZ is used, the connections are automatically
switched without any user interaction. Otherwise the cabling must be
changed during and after the delay measurement; the user is instructed to
do this in dialog boxes.

Ensure Right Ear is connected ko UPY analyzer chi,
Left Ear is connected to UPY analvzer chz,
and UPP TRiG Cut is connected to UPY TRG IN!

Fig. 75 Instructions for change of cabling during the calibration process.

The distance between HATS and subwoofer cannot be measured but must
be entered manually. This value is not critical for the measurement and can
be given with an accuracy of 10 cm.
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Subsvaofer Distance

EDD.DDEl: M
Cancel | Ok |

A

Fig. 76 Delay measurement, manual entry of subwoofer distance.

After completion of the delay measurement, it is thus ensured that the
HATS ears are correctly cabled and the output level is high enough. A list
showing all of the determined distances is displayed before the actual
equalization begins.

Delay cormpensation Ex

@ These distances between HATS and speakers have been measured:
! 1794 m fram HATS to speaker Front Left
L5165 rn frorn HATS ta Speaker Rear Left
1772 rn from HATS to Speaker Front Right
L1601 rm frorm HATS to Speaker Rear Right

L300 r from HATS to Subwoofer

Cancel

Fig. 77 List of determined distances.

Preparatory Measurements for Equalization

Equalization can only be performed successfully if the room acoustics meet
certain requirements.

Noise Floor

The acceptable noise floor is max. 30 dB(A)spl. If it is above this value,
equalization may fail in the case of weak noise fields.
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23

ﬂl Measuring ﬁ

BGMoize, noige floor measurement

| Cancel |

Repeat curment sequence ‘

Moise floor measurerment E3

Moize floor too high; 33.39922 dBspl{d); should be below 30 dBspl(D)!
Irnprovve noise absorption
ot continue with current noise floor by selecting IGNORE .

Ahort | Retry Ignore

Fig. 78 Warning for exceeded noise floor limit.

This warning is suppressed if 'lgnore uncritical level warnings' is activated in
configuration window. After the soundproofing has been improved, the
measurement can be repeated. "Ignore" continues the calibration process
although this limit has been exceeded.

Frequency Response of unequalized Speakers

The frequency response of each speaker before equalization is measured
in the range of 40 Hz to 20 kHz (or the range selected as 'Bandwidth
low/high' in configuration window, if modified).

The acceptable flatness deviation for fullrange speakers is max. +9 dB in
the range 50 Hz to 10 kHz (or the range selected as 'Flatness start/end at'
in configuration window, if modified).

The graph displays the frequency range that is to be equalized, the Y axis is
scaled from -20 to +20 dB. The limit curve shows the range that is checked
for flatness.

bl
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Fig. 79 Frequency response of unequalised fullrange speaker.

If the flatness deviation is above this value, equalization is hard to achieve
for the room, and the room properties and the speaker layout should be
improved before equalization is performed.

s

Pink equalization of Speaker Fronk Left aut of tolerance (9,95 dB)!
1\ Shoud be below 3 da!
Improve the set-up arrangement, use higher quality loudspeakers!

or continue with current set-up by selecting IGNORE

Retry | Ignore |

Fig. 80 Warning for excessive equalization needs.

'Ignore' continues the calibration process although this limit has been
exceeded.

This warning is suppressed if 'lgnore uncritical level warnings' is activated in
configuration window.

The final curve for each speaker and the flatness result for each fullrange
speaker are added to the report.

The subwoofer frequency response can be used to determine the cutoff
frequency, if unknown. If it is below the default value of 120 Hz, then the
actual cutoff frequency must be modified in the configuration window. If the
subwoofer does not pass frequencies down to 40 Hz, then the lowest third
octave should not be equalized. In this case the user should set the
Bandlimit Low in configuration window to 50 Hz. If it does not pass 50 Hz,
then this subwoofer is not appropriate for this calibration.

Fig. 81 Frequency response of unequalised subwoofer.

Total Harmonic Distortion

Measurement of the total harmonic distortion is performed for each speaker
at nominal level in order to prevent speakers from being overdriven. Since
destructive interference of the fundamental can occur at discrete
frequencies which then results in a poorer total harmonic distortion being
determined, the measurement is repeated at different frequencies in the
case of an error.
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comection Test =TI

) THD of Speaket Front Left out of tolerance;
L3 seems to be overdriven!

Retry | Ignore |

Fig. 82 Warning for excessive total harmonic distortion of a speaker.

If speakers with a high total harmonic distortion are used, the tolerance limit
'Max THD' must be set higher (e.g. -10 dB) in the configuration window.

Cabling Check

This measurement which was already performed during the delay
measurement is intended to ensure that the cabling is correct if the delay
measurement is skipped and after the cabling has been changed. The
results are the same as those under "Measurement of Level Change at
Microphone Amplifier Output".

Shared Equalization Method

The fastest way to establish a valid calibration is to equalize room and
speakers with only one signal — preferably Pink Noise — and use the
equalization data for all ambiances. Afterwards the levels of all ambiances
are individually adjusted. This is the default setting. Alternatively, the
operator can select any of the ambiances as equalization signal in the noise
calibration configuration window (see “Choice of calibration method”).

At the beginning of the equalization a check is performed to determine
whether a valid equalization data set is available. If this is the case,
equalization can be skipped (by selecting “No”) and the calibration process
continues with individual level setting:

Maise calibration |

'..;0..' Do youwant to update the Calibration using Pink MNoise now?
@ YESto recalibrate the complete noise field
MO to skip equalization and continue with lewvel setting
fusing existing equalization),
CAMCEL to abort calibration,

Wes Mo Cancel

Fig. 83 Valid Shared Equalization, recalibration prompt.

Once started, the equalization as well as the subsequent level adjustment
are largely performed without operator interaction. Input is only required if
errors occur and the operator is prompted for a decision on the next action.

During calibration process, the equalization result graph — if equalization
had been performed — and the values of the level adjustment are stored
and can be reviewed in the report after termination or abort of calibration.

Individual Equalization Method

Alternatively the calibration process can generate individual equalization
data for each ambiance. Depending on the room and speaker characteristic
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this method could generate even better flatness, but it is very time
consuming. Each ambiance will first be adjusted in level and then
equalized. Before starting the calibration process the operator has to select
this calibration method in the noise calibration configuration window (see
“Choice of calibration method”).

For each ambiance the existence of valid calibration data is checked. If this
is the case, equalization of this ambiance can be skipped by selecting “No”:

[ -

Moise calibration =

@=% Ambiance Pub_MNoise_W2 is already adjusted,
\ - ' Recalibrate?
~ ¥ESto calibrate this and all following armbiances,
MO ta skip this ambiance,
CAMCEL to abort calibration,

Yes Mo Cancel

Fig. 84 Valid Individual Equalization, recalibration prompt.

Once started, the level adjustment and equalization are largely performed
without operator interaction. Input is only required if errors occur and the
operator is prompted for a decision on the next action.

During calibration process each measured equalization result graph and the
values of the level adjustment are stored and can be reviewed in the report
after termination or abort of calibration.

Level Adjustment

Level adjustment is performed with a maximum of five iteration steps.
Normally two steps are sufficient to achieve the desired level tolerance
(< 0.3 dB, can be modified as “Max level deviation” in the noise calibration
configuration window). This number may not be sufficient for the subwoofer,
especially for ambiances with low energy in the low-frequency range. A
message is then displayed where the user can choose whether to accept
the actual level deviation or to perform a further iteration. This dialog box by
default is disabled in the noise calibration configuration window:

lgnore uncritical level warnings [v

Fig. 85 Checkbox for suppressing the message caused by excessive single
level deviation and other uncritical warnings.

Level adjustment is performed before (in case of individual equalization) or
after (in other cases) the single speaker equalization.

Equalization
Equalization is performed in 4 steps:
e single speaker equalization
e pairwise equalization of the two left and the two right speakers

o flatness check of all speakers
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o all speaker post equalization (optional)

Each of the two steps is performed with a maximum number of iteration
steps which is selected in the configuration dialog box. 2 or 3 iterations are
usually enough to achieve a flatness of 1 dB. If additional iterations are
desired (up to 5), the operator can modify this setting in the configuration
window

If the all speaker equalization check does not result in a PASS, the user can
try to achieve a PASS by repeating this measurement. This may be
successful if, for example, the tolerance violation is only slight or unwanted
noise had impaired the measurement.

Equalization check, Pink Noise (=] |

werification of all speakers including subwoaofer Failed!
! E Left Spectrum out of tolerance; 6,23 dB
Right Spectrurn out of tolerance; 6,34 dB
kotal level deviation left = 3.2 d&
total level deviation right = -0,39524 dB
Please select
ABCORT to abort equalization and improve the set-up arrangement (recommended),
RETRY to repeat this check,
IGMORE to proceed with next equalization step.

Retry | Ignore |

Fig. 86 Message for failed verification of all speaker equalizations.

This dialog can be suppressed by predefining the desired behavior in the
configuration window:

Action on final flathess dewviation | -

Ilze All zpeaker Equalization

Rety once
R ety hwice

Fig. 87 Selection of action on failed verification of all speaker equalizations
in the noise calibration configuration window.

Additionally optional post equalization can be performed if the all speaker
equalization check fails. Activated by default, this part of the calibration
slightly modifies the equalization of individual speakers to fulfil the flatness
requirement. The result of each intermediate step is displayed as a trace
during equalization. By selecting “Report intermediate steps” in
configuration window all these traces are stored in the report.

e L]

m o = e
Pugary 0

Fig. 88 Display of intermediate equalization results.
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All Speaker Post Equalization

Following an unsuccessful all speaker equalization check, it is possible to
adjust the all speaker equalization to within the +3 dB tolerance band by
subsequent correction of individual speakers.

Since the algorithm recommended by ES 202 396-1 is extremely time-
consuming and not always successful, a much faster post equalization is
selected by default. Alternatively user can select the ETSI recommendation
or deactivate the post equalization in the configuration window.

IJze All zpeaker Equalization v

All Speakers Post Equalization Fazt [recommended by BE&S]
according to ES 202 396-1

Repart intermediate steps

Fast [recommended by B&S]

Fig. 89 Checkbox in the noise calibration configuration window for
deactivating the additional all speaker equalization step.

Note: deactivating the “Use All speaker Equalization” is not recommended
because it will cause a final FAIL of calibration if the first all speaker check
fails.

If “All Speaker Post Equalization according to ES 202 396-1” is activated,
these further equalization steps are performed:

e Measurement of the crosstalk flatness separately for left and right.
If at least one of these is outside the tolerance, the crosstalk
speaker which impairs the frequency response most is determined
(by switching off the other crosstalk speaker). Starting with this
speaker, the four crosstalk speakers are equalized again
individually (next is the other speaker on the same side followed by
the next worse speaker) until the interaction of all speakers is below
the tolerance limit or repeated equalization of all four speakers was
unsuccessful.

e If this equalization step was unsuccessful, adjustment with the
direct speakers is attempted. Once again the direct speaker which
impairs the frequency response most is determined. Starting with
this speaker, the four direct speakers are equalized again
individually until the interaction of all speakers is below the
tolerance limit or repeated equalization of all four speakers was
unsuccessful.

If “All Speaker Post Equalization Fast (recommended by R&S)” is activated,
these further equalization steps are performed:

e Equalization of each pair (left and right) with the attenuated inverse
frequency response of the opposite pair.

¢ If this equalization step was unsuccessful, then equalization of each
pair (left and right) with the attenuated inverse frequency response
of the same pair.

If this equalization step is also unsuccessful, equalization has definitively
failed and must be repeated with improved room properties. After
successful termination of the background noise field calibration the
calibration data is valid and can be used for measurements in the presence
of background noise.
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Final Equalization check (=]

. \ Background Moise Field calibration /werification terminated
' osuccesstully!

Ok

Fig. 90 Message of successful calibration or verification.

Final Test of All Ambiances

This test performs a flatness and level check of each ambiance, with the A-
weighting filter activated. It can be performed during the calibration process
or separately after a calibration had successfully been terminated. So it
allows checking a valid calibration to see if any modification had been done
that requires a recalibration.

For each checked ambiance a report entry is generated with the graph
(documenting the flatness over frequency) and the numeric deviations of
flatness and level for left and right channel. Note that the +3 dB tolerance
limits in the graphs are displayed centered to the highest left and right
deviation.

If performed during the calibration process the final test section additionally
adjusts the total level to minimum level deviation of both channels. To have
this final level optimization it is strongly recommended not to deactivate the
final test!

Final test of all ambiances ™

Fig. 91 Checkbox for activation of the final test of all ambiances.

To perform the final test separately, the operator has to start the calibration
and skip all calibration sections. Note that the preparatory measurements
cannot be skipped but have to be done to ensure proper cabling. The final
test cannot be skipped but of course aborted at any time.

Calibration Sections and Resuming Points

The calibration process consists of the following sections, depending on the
calibration method used:

For Pink Noise Equalization or Equalization with shared ambiance:
e Delay Measurement
e Preparatory Measurements
e Pink Noise Frequency response before equalization
e Equalization with Pink noise or shared Ambiance
e Level adjustment of each ambiance
o Final test of all ambiances
For Individual Equalization of each ambiance:

e Delay Measurement

61 E-2



1402.0643.12

Acoustic Measurements on Mobile Phones

e Preparatory Measurements
¢ Pink Noise Frequency response before equalization
e Level adjustment and Equalization of each ambiance
e Final test of all ambiances

Resuming points are located after successful termination of

e Delay Measurement

Delay compensation

) Currently these distances between HATS and speakers are set:
"9" 1794 rn from HATS to Speaker Front Left
~ 1515 m frarm HATS to Speaker Rear Left
1772 m from HATS to Speaker Front Right
L1601 rn frorn HATS to Speaker Rear Right
1500 m from HATS to Subwoofer
Recalibration is required if position of HATS or any speaker has been
modified since last Calibration
Recalibrate delays?

Yes Mo Cancel

Fig. 92 Resuming Point after delay measurement

e Equalization with Pink noise or shared Ambiance

Moise calibration

=% [oyouwant to update the Calibration using Pink Maise now?
‘ ! YES to recalibrate the complete noise field
MO ta skip equalization and continue with lewel setting
{using existing equalization).
CAMCEL to abort calibration,

Yes Mo Cancel

Fig. 93 Resuming Point after (shared) equalization

e Level adjustment (and Equalization) of each ambiance

-

Maoise calibration

@=% Ambiance Pub_MNoise_W2 is already adjusted,

\ : ' Recalibrate?

~ ¥ESto calibrate this and all following armbiances,
MO ta skip this ambiance,

CAMCEL to abort calibration,

Yes Mo Cancel
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Fig. 94 Resuming Point after level adjustment or individual
equalization of any ambiance, e.g. Pub_Noise V2

Selecting 'Yes' always resumes the calibration at the current resuming point
(with the current beginning calibration section), 'No' skips the current
calibration section and goes to the next resuming point. If the calibration
section following the current resuming point is not valid, then the calibration
process will continue with this section.

Calibration Report

In the results overview of the main window an entry is available to open the
report of the — failed, aborted or passed — calibration process. For each
calibration that has been started a new entry is generated.

I 03/27/2n5121803 MNoise Field Adjustment Dffice Room PASS [rudl)

The complete report includes

e frequency response (unequalized) of all speakers
limit check is done for fullrange speakers only; no FAIL verdict

Frequency Response Speaker Rear Right

Soecyum [dB]
o
A

T T 1
] 100 1000 10000 20000
Frequency [Hz|

v RightEa A Uppes Imt /A Lowes linit

Fig. 95 Report Content: frequency response of unequalised
(fullrange) speaker

o all speaker flatness of equalization method used (graph and values)
limit check for flatness and level deviation
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Piri MNoise (all speskers including subwoofer)
&0

-

Spactrum [dBsp)
g

S

a1

T T T
40 100 1000 10009 20000
Frequency [Hz|

¥ LeftEs Right Ea /' Uppes Imt 7 Lower limit

Fig. 96 Report Content: All speaker flatness after equalization

final test results of all ambiances (graph, flatness and level
deviation)
limit check for flatness (FAIL verdict for individual equalization
method only) and level (including PASS/FAIL verdict)
Our=ide_Traffic_Crossroads (all spegkers including subwocfer)
€0

Spectrum [dE(&)sl]
a

T T 1
40 100 1000 10000 20000
Frequencs [Hz)

v LeflEa Right Ea W Upper Imit o Lowed limit

Fig. 97 Report Content: final test of each ambiance

other numeric calibration results
including Delays (verdict for fullrange speakers only), Noise Floor
(no FAIL verdict)

Values:

Value Result Lower Limit Upper Limit Verdict
Delay Speaker Front Left 523 ms 437 ms 729 ms PASS
Delay Spesker Rear Left 442 ms 437 ms 7.29 ms PASS
Delay Spesker Front Right 517 ms 437 ms 7.29 ms PASS
Delay Spesker Rear Right 467 ms 437 ms 729 ms PASS
Delay Subwoofer 437 ms

Noise floor 3378 daspl(A) 30,00 desplA)

Flatness Speaker Front Left 1163 d8 18.00 d8 PASS
Flatness Spasker Rear Left 15.46 dB 18.00 d8 PASS
Flatness Spesker Front Right 10.39 d8 18.00 dB PASS
Flatness Speker Rear Right 13.12 d8 18.00 d8 PASS
Pink Noise level dev left -1.56 d8 -2.00 d8 2.00 d8 PASS
Pink Noise level dev right -187 d8 -2.00 d8 2.00 d8 PASS
Pink Noise flatness left 349 d8 4.00 d8 PASS
Pink Noise flatness right 3.45 d8 4.00 d8 PASS

Fig. 98 Report Content: other numeric values
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e Test Parameters (configuration window and internal settings)
unused or irrelevant parameters are skipped

Test Parameters

Description: ETSI ES 202 396-1
V1.4.1 (2012-10) SW Version = Bets 2.3.4.64

MName

UPP setup folder

Sonic speed [m/s]

retry f single flatness beyond [dB]

Max noise floor [dBspl{A]]

left microphone ot UPY channel

right microphone at UPV channel

re-adjust level after equalization

Number of fullrange speakers

Number of subwoofers

Subwoofer connected to UPP Channel

Maximum output level [dBV]

Ear equalization

Bandiimit low [Hz]

Bandlimit high [Hz]

Flatness start at [Hz]

Value

343.0

Min distance HATS to speaker [m]
Max distance HATS to spewker [m]
Max level deviation [dB]
Max THD [dB]

Min Sound Pressure Level [dBspi]
Use Input Switcher UPZ

Modify speaker deluy
Additional delay FL [ms]
Additionel delay RL [ms]
Additional deley FR [ms]
Additional delay RR. [ms]

Max ibersbons dunng equalcston
Use Pink Noise for all equalizations
Pink Noise level [dBspl(A)]

Pink Noise: duration [s]

Pk Noise filename

Fina test of ol ambiances

Ignore uncritical level wamings
Action on final flstness deviation
Use All spesker Equalization

All spaaher Post-Equalzabion pobcy
Report intermediaste steps

Fig. 99 Report Content: Test parameters

True

&5

30
Purikhoise 1 680t 1 20sFikered. wav
True

False

[}
True

Fast (recommended by R&S)
False

HEFHEHH R T ey

e Calibration data (of HATS) used

Calibrations

Date/ Time Usage Manufacturer  Type Serial Operator Value
12032014 125853 HATS Type 1.3 At Ear Dwfaut M#inot Giung, ARTIaBmiIViF
CETECOM GmibH
12002014 125743 Second Type 3.3 Art Detault Meinof Gunz, -15.01 08
Ear CETECOM GmbH

Fig. 100 Report Content: HATS Calibration data

If the calibration process was aborted or partly skipped, only a subset of
these data is stored

If “Report intermediate steps” is activated in configuration window,
additional graphs and numeric values are stored which represent the
iteration of single speaker equalization, pair of speaker equalization and all
speaker equalization. To avoid this unnecessary information it is
recommended to activate this option only for support purposes.
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Operator

Under “Data->Operator” an operator’'s name can be entered which is stored
in association with all calibration and measurement results. If “Operator” is
activated in the report settings, the name will appear in all reports about
these measurements.

Test object

Under “Data - Test object > New” a description of the device under test
can be entered.

Test Object

M ame

|
Type

M anufacturer

Senal Humber

[ Immediately select this test object

Cancel | | Save and cloze

b

Fig. 101 Window for input of information about a test object

If the checkbox “Immediately select this test object” is checked, the test
object associated with the entered data is automatically selected upon
closing the window. The data of this selected test object will be stored in
association with all measurements and appear on the associated reports if
“DUT information” is activated in the report settings.

A previously entered test object can be selected with “Data > Test object
- Select”.
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General

Special problems caused by the coding and decoding algorithms of mobile
phones are encountered when measuring acoustic characteristics.
Vocoders are used to attain the lowest possible data rate. Mobile phone
voice codecs are optimized for transmitting human speech with low data
rate. Not the actual voice signals but only the filter and fundamental
parameters required for signal reconstruction are transmitted.

Purely sinusoidal tones normally used for audio measurements cannot be
transmitted with such a system. In commercially available mobile phones, no
special test interface is accessible which would allow to measure the
acoustic performance of the mobile without codec involved. Measurements
during normal operation can therefore only be performed via the air
interface with the speech coder and decoder included.

The codec types specified for the use in CDMA2000 phones even do not
transmit complex artificial test signals like modulated multisine according to
ITU-T P.501 or artificial speech according to ITU-T P.50 with sufficient fidelity.
Therefore TIA-1042 and TIA-1042-A specify the use of natural speech.
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Starting measurements

Measurements can be started from the “Measurement” menu. This menu
contains either all available measurements, or the measurements belonging
to the selected standard if the checkbox “Allow only selected
measurements” in the “Options - Select standard” window is checked.

The menu “Standards” allows to start any measurement, whereby the
measurements are structured into submenus according to the standards to
which they belong. This allows a quick and easy access to all available
measurements.

|Standards Config, Meas. Sequence Report  Options  Help

| TIA-1042:2005 3
TIA-1042:2005 and Auxiliaries

rhisck |'iardi | b sii Blasnlt -
13 Handset Marrow

3GFPZ Receiving Handset ME, nom. Yol.

3GPPZ Receiving Handset ME, max, Yal.

3GPPZ Receiving Handset ME, max. Wol., w. Limits
TIA-1042-A-2013 Handset \Wide and Auxiliaties 3GPPZ Idle chanmel noise receiving, masx, wal.
CDMAZK HHHF Marrow 3GPPZ Sending Handset Marrowband

3
3
TIA-1042-8-2013 Handset Marrow and Auxiliaries  »
»
»
3
CDMAZK HHHF Wide 4 3GPP2 Weighted Terminal Coupling Loss, ME
3
»
3
»
3

TIA-1042-A-2013 Handset Wide

CDMAZK DTHF and YMHF Marraw 3GPPZ Idle Channel Maoise Sending NE
CDMAZK DTHF and YMHF Wide 3GPPZ STMR ME, Mominal Volume Setting
Configurable Handset and Headset 3GPPZ STMR ME, All Yal, Steps
Configurable Handsfree 3GPPZ Talker Sidetone Delay

More ... 3GPPZ Delay ME, CMU

IGPP2 Talker Sidetone Delay U | e h”B* C'l‘_"w_ » b Nt
3GPP2 Fieceiving Handset ME, nom. o, UE 3GPP2 Speech Quality in Snd. in Presence of Ambient Moise NE
WIEET ldla mhamnal meisa ramaivina e sl 1E 2 BACE 1dla Chavmal Maica Bamai

Fig. 102 “Standards” menu with submenu for narrow band handset tests
according to TIA-1042-A-2013.

Functionality and control of the measurement macros

@EDMN Sending Handset [_[O]x

Sending sensitivity [dB re 1V/Pa]

B Messued stR =900 [ Mandatony lower imit [ Dested lowes imit
Bl Mandaton upper it B Desied upper i

Type 3.2 Low Leak AiLEa [CMU / CRTU S ample test object
Save curve as | Load curve | Sa'ﬁr:uﬁ\;e = mea:lfdml\eﬂ | CuEmmm oot Change Scale Create Report Clase

Fig. 103 Example of a measurement window
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When a measurement macro is started, e.g. from the “Measurement’
menu, the standardized measurement is immediately executed. With a
single measurement, the window of the measurement macro stays open
after the measurement is terminated. At that time, the following functionality
is available:

LT

IHmEmaEr

Show Cursor

Zhange Scale

[Daka Poink Size
Comrnenk

Save acreenshot as ..,

Fig. 104 Context menu of the graph window

Zooming

When the “Shift” key on the keyboard is pressed, the mouse cursor
changes to the zoom cursor. When the left mouse button is pressed, a
rectangle can be marked in the graph. As soon as the left mouse button is
released, the graph is zoomed into the area of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step.
“Unzoom” zooms completely out to the original scaling.
Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper
and lower bounds of both axes can be entered by numbers.

@Ehange Scale M =]

# MininnLmm # I aximum
| 1 EIEI.EIEI::I | 1 EIEIIIIEI.EIEI::I
" kirinnam ol =R

| S000=] | 0.00=]
Caricel ok |
dnce | /

o

Fig. 105 Window for changing the scale of the graph

Cursor

When the item “Show Cursor” is marked in the graph context menu, a
cursor is displayed which can be dragged along the graph with the mouse.
X and Y values of the data points below the cursor are displayed.
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Data Point Size

“Data Point Size” in the graph context menu opens a window in which the
size of marks at the measured data points can be specified. Moving the
mouse cursor over one of the marks causes the associated X and Y values
to be displayed.

Making Additional Measurements

The softkey “Add Measurement” triggers another measurement according
to the specification of the test. Loudness ratings and noise values are
calculated and displayed in the legend. However, limits are not checked,
and the report shows only the original results.

This function can e.g. be used to find the correct volume setting to pass
nominal RLR. It can further be used for adjustments in the device under
test.

Storing and Loading Curves

All curves in the graph can be stored to an ASCII file, and such curves can
be loaded back into the graph. The softkey “Store Curve” opens a window
in which a combo box offers choice between the legends of all curves in the
graph. The curve associated in which the selected entry is stored to the file
at the specified location.

Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a
R&S UPV format limit file with a specified shift in Y axis direction. This
functionality can be used to generate limit curves from “golden” devices for
evaluation purpose.

Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph
context menu, a comment can be entered and edited which will appear in
the report about the respective measurement.

Storing a Hardcopy of the Graph

With the menu item “Save Screenshot as ...” in the graph context menu, a
hardcopy of the current graph window with all numeric displays, legend etc.
can be stored as image. The current view of the graph including additional
curves, current scaling and size is copied. However, colours are inverted to
a printer-friendly colour set.
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Fig. 106 Hardcopy of measurement graph

Creating a Report

The softkey “Create Report” causes a report to be prepared. The report
preview window (see below) opens and shows the preview of the report.
Buttons in the preview window allow to print the report or to export it to PDF,
WORD, EXCEL or Rich Text format.

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is
returned to the R&S UPV-K9 main window. All relevant data associated with
the measurement is imported to the results data. A new entry appears for
the measurement as new row on the bottom of the overview data grid in the
main window.

Notes on Individual Measurements

Sending Frequency Response and Loudness Rating

Sending Frequency Response

The sending frequency response is specified as the transmission ratio in dB
of the voltage at the decoder output to the input noise pressure at the
artificial mouth.

The mobile phone under test is installed in the LRGP (loudness rating
guard-ring position) according to ITU-T P.76, and the receiver is sealed to
the artificial ear.

Natural speech with an active speech sound pressure level of -4.7 dBPa is
created with the artificial mouth at the MRP (mouth reference point), and
the corresponding output voltage spectrum is measured at the CMU speech

71 E-2



1402.0643.12

Acoustic Measurements on Mobile Phones

decoder output and compared to the reference spectrum obtained at the
MRP.

The sending frequency response must be within the (floating) mandatory
limit lines specified according to table 2.2-1 of TIA-1042. The absolute
sensitivity is not taken into account.

Table 2.2-1 of TIA-1042 also specifies “desired” limit lines as a target for the
acoustic design, which, however, are not mandatory to be passed. The sending
tests of R&S UPV-K92 display also the desired limit template which is centred
around the measured frequency response curve independently from the
mandatory template. A verdict for the desired limit is also shown, which,
however, does not influence the total verdict of the test case. TIA-1042-A does
not specify desired limit lines.

For each of the two templates, the offset of the measured frequency response
to the upper or lower limit line is calculated and then the whole limit template is
shifted to be centred with respect to the measured curve. Then another limit
check is performed. If the shifted curve is now within the limit lines, PASS is
output, otherwise FAIL is displayed. The limit check is performed at each
measured frequency. If the measured value and the end point of a limit line are
not at the same frequency, it may happen that the trace slightly crosses a corner
of the limit line although there are no limit violations. The remaining margin is
displayed. A negative margin shows the amount of limit violation.

Sending Loudness Rating

The sending loudness rating (SLR) takes into account the absolute
loudness in the transmit direction and weights the tones in compliance with
the normal sensitivity of the average human ear.

To this end, for narrowband connections the frequencies (Hz) of bands 4 to
17 are evaluated according to table 1 of ITU-T P.79. For wideband
connections bands 1 to 20 are evaluated.

Table 5 Band centre frequencies according to ITU-T P.79

Band 1 2 3 4 5 6 7 8 9 10

fm/Hz | 100 | 125 | 160 | 200 | 250 | 315 | 400 | 500 | 630 | 800

Band | 11 12 13 14 15 16 17 18 19 20

fm/Hz | 1000 | 1250 | 1600 | 2000 | 2500 | 3150 | 4000 | 5000 | 6300 | 8000

The sensitivity at each frequency is defined as the ratio dBV/Pa referenced
to the rated internal level in dBmO, and the sending loudness rating is
calculated according to formula 5-1 of ITU-T P.79. Note that loudness rating
values are loss values, i.e. a high loudness rating value indicates a low gain
and a low loudness rating value indicates a high gain.

Due to the input sensitivity tolerance of the CMU speech coder, the
individual sensitivity of the CMU used has to be taken into account in order
to calculate the sending loudness rating (see calibration routines).
According to TIA-1042, the sending loudness rating should be between
6 dB and 19 dB, with lower dB values corresponding to greater loudness
(6 dB = maximum loudness, 19 dB = minimum loudness). Target SLR
should be 11 dB. In TIA-1042-A the SLR shall fall within the range +11 dB
to +5 dB. The measured SLR is indicated in a window in the frequency
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response display and checked for compliance with these limits. In addition
to the numeric value, either PASS or FAIL is displayed.

The general PASS or FAIL information is obtained from the limit check of the
frequency response curve and the loudness rating. PASS is output only if both
the curve and the loudness value are within tolerances.

The AMPS version of this test ("“AMPS Sending Handset”) automatically looks
for existing CDMA2000 results with the same mobile. If a result is found, the
loudness contrast is displayed and checked against the limit of £3 dB.

@EDMN Sending Handset [_[O]x

Sending sensitivity [dB re 1V/Pa]

1000
Frequency [Hz]
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Fig. 107 Sending frequency response with SLR value displayed

Receiving Frequency Response and Loudness Rating

The following two measurement definitions are available, as the permissible
limit values of the loudness rating depend on the volume set in the mobile
phone under test: “CDMA Receiving Handset, nom. Vol.” checks loudness
rating limits for nominal loudness setting and at the same time compliance
with the frequency response limit template. “CDMA Receiving Handset,
max. Vol.” checks the receiving loudness rating at the highest volume
setting against a minimum. (Note: As the loudness rating is a loss value, a
high RLR is associated with a soft speech signal and a low RLR is
associated with a loud speech signal).

Receiving Frequency Response

The receiving frequency response is specified as the transmission ratio in
dB of the sound pressure in the artificial ear to the input voltage at the
speech coder input of the CMU. The measured sound pressure is
referenced to the ear reference point (ERP). For ear types 3.x, the
measuring microphone is applied to the drum reference point (DRP), which
is the reason why any measured value has to be converted to the ERP by
means of calibration factors. According to TIA-1042, the measurement
must be referenced to the ear reference point (ERP). For information only
there are separate measurements supplied with R&S UPV-K92 which
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measure referenced to the DRP.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the
HATS. In case of ear type 3.2, the receiver is sealed to the rubber gasket of
the artificial ear. If the low leak version of this ear type is used, care must be
taken that the defined leak opening at the circumference of the artificial ear
is not accidentally covered.

The speech coder is driven such that the received speech has an active
level of -19 dBmO (TIA-1042) or -16 dBmO (TIA-1042-A) on the digital side.
The sound pressure in the artificial ear is measured and evaluated.

Ear type 1 is not specified in TIA-1042 for measurements on CDMA2000
mobile phones. TIA-1042-A mandates the use of ear type 3.3 for receiving
tests.

The receiving frequency response must be within the (floating) mandatory
limit lines specified according to table 2.1-1 of TIA-1042 or TIA-1042-A,
respectively. The absolute sensitivity is not taken into account.

Table 2.1-1 of TIA-1042 also specifies “desired” limit lines as a target for the
acoustic design, which, however, are not mandatory to be passed. The
receiving tests of R&S UPV-K92 display also the desired limit template which is
centred around the measured frequency response curve independently from the
mandatory template. A verdict for the desired limit is also shown, which,
however, does not influence the total verdict of the test case. TIA-1042-A does
not specify desired limit lines.

For each template, The margins of the measured frequency response to
the upper and lower limit lines are calculated separately, and then the whole
template is shifted such that the resulting margins to upper and lower limit
are equal. Then another limit check is performed. If the shifted curve is now
within the limit lines, PASS is output, otherwise FAIL is displayed. The limit
check is performed at each measured frequency. If the measured value and the
end point of a limit line are not at the same frequency, it may happen that the
trace slightly crosses a corner of the limit line although there are no limit
violations. The remaining margin is displayed. A negative margin shows the
amount of limit violation.

Receiving Loudness Rating

The receiving loudness rating (RLR) takes into account the absolute
loudness in the receive direction and weights the tones in compliance with
the difference between an average speech spectrum and the normal
threshold of hearing in quiet of the average human ear.

To this end, for narrowband connections bands 4 to 17 are evaluated
according to table 1 of ITU-T P.79. For wideband connections bands 1 to 20
are evaluated.

The sensitivity at each frequency is specified as the ratio dBPa/V
referenced to the rated internal level, and the receiving loudness rating is
calculated according to formula 5-1 of ITU-T P.79.

Due to the input sensitivity tolerance of the speech encoder, the individual
sensitivity of the encoder input used has to be taken into account in order to
calculate the receiving loudness rating (see section “Calibration” above).

The receiving loudness rating depends on the receiving loudness set on the
mobile phone under test and, according to TIA-1042, should be between
-5 dB and +5 dB at a rated nominal loudness setting, with lower dB values
corresponding to a higher loudness. According to TIA-1042-A, the RLR
shall be between -1 dB and +5 dB, and the nominal target value should be
2 dB.
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To prevent damage to the human ear, the maximum receiving loudness
must not exceed a certain value. With the user volume setting of the mobile
unter test set to maximum, the RLR must not fall below -18 dB according to
TIA-1042 and it shall not be less (louder) than -13 dB according to TIA-
1042-A.

The measured RLR is indicated in a window in the frequency response
display and checked for compliance with these limits. In addition to the
numeric value, either PASS or FAIL is displayed.

According to TIA-1042-A, the RLR with the receive volume control set to
minimum shall not be higher (quieter) than 18 dB.

The AMPS version of this test (“AMPS Receiving Handset”) automatically
looks for existing CDMA2000 results with the same mobile and same volume
control setting. If a result is found, the loudness contrast is displayed and
checked against the limit of +3 dB.

@EDMN Receiving Handset, nom. Yol [_[O]x

Receiving sensitivity [dB re 1 Pa/V]
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Fig. 108 Receiving frequency response with RLR value displayed
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Wideband to Narrowband Loudness Contrast

For a mobile phone supporting both narrowband and wideband speech and
tested according to TIA-1042-A, the differences between the sending
loudness ratings in wideband mode and narrowband mode and the
differences between the receiving loudness ratings in wideband and
narrowband mode have to be reported as wideband to narrowband
loudness contrast.

For this purpose the UPV-K9y program provides a pseudo measurement
which does not really perform a measurement on the mobile phone under
test, but collects the loudness ratings from the result database and
calculates the difference. The evaluated loudness ratings must be
measured with the currently selected device under test. If more than one
result exists for a specific loudness rating of this device under test, the
latest result is used.
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Weighted Terminal Coupling Loss (TCLw)

The echo loss is the attenuation between the speech coder input and the
speech decoder output (gain of speech coder + decoder = 1). Normally the
echo loss is caused by internal acoustic coupling between the telephone
receiver and the microphone. Since the echo considerably reduces the
sound transmission quality, it must not exceed a certain value.

The mobile phone under test is positioned according to one of the options
listed in IEEE Std 269-2002. These options comprise the handset to be
mounted on the ear simulator used for the receiving measurements,
suspended in free air under anechoic conditions or facing a hard, smooth
surface free of any obstacles for at least 500 mm. The positioning of the
mobile for this test will greatly influence the result. Hence it should be noted,
e.g. as comment in the measurement result.

Artificial speech “Echoloss” is used as test signal and applied to the speech
coder. The spectral energy distribution of the generated signal is measured
in the third-octave bands from 200 Hz to 4 kHz. At the same time, the
spectral distribution in the output signal of the speech decoder is measured.
The echo loss is calculated from the differences of the bands according to
ITU-T G.122.

The actual gain of the speech coder and decoder must also be considered in
the result. This value is available in the CMU after calibration of the coder. In
addition, the attenuation of the echo path is displayed as a curve.

TIA-1042 specifies a TCLw of at least 45 dB; mobile phones with good echo
cancellers can meet this requirement. Since the microphone of the mobile
phone under test also picks up any side noise and treats it like an echo, it is
essential that the test chamber is well shielded against external noise.

@EDMN Weighted Terminal Coupling Loss [_[O]x
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Fig. 109 Typical result of echo loss measurement

Peak Acoustic Pressure Level

To avoid damage to the ear in use of the mobile phone, the maximum
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sound pressure level generated by the earpiece in the ear of the user
should be limited. IEC 60950-1 specifies a respective test using the test
signal “PeakLevel”’, a heavily clipped artificial signal which is designed to
produce a high output level at the speech decoder. The maximum sound
pressure level obtained in the measurement is checked against a maximum
of 42 dBPa (136 dB relative to 20 pPa) as specified in IEC 60950-1.

If a receive volume control is provided at the mobile, this test should be
performed with maximum volume setting.

@EDM.& Peak Acoustic Pressure Level - [O] x]

Peak acoustic pressure level = 14.42 dBPa
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Fig. 110 Typical result of peak acoustic measurement

Sidetone Masking Rating (STMR)

This test is not specified in TIA-1042. In this standard it is provided for
reference only.

The sidetone path is the deliberate output of a part of the signal picked up
by the microphone to the phone's receiver. This is to create a natural
hearing impression for the person speaking on the phone as is encountered
under normal conditions involving an acoustic path between mouth and ear.

If an artificial ear type 3.2 is used (TIA-1042), the mobile phone under test
is installed in the LRGP (ITU-T P.76), and the receiver is sealed to the
artificial ear. According to TIA-1042-A the mobile phone is mounted on the
HATS

The artificial mouth generates a test signal with a sound pressure of
-4.7 dBPa at the MRP (mouth reference point), and the sound pressure is
measured in the artificial ear. In the test according to TIA-1042-A, real
speech is used as test signal. In the measurement provided for reference
for use with TIA-1042, the test signal is a modulated multisine.

The attenuation of the sidetone path is determined at each frequency
according to table 1 of ITU-T P.79, and the sidetone masking rating (STMR)
is calculated according to formula 5-1 of ITU-T P.79 with the weighting
factors of table 3 of ITU-T P.79 taken into account. In addition, the gain of
the sidetone path is displayed as a curve.
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According to TIA-1042-A the STMR shall be between 15 dB and 23 dB for
the nominal setting of the volume control. For all other positions of the
volume control, the STMR shall be = 10 dB.

4 CDMA Sidetone Masking Rating - [O] x

Sidetone gain [dB re 1 Pa/Pa]

8

Frequency [Hz]
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Fig. 111 Typical measurement of sidetone masking rating

Stability Margin
This test is provided for reference only. It is not specified in TIA-1042 nor in
TIA-1042-A.

The stability margin is measured to test the susceptibility of the phone to
acoustic feedback and instability.

For the test, the telephone is placed on an even, hard board with the
receiver and microphone pointing downwards.

A loop is closed in the R&S UPV between the receiving and the voice
channel, and an overall gain of 6 dB is set. The gain of the coder is
automatically taken into account (see also Echo Loss).

To activate the loop, a noise signal of -10 dBmO in line with ITU-T O.131 is
applied for 1 s and then switched off, with the loop remaining closed.
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Fig. 112 Window during stability margin test

The test person has to listen to determine whether any resonances or
oscillations are produced. If there are no oscillations, the minimum
requirements according to 3GPP TS 26.131 for a stability margin of 6 dB
are met.

Stability Loss

This test is not specified in TIA-1042 or TIA-1042-A. It is provided as an
auxiliary measurement for reference.

From release 10 of 3GPP TS 26.132, the stability margin test case is
replaced by a stability loss test case. The test measured the attenuation
between input and output of the system simulator, similar to the echo loss
measurement. Other than with the echo loss measurement, the result is not
integrated over frequency, but the spectral minimum is searched.

The test routine first looks for valid delay results of the selected device
under test in sending and receiving direction. If no results are found, or if
the delay results are older than specified in the parameters of this
measurement, the UE has to be first mounted on the HATS for the delay
measurements.

When valid delay values are available, the mobile has to be set up
according to the following illustration:
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Fig. 113 Test setup for stability loss test

As soon as the operator has acknowledged the UE to be correctly placed, a
PN signal with high rms level is send to the network interface, and the
returned signal at the output of the system simulator after the roundtrip
delay is measured. The spectral attenuation is calculated from the
difference of the level spectra.

b 3GPP Stability loss WB, Rel. 10

Echo path loss [dB]

1000
Frequency [Hz]
BB Measued Stab Loss =5663 8 [ Noise
HATS Type 33 At Ear  |CMU /CBT Examphe Test Mobile
Save Curve as | Load Cusve | BML“&;—“": e H“:fdm Em Delete Curve Create Report Close

Fig. 114 Window of stability loss test
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A second measurement is performed without test signal to show the noise
“floor” of the measurement. As the graph plots the path loss, the noise-
induced result will usually be above the stability loss result.

Echo Control Characteristics

This test is not specified in TIA-1042 or TIA-1042-A. It is provided as an
auxiliary measurement for reference.

The “Echo Control Characteristics” test has been added to 3GPP TS
26.132 in Release 11. It requires update key UPV-K9201 and option second
analog generator (UPV-B3). It is a so-called “double-talk” test in which test
signals are sent in both uplink and downlink direction simultaneously. The
signal sent by the mobile to the network simulator is analyzed.

The uplink signal contains a section with single words separated by pauses
(“single near-end words”) and a section with continuous talk (“continuous
double-talk”). These sections are analysed separately.

In a first run, both uplink and downlink signals are played simultaneously. In
a second run only the uplink signal is played while the downlink path is
silent. The level difference between both situations is analyzed in frames of
5 ms. The results are summarized separately for the following two
categories:

“Double-talk” frames are defined as the frames where both the far-end
(receiving direction) signal includes active speech (extended with a hang-
over period of 200 ms) and the near-end signal is composed of active
speech.

“Far-end single-talk adjacent to double-talk” frames are similarly defined as
the frames with active far-end speech and no active near-end speech.

The test method measures the duration of any level difference between the
sending signal of a double-talk sequence (where the echo canceller has
been exposed to simultaneous echo and near-end speech) and the sending
signal of the same near-end speech only. The level difference is classified
for each of the two situations (with and without simultaneous downlink
signal) and for each of the two classified frame categories separately into
eight categories according to the following figure and table:
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Fig. 115 Classification of level differences and their duration into
categories
Cat Level difference (AL) Duration (D) Description
Al -4dB<AL<4dB Full-duplex and full
transparency
A2 -15dB<AL<-4dB Full-duplex with level
loss in Tx
B AL <-15dB D <25ms Very short clipping
C AL <-15dB 25ms <D <150 ms Short clipping resulting
in loss of syllables
D AL <-15dB D> 150 ms Clipping resulting in loss
of words
E AL >4 dB D <25ms Very short residual echo
F AL >4 dB 25 ms <D < 150 ms Echo bursts
G AL >4 dB D >150 ms Continuous echo
Table 6 Description of categories

For each category, the ratio of frames in this category to the total number of
frames is given, as well as the average level difference.
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Fig. 116 Result screen of the “Echo Control Characteristics” test.

Interpretation of the results:

A positive level difference means that the level of the signal sent by the
mobile is higher with simultaneous downlink speech than without. This is an
indication of echo.

Short duration (category E) indicated short echo bursts.
Long duration (category G) indicates continuous echo.
A negative level difference is an indication of clipped uplink speech.

Short duration (category B) indicates short clipping, e.g. at the start of
sentences or words.

Medium duration (category C) indicates loss of syllables.

Long duration (category D) indicates continuous high attenuation.

Sending Distortion

This test is provided for reference only. It is not specified in TIA-1042 nor in
TIA-1042-A.

The mobile phone under test is installed in the LRGP or on the HATS.

There are two versions of this test according to 3GPP TS 26.132. The
earlier version is valid up to release 8 and provided as auxiliary
measurement to TIA-1042. The latest version is valid from release 9 and
provided as auxiliary measurement to TIA-1042-A.

A pulsed sinusoidal tone with a pulse length of approx. 360 ms is used for
the measurement.

For tests according to the earlier version, the frequency of the tone is 1015
Hz. At this frequency, coding yields a sufficiently stable output signal. Voice
activity detection continues to be active in the mobile phone under test due
to this pulsating signal.
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The test signal is generated with the artificial mouth at the MRP (mouth
reference point) and the SINAD value of the received signal is measured at
the R&S CMU200 decoder output.

The acoustic reference level (ARL) is defined as the sound pressure which
creates a signal level of -10 dBmO in the transmit channel. In the earlier
version, an automatic routine varies the sound pressure at the artificial
mouth until the desired level is attained. This value is then used as a
reference for determining the SINAD value versus level. The SINAD value
is measured at sound pressures between -35 dB and +10 dB relative to the
acoustic reference level (ARL) and compared with the limits specified in
table 7 of 26.131 of 3GPP.

Signal processing of a modern mobile phone comprises a voice activity
detector which determines whether a voice signal is present or whether the
sending signal just comprises background noise. For this reason the
sending distortion measurement omits levels below -25 dB and starts at
high test tone levels gradually reducing the level.

The measurement is performed up to a maximum sound pressure of 10 dBPa
at the artificial mouth if the value 10 dB relative to ARL with 10 dBPa cannot be
attained. The actual trace may therefore end at a lower pressure. This occurs
for mobile phones under test which have a low sensitivity in the transmit
direction.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.

4 3GPP Distortion sending Rel. 6 - [O] x

Sending signahto-distorion ratio [dB]

2 20 10 0 10 15

Sending signal level [dB relative to ARL]
. Measured . Lowser Limit
3GPP HandS Mamow Type 3.2 Low Leak AtEa |CMU / CBT Sample Object
Save Curve as Add Enter
Save Curve as Load Curve Limst File Moans " C " Delete Curve Create Report Cloze

Fig. 117 Sending distortion measurement

In the latest version of this test, additional measurements are performed at
the frequencies of 315 Hz, 408 Hz, 510 Hz and 816 Hz with a SPL of -4.7
dBPa at the MRP. Other than in the previous version of the test, the levels
are not defined relative to ARL, but as absolute SPL at the MRP. A CSS
activation signal is issued before each measurement to activate the VAD
(voice activity detector) of the mobile under test. Alternatively an activation
signal specified by the terminal manufacturer may be used. To avoid an
impact of the activation signal on the result due to the processing delay in
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the transmission chain, the test routine comprises a delay measurement.
The start of the analysis is delayed against the start of the test signal by the
measured delay time.

1 2 5 4 5 & 7.8 g

Fig. 118 Recommended activation signal according to the latest version of
the sending distortion test

@ 3GPP Distortion Sending Wide, Rel. 8 [_[O]x

50 50

.
(=]

-]

Sending signahto-distorion ratio [dB]

25 -10 0 10 200 1000 2000
Sending signal level [dBFa] Frequency [Hz]
B Messuwed [ Lower Limit B8 Measued [ Lower Limit
HATS Type 334 Esr  |CMU /CBT Sample Test Dbject
Save Curve as Load Curve Save Cutve as Add Enter Delete Curve Create Report Cloze
Limik File Measurement Comment

Fig. 119 Sending distortion measurement for wideband according to the
latest version of the test

The UPV-K9y software provides the CSS activation signal as a default.
However, before first use the signal has to be imported using “Options >
Activation Signal - Import” (see Chapter 2). This step checks the
conditions on the wav file and calculates the active level of the signal. With
the same menu item also other wave files can be imported for use as
activation signal. The wav files must be mono with 48 kHz sampling
frequency and have a duration of 10 seconds or less.
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For the sending direction the activation signal must be pre-equalized
according to the inverse frequency response of the artificial mouth. This can
be done during import of the wav file. After a re-calibration of the artificial
mouth, the equalization has become obsolete and has to be re-done. The
macro for the test case automatically detects an obsolete equalization of
the activation signal and does a new equalization before the test is started.

If more than one activation signal is imported at the same time, the signal to
be used can be globally chosen with menu item “Options > Activation
Signal > Select’. In addition, the measurement definition for this test case
has a parameter to specify the file name without extension of the activation
signal to be used. If this parameter is provided, it overrides the global
choice of the activation signal. Thus the test can be repeated several times
within a sequence, using different activation signals.

The test macro for distortion tests with activation signals from wav files also
provides a spectrum display of the signal sent by the mobile. This is
provided for information e.g. for troubleshooting purpose.

Receiving Distortion

This test is provided for reference only. It is not specified in TIA-1042 nnor
in TIA-1042-A.

The mobile phone under test is installed in the LRGP (ITU-T P.76) with the
receiver sealed to the artificial ear, or on the HATS.

The SINAD ratio in the receiving path is measured as a function of the acoustic
signal level.

There are two versions of this test according to 3GPP TS 26.132. The
earlier version is valid up to release 8 of 3GPP TS 26.132 and provided as
auxiliary measurement to TIA-1042. The latest version is valid from release
9 of TS 26.132 and provided as auxiliary measurement to TIA-1042-A.

A pulsed sinusoidal tone is used for the measurement.

For tests according to up to release 8 (narrowband) and up to release 7
(wideband), the frequency of the tone is 1015 Hz. For measurements
according to later releases the frequency is 1020 Hz (see also table 12
below). At these frequencies, coding yields a sufficiently stable output
signal.

Voice activity detection continues to be active due to this pulsating signal.

The test signal is applied to the input of the speech coder, and the SINAD
value of the sound pressure in the artificial ear is measured with
psophometric weighting according to ITU-T G.714.

The SINAD value of the sound pressure is measured at levels between
-45 dBm0 and 0.

The measurement is performed up to a maximum sound pressure of
10 dBPa in the artificial ear; the actual trace may end at an earlier point if
this maximum sound pressure is reached.

If the operator desires to see the receiving distortion value at the point
exceeding 10 dBPa, this can be achieved by pressing the “add
measurement” button. This causes the measurement to be repeated at all
specified levels. The second measurement is not taken into account for
reporting and Pass/Fail decision.
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@'J.’-PF‘ Distortion receiving [_[O]x

Receiving signalto-destortion ratio [dB]

30 £
Receiving ssgnal level [dBml]
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3GPP HandS Mamow Type 3.2 Low Leak AtEa |CMU / CBT Sample Object
Save Curve as Add Enter
Save Curve as Load Curve Limst File Measusement | C " | Delete Curve | Create Report Cloze

Fig. 120 Typical result of receiving distortion measurement

For tests according to the latest version, additional measurements are
performed at the frequencies of 315 Hz, 408 Hz, 510 Hz and 816 Hz with a
digital level of -16 dBmOQ at the network interface (encoder input). An
activation signal precedes the test signal. To avoid an impact of the
activation signal on the result due to the processing delay in the
transmission chain, the test routine comprises a delay measurement. The
start of the analysis is delayed against the start of the test signal by the
measured delay time.

4 3GPP Distortion Receiving Wide, Rel. 8 - [O] x

=

Receiving signalto-destortion ratio [dB]

50 40 30 20 10 0 s 200 1000 2000
Receiving signal level [dBm0] Frequency [Hz]
B Messuwed [ Lower Limit B8 Measued [ Lower Limit
HATS Type 334 Ear  |CMU / CBT Sample Test Object
Save Curve & Load Curve ‘3"":"&;"': SN ”’fgm | cm | Delete Curve | Creats Report | Close

Fig. 121 Typical result of receiving distortion measurement in wideband
according to release 8.
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A CSS activation signal is recommended. Alternatively an activation signal
specified by the terminal manufacturer may be used.

The UPV-K9y software provides the CSS activation signal as a default.
However, before first use the signal has to be imported using “Options >
Activation Signal - Import” (see Chapter 2). This step checks the
conditions on the wav file and calculates the active level of the signal. With
the same menu item also other wave files can be imported for use as
activation signal. The wav files must be mono with 48 kHz sampling
frequency and have a duration of 10 seconds or less.

If more than one activation signal is imported at the same time, the signal to
be used can be globally chosen with menu item “Options - Activation
Signal > Select”. In addition, the measurement definition for this test case
has a parameter to specify the file name of the activation signal to be used
(without extension). If this parameter is provided, it overrides the global
choice of the activation signal. Thus the test can be repeated several times
within a sequence, using different activation signals.

The test macro for distortion tests with activation signals from wav files also
provides a spectrum display of the signal output at the earpiece of the
mobile. This is provided for information e.g. for troubleshooting purpose.

@ IGPP Distortion Receiving Wide, Rel. 9 [_[Of x

Spectrum at Art. Ear [dBPa]

100 1000 10000
Frequency [Hz]
B oen Y 5@
HATS Type 33 At Ear  |CMU /CBT 'WE Test Mobie #3
Save Curve as Add .
Save Curve as Load Curve Limst File Moans " | HideSuctlunl Delete Curve | Create Report | Cloze

Fig. 122 Spectrum display of the receiving distortion test

During the test, the latest spectrum is displayed. After the test has finished,
button “Show Spectrum” or “Hide Spectrum”, respectively, toggles between
spectrum display and result display. In this state the spectra to be displayed
can be configured in the context menu of the graph, and the spectra can be
exported to ASCII files.

Idle Channel Noise Sending

In TIA-1042 this test is provided for reference only.

The noise voltage at the speech decoder output is measured with the
phone set up in a quiet environment (<30 dB(A)).
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When using a type 3.2 ear, the mobile phone under test is installed in the
LRGP (ITU-T P.76). When using a type 3.3 ear, the mobile phone under
test is mounted on the HATS.

The decoder output voltage is measured, weighted psophometrically
according to ITU-T G.223 and recalculated for the internal level in dBmOp.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied. The noise level is measured during the signal
pauses. The voice activity decoder (VAD) is activated and the mobile phone
remains in the active normal sending mode.

The idle noise level should not exceed -64 dBmOp. The measured noise
voltage is also displayed as a spectrum, making it easier to find causes if
the limit value is exceeded.

@EDMN Idle channel noise sending _[O]x

CCITT -weaghted spectium [dB]

1000
Frequency [Hz)

BB Messued, Noise = -72.25 SBmlIF)

Type 3.2 Low Leak AnEa |CMU / CRTU Sample test object
Smmasl Load curve | Sa'ﬁ:‘;:“l Ma:fd " | CEml | Change Scale | Create Report | Cloze

Fig. 123 Typical result of sending noise measurement

In TIA-1042-A a newer version of this test is provided, using a CSS
activation signal. When measuring a narrowband correction, the noise is
psophometrically weighted. In a wideband measurement, the noise is A-
weighted.

Idle Channel Noise Receiving

In TIA-1042 this test is provided for reference only.

The sound pressure in the artificial ear is measured with the phone set up in
a quiet environment.

When using a type 3.2 ear, the mobile phone under test is installed in the
LRGP (ITU-T P.76), and the receiver is sealed to the artificial ear. When
using a type 3.3 ear, the mobile phone under test is mounted on the HATS.

The sound pressure in the artificial ear is measured with A-weighting on.

To keep the mobile phone under test in the normal operating mode, a
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pulsed signal is applied to the speech coder input. The noise level is
measured during the signal pauses. The voice activity decoder is activated
and the mobile phone remains in the active normal receiving mode.

With rated loudness set on the mobile phone, the sound pressure should
not exceed -57 dBPa(A). In this case use test “3GPP Idle channel noise
receiving, nom. Vol”.

At maximum receiving loudness, the sound pressure should not exceed
-54 dBPa(A). In this case use test “3GPP Idle channel noise receiving, max.
Vol.”.

The measured noise voltage is also displayed as a spectrum, making it
easier to find causes if the limit value is exceeded.

@EDMN Idle channel noise receiving, nom. vol. [_[O]x

ing = -60.96 dB

Aweighted spectium [48]

1000
Frequency [Hz]

B8 Messued, Noise = 60,96 @BPal4)

Type 3.2 Low Leak AnEa |CMU / CRTU Sample test object
Save curve as | Load curve | Sa'ﬁ:‘“\’:“ | Ma:fd " | CEml Change Scale Create Report Cloze

Fig. 124 Typical result of receiving noise measurement

This measurement makes high demands on the sound insulation of the test
chamber and the S/N ratio of the measuring microphone including
preamplifier in the artificial ear. A comparison measurement with the test
mobile phone switched off or without a DUT shows the measurement
reserves of the test equipment. Due to the low inherent noise of the Audio
Analyzer R&S UPV, measurements can be made to about -80 dBPa(A) at
0 dB microphone gain, and even to lower values when a higher microphone
gain is set.

In TIA-1042-A a newer version of this test is provided, using a CSS
activation signal.

Talker Sidetone Delay

The sidetone delay measurement is specified in TIA-1042-A only.

The sidetone delay is measured by cross-correlation between the electric
input signal to the artificial mouth and the electric signal from the artificial
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ear. The sidetone delay is defined as difference between first and second
maximum of the cross-correlation envelope.

Test signal is a short word “five” of real speech according to ITU-T P.501.
Before the test, the test signal is offline-filtered according to the mouth
speaker equalization curve obtained during mouth calibration. This offline
filtering is only performed when the valid speaker equalization curve is
newer than the file with the filtered test signal.

4 3GPP Sidetone Delay, Rel. 10 - [O] x

17.n?

Ervelope of Cross Comelation / %

30 40 42667

20
Delay [ms]
BB Messued, Delay = 163 ms
HATS Type 334t Ear  |CMU /CBT Example Test Mobile
Save Curve & Load Curve Sa'l_".rc;;"':“l Hm“:"m | CE““" Delete Curve | Creats Report | Close
Fig. 125 Typical sidetone delay result according to release 10

Mobile Station Delay

In TIA-1042-A the measurement of the roundtrip delay is required. The
roundtrip delay is defined as the sum of the contributions of the UE under
test to the uplink and downlink end-to-end delay. To obtain the roundtrip
delay value, the end-to-end delay can either be measured separately for
uplink and downlink, or the loopback delay can be measured by
establishing a loopback of the voice data in the system simulator. In both
cases the contribution of the system simulator has to be subtracted from
the measured end-to-end delay. The method specified in TIA-1042-A is
using the loopback in the network simulator.
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Fig. 126 Typical roundtrip delay result

The loopback delay is measured by cross-correlation between the
generator output signal and the analyser input signal.

Test signal is a short word “five” of real speech according to ITU-T P.501.

Speech Quality in Presence of Ambient Noise

Setup
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Fig. 127 Test setup and connection of external components with CMW500
and input switcher UPZ for measurement “Speech Quality in Presence of
Background Noise”

The arrangement of the elements in the block schematic does not reflect
the physical setup in the test room. See ETSI ES 202396-1 for details on
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the requirements for the test room and the speaker setup. For the speaker
positioning the following rules and advice apply:

The four full-range speakers are to be arranged in a square

Distance of each of the four full-range speakers from the center of
the HATS is 2m

Avoid positioning any speaker in any of the room corners

Avoid positioning of speakers including subwoofer or HATS exactly
in the room center or at one half, one third or one fourth of the room
length or width

Connections

Connect

1.

N o o bk wDd

®

10.

11.

LAN socket of UPV to LAN socket of UPP

UPP trigger output to UPV trigger input

UPP-Z8A output 3 to input of front left active speaker
UPP-Z8A output 4 to input of rear left active speaker
UPP-Z8A output 5 to input of front right active speaker
UPP-Z8A output 6 to input of rear right active speaker

UPP-Z8A configured subwoofer output (by default 7) to input of
active subwoofer

UPV generator output 1 to artificial mouth via drive amplifier

Artificial ears to microphone power supply during noise field
calibration

During the acquisition for the speech quality evaluation, a 4"
microphone is connected to UPV analyzer input 1 via the
microphone power supply

Output 1 of the CMU / CMW to UPV analyzer input 2.

Switcher Support

If 'Input Switcher UPZ' is enabled in 'Noise Calibration Configuration’, the
measurement will try to connect all required signal sources automatically to
UPV input instead of prompting user to change cabling. This presumes:

UPV is connected to UPZ via serial cable (RS232) OR USB cable
(do not connect USB if you want to use RS232!);

USB-to-serial device driver is installed (only if using USB
connection);

UPZ is powered ON (green 'ON'-LED on switcher front panel)

When starting the measurement the first time, a dialogue is displayed to
instruct the user how to connect the input switcher's analogue input and
output connections (note: only 1 microphone needs to be connected to
input channel 4 or 5, respectively):
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Swvitcher UPE (3]

Flease connect input switcher UPZ to UPW:

- switcher output channel 1to UPY analog input channel 1

- switcher output channel 2 to UPY analog input channel 2

Please connect switcher input channels

- connect HATS output left ear to UPE input channel 1

- connect HATS output right ear to UPT input channel 2

- connect decoder output (CRAWY, CWU or CBT) to UPZ input channel 3
- connect free field reference microphone to UPE input channel 4

- connect diffuse field reference microphone to UPZ input channel 5

- connect UPP-B3 output channel 10 to UPZ input channel 6

Ok

Fig. 128 Switcher support, analogue connection instructions.

or — if no switcher could be detected — how to establish the control
connection from UPV to UPZ:

Swvitcher UPZ =

Input Switcher UPZ not connected or switched off, Please check

- USE or Serial connection must be established between UPY and UPZ

- Powver cable rmust be connected to UPZ

- UPZ rmust be turned OM (rear panel)

- if using COM interface 'Used for' must be set to "Switcher' (Config Panel
- if using U3E interface 'USE Serial Port’ dewvice driver must be installed
'‘Cancel will continue without switcher; cabling must be dane manually!

Retry Cancel

Fig. 129 Switcher support, control connection instructions.

If the switcher cannot be enabled at this point, then “Cancel” will disable
switcher for the current measurement. The cabling has to be done
manually. The corresponding setting in configuration window will not be
changed. On next start of this measurement it will again be attempted to
use the switcher.

The measurement checks the connection to UPZ whenever the switcher
needs to be operated. If switcher control fails while measurement is running
(e.g. by unplugging the control or power cable), the operator will be
prompted to establish the analogue connections manually. This allows the
measurement to continue correctly.
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Switcher UPE (=]

Switcher not available; please establish UPY input connections manually:
- connect UPP-BE output channel 10 to UPY analog input channel 1
- connect HATS output right ear to UPY analog input channel 2

Ok

Fig. 130 Switcher support, error message if switcher failed during
measurement.

Prerequisites
¢ Reference Microphone Calibration
o Atrtificial Mouth Calibration
¢ Codec Calibration

¢ Noise Field Calibration

Measurement

Place the reference microphone close to the opening of the UE’s main
microphone.

Start the test case from the “Measurement” or “Standard” menu. The test
will start right away in the following processing order:

1. For each ambiance, measurement of uplink delay and checking if
established call still is alive

For each ambiance, recording the raw signals
For each ambiance, checking again if established call still is alive

Pre-processing all recordings for calculation

o M DN

Processing of the acquired signals with simultaneous display of the
results according to the progress, including the “PASS/FAIL”
criteria.

6. Deleting of temporary files.

A typical image showing the completion of steps 1-3 looks like following:
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Pub_Noise_V2
Qutside_Traffic_Road
Outside_Traffic_Crossroads
Train_Station
Fullsize_Car1_130Kmh
Cafeteria_Noise

Mensa

Total Verdict =

Fig. 131 Running “Speech Quality in Presence of Background Noise” — all
recordings are just done

Work_Noise_Office_Callcenter

Each recording resp. calculation can be repeated by clicking “Repeat
current sequence” in the status box:

B3

ﬂl Measuring ﬁ

speech with Pub_Noise W2

| Cancel J

Repeat current seguence |

Fig. 132 Busy message of “Speech Quality in Presence of Background
Noise” with Pause, Emergency Off, Cancel, Repeat

The “cancel” button cancels the complete measurement.

The “repeat ... sequence” button repeats the current step. This may be a
delay measurement, a recording of a specific noise ambiance or its
calculation.

The “crossed speaker” symbol button stops the playback of the noise and
test signal and aborts the current acquisition which can be repeated
thereafter.

The “pause” button symbol suspends execution and shows a message box
which will allow cancelling or continuing the measurement:

|

=)

Execution of sequence has been suspended.
Would you like to continue now? L

0K | Cancel

Fig. 133 Message after the measurement execution has been suspended
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When all recordings are done, the calculation process starts. For each
ambiance, the 3QUEST batch -calculator will be started with the
preprocessed recordings.

Results are S-MOS, N-MOS and G-MOS for each ambiance and overall
average. The coloured values are the averages over all sentences, and the
grey values are the standard deviations between the sentences.

Depending of the predefined PASS / FAIL criteria, the result values will be
coloured in green or red. The total verdict is “Fail” if the average of all S-
MOS-LQO is below 3.0 or the average of all N-MOS-LQO is below 2.5 or
the average of all G-MOS-LQO is below 2.5.

Continuing broken Measurements

When a measurement has been cancelled by “Cancel” for some reason
and the “Speech Quality in Presence of Ambient Noise” window has been
closed, there is a possibility of recovering the already existing recording
within 1 hour after abortion of the measurement.

When opening the measurement window again, the software will try to find
the raw data for each ambiance signal which has been recorded during the
last hour with exact the same settings like the current.

If raw data is found, the software will ask the user to reuse it for each
ambiance:

Home Tl Averoge Velues - - - -

Pub_Moise V2
Outside_Traffic_Road
O de_Traffic_C t

recent measurement

A recent measurement for ambiance Outside_Traffic_Crossroads was found.
Do you want to keep the raw data of it 7

Yes

Total Verdict =

Fig. 134 Recovering raw data from last “Speech Quality in Presence of
Background Noise” measurement

Cancel

sending delay

Typical Problems during measurement

In practice it can happen that a mobile under test drops the call after a few
minutes.

Since the recording of the signals takes a quite long time and often runs
without supervision, the software contains a security check if the call still is
alive:
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1. Before any recording will be started, the current signal delay and
signal level is detected. If the signal level is below a lower limit, the
measurement stops and allows a retry.

2. Atfter a recording is done the signal level is detected again. If the
level is below a lower limit, the measurement stops, too.

In both cases following message box appears:

Sending Delay 2]

v , sending delay measurement failed!

The measured signal level of 0.0002V
exceeds the minimum of 0.1V

- check the connection between CMU/CMW and UPV
- check if the call is set up.

Abort | Retry Ignore

Fig. 135 Common Problem 1: “Speech Quality in Presence of Background
Noise” detected lost call

“Retry” will repeat the current noise ambiance measurement (e.g. after
resetting the call), “Ignore” will skip this measurement and continue with the
next one (e.g. during a demo if the result does not matter), “Abort” will
cancel the measurement.

A second problem may occur when the recordings are all done and the
calculation process is started: The 3QUEST does not find its license. This
typically would look like this:

se_ V™

ffic_| ' HEAD acoustics®
L]

c_Cr

) nois Error x
HEAD 3

. % Mo license for HEAD 3QUEST-Batch found!
1_13| Version: )

_Noij [ o | m Measuring ﬁ

s5a

fice_ J QUEST Retrieving

Total Verdict

calculating MOS values

| Cancel |

Repesat current sequence |

Fig. 136 Common Problem 2: “Speech Quality in Presence of Background
Noise” running 3QUEST with missing License dongle

There may be two reasons for it:
1. The 3QUEST license dongle is missing on the UPV
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2. The UPV is being operated remotely with Microsoft Remote
Desktop while the dongle is plugged in.

In both cases the user may either press the “Cancel” button in the yellow
progress window or he may quit the 3QUEST license message.

Additional operations when finished

When the noise measurement is completely finished, there are some
extended features which may be reached through the soft key bar:

HATS Type 3.3 At Ear
- _ Verify Noise Verify Speach Repeat Enter Clear Temp ol - ~
Verify Delay | Field == l Measurement Comment Files Create Report Close

Fig. 137 The soft key tool bar of the “Speech Quality in Presence of
Background Noise” measurement

Verify Delay Takes a single delay measurement of the
current call
Verify Noise Field Checks the sound pressure level of each

ambiance according to the specification. For
this measurement, both artificial ears are
used.

Verify Speech Level Checks the sound pressure level of the
artificial mouth according to the specification.
For this measurement, the reference
microphone must be placed to the HATS
MRP.

Repeat Measurement | Repeats the complete measurement

Enter Comment Allows to enter an additional comment for the
report.
Clear Temp Files Normally, the intermediate files belonging to a

specific noise field calibration will not be
removed. This button allows to clear all
temporary files to get more space on the hard
disk.

The files will be recreated automatically during
next measurement — but this will take some
more time.

Create Report Allows direct creation of a report

Extended Speech Quality Measurements

In addition to the normative Speech Quality Measurements, R&S provides
some extra functionality which can be reached across the Menu. It is called
“Extended Speech Quality in Presence of Ambient Noise”

When the extended version of the background noise measurement is
started, it will be possible to measure only a subset of the given signals and
to repeat a single signal as well. This is done be using the additional check
boxes in the window. Only for checked ambiances the recordings and
calculations will be done.
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Norse Field Avernge Values - - - -

SMOS NMOS GMOS

Pub_Noise_V2
Outside_Traffic_Road
Outside_Traffic_Cn t
Clean (no noise)
Fullsize_Car1_130Kmh
Cafeteria_Noise
Mensa
Work_Noise_Office_Callcenter

Total Verdict =

Fig. 138 Running “Extended Speech Quality in Presence of Background
Noise” with only 3 ambiances: Recording is just done.

sending delay

In this example, the steps 1-3 of only three selected signals has just be
performed before the calculation starts.

Continuing broken Extended Measurements

In addition to the recovery functionality of already recorded raw signals, the
extended mode provides recovery of calculations already done, too:

SMOS NMOS GMOS

Pub_Noise_V2
Outside_Traffic_Road
Outside_Traffic_Crossmoads
Clean (no noise)
Fullsize_Car1_130Kmh
Cafetena_Noise

Mensa

Work_Noise_Office_Callcenter

Total Verdict =

Fig. 139 Restarting “Extended Speech Quality in Presence of Background
Noise” with only 3 ambiances: The first two ambiances have been
calculated, now recording of third ambiance is just done.

sending delay

This image shows a recovery situation after two ambiances have been
calcuated and a third one had been added. The calculation of the third one
has not been done yet. When reopening, the check marks of “Clean (no

noise)”, “Cafeteria”, “Mensa” and “Callcenter” had been set automatically
again but were removed by the user.
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When “Repeat Measurement” is clicked now, nothing will happen except
that the calculation of the missing ambient noise will be done. A typical final
result will show like this:

e it Avornge Vot PASS

SMOS NMOS GMOsS

Pub_Noise_V2
QOutside_Traffic_Road
Outside_Traffic_Crossmads
Clean (no noise)
Fullsize_Car1_130Kmh
Cafeteria_Noise

Mensa

Work_Noise_Office_Callcenter

Total Verdict =

Fig. 140 Completed “Extended Speech Quality in Presence of Background
Noise” measurement

sending delay

In a recovery situation, there also would be the ability for adding new noise
ambiances. The condition between each check mark and current display
decides what exactly will happen:

e If a check mark is set, the corresponding noise ambiance will be
recorded and calculated again no matter if already a raw data set
exists or not.

e If a check mark is cleared, the corresponding noise ambiance will
never be recorded again. If there is still a result, nothing will
happen. Otherwise, if there exists a raw data set, the calculation will
be performed.
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Notes on Hands-Free Measurements

General Remarks

The standards 3GPP2 C.S0056, 3GPP2 C.S0056-A, TIA-1042 and TIA-
1042-A do not define requirements and test specifications for the tests of
the acoustic behaviour of the mobile phone in this mode

As bonus, R&S UPV-K92 CDMA2000° Mobile Phone tests provide test
cases for handheld hands-free and desktop hands-free mode with narrow
band and wideband speech. The method and requirements are analogous
to those in 3GPP TS 26.132. Test specifications and limits for hands free
car kits are the same as for desk top hands-free terminals.

Hands-free tests with R&S UPV-K92 support the use of either artificial
mouth according to ITU-T P.51 together with a free field measurement
microphone or alternatively the use of a HATS with type 3.3 or 3.4 artificial
ear and artificial mouth according to ITU-T P.58.

Test Setup

All tests must be performed in an anechoic room. Background noise must
be less than 24 dBSPL(A). Furthermore the room should be big enough and
its walls should have sufficient absorption to provide nearly free-field
conditions at the hands-free reference point. Not all test boxes which are
appropriate for handset tests can be used for hands free measurements.

If a free-field microphone with a discrete P. 51 mouth is used, it should be
configured to the Handheld hands-free UE as per Figure 58 for receiving
measurements and Figure 59 for sending measurements. The
measurement instrument should be located at a distance dyr from the
centre of the visual display of the mobile station. The distance dyr is
specified by the manufacturer.

Normal vector
from front of phone

I |
Free-field measurement : [
microphone e <9

dm-‘

Fig. 141 Configuration of handheld hands-free UE, free-field microphone
for receiving measurements
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Lip i Normal vector
Ip ring from front of phone
position

Ci]]l‘

Fig. 142 Configuration of handheld hands-free UE and artificial mouth
according to ITU-T P.51 for sending measurements

If a HATS is used, the measurement can either be performed binaurally
(with two artificial ears and correction of the RLR by 6 dB) or monaural.

The selection of acoustic accessories used for the hands free tests can be
entered in menu item “Options - Hands free settings”.

Hands Free Settings

LRGP ITU-T P.51 and free field
microphone

HaTS [TU-T P.58 and type 3.3
artificial 2ar, manaral

HaTS [TU-T P.58 and type 3.3
artificial ear, binaural

H&TS [TU-T P.58 and tppe 3.4
artificial 2ar, manaral

H&TS [TU-T P.58 and tppe 3.4
artificial ear, binaural

Generic speaker and free field
rnicraphane

Cancel Ok /L
e

Fig. 143 Hands free settings

103 E-2



1402.0643.12

Acoustic Measurements on Mobile Phones

L (j] I L

HATS ] 1
Reference I Normal vector

Point ' from front of phone

Fig. 144 Configuration of handheld hands-free UE with HATS

For desk top hands-free it is referred to ITU-T P. 340 (http://www.itu.int) for
the use of free field microphone and discrete P.51 mouth. The hands free
terminal should be placed on a table of approximately 1 m? with the centre
of its front edge 400 mm perpendicularly from the centre of the front edge
of the table. The surface area should not be less than 0.96 m* and its width
should not be less than 0.8 m. The front centre of the measuring
microphone or centre of the lip ring, respectively, should be placed 300 mm
above the centre of the front edge of the table with the axis of the
microphone or artificial mouth inclined towards the centre of the front edge
of the hands-free terminal.

For the use of a HATS with both types of hands-free terminals it is referred
to ITU-T P.581. For handheld hands free the setup of ITU-T P.581
corresponding to “portable hands-free” should be used. For desk top
hands-free, the centre of the lip ring is positioned as described above, but
the axis of the artificial mouth should be horizontal.

Acoustic Calibration for Hands Free Tests

The calibration for the free field microphone or type 3.3 or type 3.4 HATS
ear, respectively, is done as described in chapter 4 above.

For binaural measurements, the second artificial ear has to be calibrated
accordingly, using the sub-item “Second Type 3.3 ear” or “Second type 3.4
ear”, respectively, in “Calibration - Artificial Ear’. Note that the second
artificial ear must be connected to Analyzer input 2 instead of the
R&S CMU200 connection.

According to 3GPP TS 26.132, free field equalization has to be taken into
account. Free field data can either be imported as an average table from
the standard or from an individual calibration disk, using the menu item
“Calibration - Free field equalization”.

The calibration of the artificial mouth for hands free tests comprises two
additional steps. After the level has been adjusted and the frequency
response has been equalized at the MRP, the reference microphone has to
be repositioned at the so-called Hands-Free Reference Point (HFRP or
HATSHFRP).
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For the mouth according to ITU-T P.51 the HFRP is in 50 cm distance from
the lip ring on the axis of the mouth. The calibration has to be performed at
this point independent of the measuring distance currently used.

The HATS HFRP is stipulated in ITU-T P.581. It is one of the points 11 to
17 defined in table 6a of ITU-T P.58. It should be on the axis which is
closest to the actual axis from the lip ring to the microphone under test. The
distance is always 50 cm from the lip ring. The axis may be azimuthally
centric (i.e. 0° horizontally) with an elevation (vertical) angle of 0°, +15° or
1+30°. Points 16 and 17 are located on an axis with 0° elevation and an
azimuth angle of 15° or 30°.

The level at this point is adjusted to -28.7 dBPa. For the last step, the
reference microphone is returned to the MRP, and the level and spectrum
at the MRP are measured as reference for the transfer function calculation.

The mouth calibration for hands-free tests is started with the menu item
“Calibration = Atrtificial Mouth (Hands Free)”. This procedure comprises the
mouth calibration for handset tests and has also effect on subsequent
handset tests with the same individual artificial mouth.
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Customizing Measurements

The first item in the “Measurement” menu which is called “Settings” opens a
sub-menu with all available measurements in it. Clicking on a measurement
in this sub-menu opens a window which allows to change parameters of the
selected measurement.

Parameters of Sending Handset with Speech "Normal™

Template Files
Mo File Mame

1 CDMA_Handset_Sending N Mandatory up

2 COMA_Handset_Sending N Mandatory lo

3 COMA_Handset_Sending N Desired uppe

4 COMA_Handset_Sending N Desired lower

Mo Name Type Default Vahe Fixed
- 1 test signal fle Shing Nomal True

2 wideband Boolean false False
3 SLR upper limit (dB) Double 15 False
4 check SLR upper imit Boolean true False
5 SLF lower bmit [dB) Double 6 False
& check SLR lower imit Boolean frue False

Mo File name
1 del_snd set

2 ea_snd set

MNumbes m ot I
Number [~ 1] Edit I I Locked Cancel |

Fig. 145 Measurement setup window

The “Title” appears in the measurement menu and forms the heading of the
report.

The “Description” can be chosen to be included into the report.
“Date” shows the date of the last change to this measurement definition.

“Operator instruction” is the text displayed before the start of each
measurement, provided that the item “Show operator instructions” is
activated in the “Options” menu.

The entry in the field “Program File” designates the measurement type and
must not be changed.

The field “Setup Files” specifies the R&S UPV setups used by the
measurement. The specified file can be replaced by a user defined file but
the number of setups is defined by the measurement type. The customized
setup file must be stored in folder D:\Hearing. It is recommended to
generate customized setups by copying existing ones. Note that changes in
the setup like changing the analysis function or generator signal may cause
malfunction of the measurement. Some parameters of the setup might be
overwritten by the macro during the measurement run.

The field “Template files” specifies limit template curves for the response
curve. The buttons “Add” or “Edit” produce the following input window:
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Template Curye
MHurnber I'I

bl andatory upper limit

bd andatory lower limit

Drezired upper limit

Desired lower lirmt

Center curve

Upper tolerance Lawer
dB tolerance dB

=

Far information only |

File name Browsze |

IED ke_Handzet_Sending_Marra

Cancel | k. !
2

Fig. 146 Input window for limit template curve

The radio buttons allow to determine whether the given curve should be
used as upper limit, lower limit or for information only (no limit check). The
field “File name” must contain the path name of the file. To generate a new
limit curve file, use the softkey “Save as limit curve” of the respective
measurement window or copy and edit an existing limit file using a text
editor.

All other available parameters of a measurement definition are shown in the
“Parameters” data grid. The rightmost column with the headline “Fixed”
displays whether the respective parameter can be changed by the operator
or not. In “generic’ measurements all parameters may be changed. In
measurements which follow standards, only parameters which are not
determined by the standard may be changed by the operator. The “Edit”
button opens an input window for the parameter in the line specified in
“Number”:
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Murnber I o

Mame

wideban:

Type

I Boaolzan j

Default Walue

Ifalse

[ Locked

Cancel | k. I
/

o

Fig. 147 Input window for parameter value

“Name” appears in the report and explains the meaning of the parameter.
“Type” is determined by the measurement routine and cannot be changed.
In the field “Value” a value must be entered which conforms with the syntax
rules of the selected data type. The syntax is checked automatically when
the text box is left. However there is no check for the allowable range of the
value. Entering inadequate values (e.g. too high levels, negative
frequencies) may cause malfunction of the measurement.

Parameters for the different Measurement Types

Sending Response

Table 7 Parameters for sending response measurements

Name Type Value | Explanation

test signal file String Normal | The file cannot be changed by the operator
wideband Boolean | false Do not change

SLR upper limit (dB) Double |19 Upper limit for SLR limit check

check SLR upper limit | Boolean | true Upper limit is checked if “true”

SLR lower limit (dB) Double |6 Lower limit for SLR limit check

check SLR lower limit | Boolean | true Lower limit is checked if “true”

Sending Response AMPS

Table 8 Parameters for sending response measurements in AMPS

Name Type Value | Explanation
test signal file String Normal | Cannot be changed by the operator
wideband Boolean | false Do not change
SLR upper limit (dB) Double |19 Upper limit for SLR limit check
SLR check upper Boolean | false Upper limit is checked if “true”
SLR lower limit (dB) Double |19 Lower limit for SLR limit check
SLR check lower Boolean | false Lower limit is checked if “true”
loudness contrast limit (dB) | Double |3 Limit for absolute SLR difference between
CDMA2000 and AMPS
check loudness contrast Boolean | true Limit is checked if “true”
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Sending Response with Speech “Single Talk”

Table 9 Parameters for sending response measurements with ST speech

Name Type Value Explanation

CDMA Boolean | True Defines 0 dBFS = 3.17 dBm0

signal file name String | ST_100-8000Hz_FS | The file cannot be changed by
the operator

analysis delay (s) Double |0 Start of the analysis after start of
the signal

analysis length (s) Double |35.4116 Length of the analysed portion
of the signal

selective Boolean | False Time-selective analysis of the
spectrum

handsfree Boolean | False Use devices configured in
handsfree settings

wideband Boolean | False Speech codec bandwidth

annex G weighting factors | Boolean | False False: Use Annex A of P.79
True: Use Annex G of P.79

SLR upper limit (dB) Double |11 Upper limit for SLR limit check

check SLR upper limit Boolean | True Upper limit is checked if “true”

SLR lower limit (dB) Double |5 Lower limit for SLR limit check

check SLR lower limit Boolean | True Lower limit is checked if “true”

Receiving Response

Table 10 Parameters for receiving response measurements

Name Type Value | Explanation

test signal file String | Normal | The file cannot be changed by the operator

DRP Boolean | false If “false”, the DRP-ERP correction is taken into
account

Wideband Boolean | false Selects wideband measurement (100 Hz to 7 kHz).

Not available in the current version.

RLR upper limit (dB) | Double |5

Upper limit for RLR limit check

RLR check upper

Boolean | true

Upper limit is checked if “true”

RLR lower limit (dB) | Double |-5

Lower limit for RLR limit check

RLR check lower

Receiving Response

Boolean | true

AMPS

Lower limit is checked if “true”

Table 11 Parameters for receiving response measurements in AMPS

Name Type Value | Explanation

test signal file String Normal | The file cannot be changed by the
operator

DRP Boolean | false If “false”, the DRP-ERP correction is taken
into account

wideband Boolean | false Do not change

RLR upper limit (dB) Double |5 Upper limit for RLR limit check

RLR check upper Boolean | false Upper limit is checked if “true”

RLR lower limit (dB) Double |-5 Lower limit for RLR limit check

RLR check lower Boolean | false Lower limit is checked if “true”

max. loudness contrast (dB) | Double |3 Limit for absolute RLR difference between
CDMA2000 and AMPS

check loudness contrast Boolean | true Limit is checked if “true”
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Receiving Response with Speech “Single Talk”

Table 12 Parameters for receiving response measurements with ST speech

Name Type Value Explanation

CDMA Boolean | True Defines 0 dBFS = 3.17 dBm0

signal file name String ST_100-8000Hz_FS | The file cannot be changed by the
operator

analysis delay (s) Double |0 Start of the analysis after start of the
signal

Analysis length (s) Double |35.4116 Length of the analysed portion of the
signal

selective Boolean | False Time-selective analysis of the
spectrum

handsfree Boolean | False Use devices configured in handsfree
settings

Binaural Boolean | False Binaural measurement for binaural
headsets

curve equalisation String DF Equalisation applied to frequency
response

loudness rating String ERP Equalisation applied to loudness

equalisation rating calculation

wideband Boolean | True Speech codec bandwidth

annex G weighting Boolean | False False: Use Annex A of P.79
True: Use Annex G of P.79

RLR upper limit Double |5 Upper limit for SLR limit check

check RLR upper limit | Boolean | True Upper limit is checked if “true”

RLR lower limit Double |-1 Lower limit for SLR limit check

check RLR lower limit | Boolean | True Lower limit is checked if “true”

Loudness Rating Contrast Calculation

Table 13 Parameters loudness rating contrast calculation

Name Type Value Explanation
compared value count | Parameter |2 Must be the same in all
count instances
measurement testcase | String Sending Handset WB with | Exact name of first WB
title (1) Speech "Single Talk" testcase
measurement testcase | String Receiving Handset WB with | Exact name of second
title (2) Speech "Single Talk" WB testcase
compared value count | Parameter |2
count
measurement value String Sending Loudness Rating Exact name of first WB
name (1) value
measurement value String RLR Exact name of second
name (2) WB value
compared value count | Parameter |2
count
reference testcase title | String Sending Handset NB with Exact name of first NB
(1) Speech "Single Talk" testcase
reference testcase title | String Receiving Handset NB with | Exact name of second
(2) Speech "Single Talk" NB testcase
compared value count | Parameter |2
count
reference value name | String Sending Loudness Rating Exact name of first NB
(1) value
reference value name | String RLR Exact name of second
(2) NB value
compared value count | Parameter |2
count
contrast value name String Contrast Sending Name of the first result
(1) in the report
contrast value name String Contrast Receiving Name of the second
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Name Type Value Explanation
(1) result in the report
compared value count | Parameter |2
count
upper limit (1) [dB] Double 3 Upper limit for first
result
upper limit (2) [dB] Double 3 Upper limit for second
result
compared value count | Parameter |2
count
check upper limit (1) Boolean True Upper limit is checked
on first result if “true”
check upper limit (2) Boolean True Upper limit is checked
on second result if “true”
compared value count | Parameter |2
count
lower limit (1) [dB] Double -3 Lower limit for first
result
lower limit (2) [dB] Double -3 Lower limit for second
result
compared value count | Parameter |2
count
check lower limit (1) Boolean True Lower limit is checked
on first result if “true”
check lower limit (2) Boolean True Lower limit is checked
on second result if “true”
maximum value age Double 0.5 Found values are only
(hours) used if they are younger
than specified here
store additional Boolean True Retrieved values are
information as stored as comment
comment

Terminal Coupling Loss

Table 14 Parameters for TCL measurements

Name

Type Value Explanation

signal file name

String Echoloss

The file cannot be changed by the operator

rms value (dBFS)

Double |-12.5

the operator

Rms value of the signal file, cannot be changed by

wideband

Boolean | false

Selects wideband measurement (100 Hz to 7
kHz). Not available in the current version.

TCL upper limit (dB) | Double |0 Upper limit for TCL limit check
check upper limit Boolean | false Upper limit is checked if “true”
TCL lower limit (dB) | Double |45 Lower limit for TCL limit check

check lower limit

Boolean | true

Lower limit is checked if “true”

Terminal Coupling Loss with Compressed Speech “Single Talk”

Table 15 Parameters for TCL with compressed ST speech

Name Type Value Explanation

CDMA Boolean | True Defines 0 dBFS = 3.17 dBm0

Wideband Boolean | False Speech codec bandwidth

Handsfree Boolean | False Use devices configured in
handsfree settings

Signal File String ST_compressed_NB | The file cannot be changed by
the operator

act. level to peak ratio String -17.873 Property of the test signal file

[dB]

signal level (dBmO) Double -10 Level of the test signal at the
encoder input
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Name Type Value Explanation

pre-delay (s) Double 17 Start of the analysis after start of
the signal

analysis length (s) Double 18 Length of the analysed portion
of the signal

selective Boolean | False Time-selective analysis of the
spectrum

max. age of delay values | Double 0.5 Not used

[hrs]

TCL upper limit (dB) Double 80 Upper limit for TCL limit check

check TCL upper limit Boolean | False Upper limit is checked if “true”

TCL lower limit (dB) Double 45 Lower limit for TCL limit check

check TCL lower limit Boolean | True Lower limit is checked if “true”

show noise curve Boolean | True Show spectrum of second
measurement without test signal

Peak Acoustic Level

Table 16 Parameters for peak acoustic level measurements

Name Type Value Explanation

test signal file name String PeakLevel | File name (without extension) of the .wav
file used for the test

measurement interval (s) | Double |10 Length of the measurement

DRP Boolean | false If “false”, the DRP-ERP correction is taken
into account

upper limit (dBPa) String | 42 Upper limit for sound pressure level in
dBPa

check upper limit Boolean | true Upper limit is checked if “true”

Sending Noise

Table 17 Parameters for sending noise measurements

Name Type Value | Explanation

average count Byte 10 Number of averaged measurements

upper limit [dBmO(P)] | Double |-64 Upper limit noise level limit check

check upper limit Boolean | true Upper limit is checked if “true”

lower limit [dBmO(P)] | Double |-100 Lower limit for noise level limit check

check lower limit Boolean | false Lower limit is checked if “true”

weighted spectrum Boolean | true If “true”, the displayed spectrum is weighted, if

“false”, the spectrum is unweighted

store spectrum Boolean | true

Sending Noise with Activat

ion Signal

If “true”, the spectrum is stored for reporting

Table 18 Parameters for sending noise test with activation signal

Name Type Value Explanation

weighting filter String | CCIT Can be CCITT or AWE

handsfree measurement | Boolean | False Use devices configured in handsfree
settings

lower frequency (Hz) Double | 300 Lower end of analysis frequency range

upper frequency (Hz) Double | 3400 Upper end of analysis frequency range

use activation signal Boolean | True Switch activation signal on/off

activation signal String | CSS_Act_48kHz | If no signal is specified, the activation
signal specified in the “Options” menu
is used

activation signal level Double |-4.7 Level of the activation signal at MRP

(dBPa)
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Name Type Value Explanation

adapt activation signal Boolean | False Allow to reduce the level of the

level activation signal if it exceeds the
generator range

measurement delay (ms) | Double | 100 Start of the analysis after start of the
signal

average count Byte 5 Number of measurements to be
averaged

show all spectra Boolean | True Show spectra of all measurements on
the screen

store all spectra Boolean | False Show spectra of all measurements in
the report

maximum spectral Integer | 1024 Maximum number of frequency points

resolution in the spectrum curves (has no
influence on the FFT size!)

total noise upper limit Double |-64 Upper limit for total noise rms

(dBm0)

check total upper limit Boolean | True Upper limit is checked if “true”

lower limit for total noise | Double |-90 Lower limit can be applied to exclude

(dBm0) dropped call

check total lower limit Boolean | False Lower limit is checked if “true”

upper limit for spectrum | Double |-74 Upper limit for single frequency

(dBm0) disturbances

check spectral upper Boolean | False Check upper limit for single frequency

limit disturbances

lower limit for spectrum | Double |-100 Lower limit can be applied to exclude

(dBPa) dropped call

check spectral lower limit | Boolean | False Lower limit is checked if “true”

Receiving Noise

Table 19 Parameters for receiving noise measurements

Name Type Value | Explanation

DRP Boolean | false | If “false”, the DRP-ERP correction is taken into
account

average count Byte 10 Number of averaged measurements

upper limit Double |-57 Upper limit for noise level limit check

[dBPa(A)]

check upper limit Boolean | true Upper limit is checked if “true”

lower limit [dBPa(A)] | Double |-100 | Lower limit for noise level limit check

check lower limit Boolean | false | Lower limit is checked if “true”

A weighted Boolean | true If “true”, the displayed spectrum is weighted, if

spectrum “false”, the spectrum is unweighted

store spectrum Boolean | true If “true”, the spectrum is stored for reporting

CDMA Boolean | true Adapts the timing of the test for the CDMA2000
codecs

Receiving Noise with Activation Signal

Table 20 Parameters for receiving noise test with activation signal

Name Type Value Explanation

ear equalisation String | DF Equalization of the artificial ear (DRP,
ERP, DF or FF)

weighting filter String | AWE Can be CCITT or AWE

handsfree measurement | Boolean | False Use devices configured in handsfree
settings

lower frequency (Hz) Double | 100 Lower end of analysis frequency range

upper frequency (Hz) Double | 10000 Upper end of analysis frequency range

use activation signal Boolean | True Switch activation signal on/off
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Name Type Value

Explanation

activation signal String

CSS_Act_48kHz

If no signal is specified, the activation
signal specified in the “Options” menu
is used

activation signal level Double |-16 Level of the activation signal at the

(dBm0) encoder input

measurement delay (ms) | Double | 100 Start of the analysis after start of the
signal

average count Byte 5 Number of measurements to be
averaged

show all spectra

Boolean | True

Show spectra of all measurements on
the screen

store all spectra

Boolean | False

Show spectra of all measurements in
the report

maximum spectral
resolution

Integer | 1024

Maximum number of frequency points
in the spectrum curves (has no
influence on the FFT size!)

binaural measurement

Boolean | False

Binaural measurement for binaural
headsets

total noise upper limit Double |-57

(dBPa)

Upper limit for total noise rms

check total upper limit

Boolean | True

Upper limit is checked if “true”

lower limit for total noise | Double |-70

(dBPa)

Lower limit can be applied to exclude
dropped call

check total lower limit

Boolean | True

Lower limit is checked if “true”

upper limit for spectrum | Double |-60

Upper limit for single frequency

(dBPa) disturbances
check spectral upper Boolean | False Check upper limit for single frequency
limit disturbances

lower limit for spectrum | Double | -100

(dBPa)

Lower limit can be applied to exclude
dropped call

check spectral lower limit | Boolean | False

Sending Distortion

Lower limit is checked if “true”

Table 21 Parameters for sending distortion measurements

Name Type Value | Explanation

wideband Boolean false Selects wideband measurement (100
Hz to 7 kHz). Not available in the
current version.

average count Byte 10 Number of averaged measurements

number of levels Parameter | 10 Number of test levels, equals number

count of level parameters given below

level 1 (dB relative to ARL) Double -35

level 2 (dB relative to ARL) Double -30

level 3 (dB relative to ARL) Double -25

level 4 (dB relative to ARL) Double -20

level 5 (dB relative to ARL) Double -15

level 6 (dB relative to ARL) Double -10

level 7 (dB relative to ARL) Double -5

level 8 (dB relative to ARL) Double 0

level 9 (dB relative to ARL) Double 5

level 10 (dB relative to ARL) | Double 10

CDMA Boolean true Adapts the timing of the test for the
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Sending Distortion with Activation Signal

Table 22 Parameters for sending distortion test with activation signal

1402.0643.12

Name Type Value Explanation
weighting String CCITT Can be CCITT or AWE
handsfree Boolean False Use devices configured in
handsfree settings
lower frequency Double 200 Lower end of analysis frequency
boundary (Hz) range
upper frequency Double 4000 Upper end of analysis frequency
boundary (Hz) range
test tone duration (ms) Double 360 Duration of the sine tone
settling time (ms) Double 50 Start of the analysis after start of
the test tone
average count Byte 5 Number of measurements to be
averaged
use activation signal Boolean True Switch activation signal on/off
activation signal String CSS_Act_48kHz | If no signal is specified, the
activation signal specified in the
“Options” menu is used
adapt activation signal to | Boolean True Allow to reduce the level of the
range activation signal if it exceeds the
generator range
sweep 1 frequency (Hz) | Double 1020 Test tone frequency for level
sweep
number of levels Parameter |6
count
level 1 (dBPa) Parameter |5
count
level 2 (dBPa) Double 0
level 3 (dBPa) Double -4.7
level 4 (dBPa) Double -10
level 5 (dBPa) Double -15
level 6 (dBPa) Double -20
number of activation Parameter |6 Must be equal to number of levels
levels count
activation level 1 (dBPa) | Double 5
activation level 2 (dBPa) | Double 0
activation level 3 (dBPa) | Double -4.7
activation level 4 (dBPa) | Double -10
activation level 5 (dBPa) | Double -15
activation level 6 (dBPa) | Double -20
sweep 2 level (dBPa) Double -4.7 Test tone level for frequency
sweep
sweep 2 activation level | Double -4.7 Activation level for frequency
(dBPa) sweep
number of frequencies Parameter |0
count
show spectrum Boolean True Show spectrum on the screen
memorize spectrum Boolean True Store spectrum until the
measurement is closed, to be
viewed after completion of the test
maximum resolution Integer 400 Maximum number of frequency
points in the spectrum curves (has
no influence on the FFT size!)
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Receiving Distortion

Table 23 Available parameters for receiving distortion measurements

Name

Type

Value

Explanation

DRP

Boolean false

average count

Byte 5

Number of averaged measurements

number of levels

Parameter | 10

Number of test levels, equals humber of level

count parameters given below

level 1 (dBm0) Double -45

level 2 (dBm0) Double -40

level 3 (dBm0) Double -35

level 4 (dBm0) Double -30

level 5 (dBm0) Double -25

level 6 (dBm0) Double -20

level 7 (dBm0) Double -15

level 8 (dBm0) Double -10

level 9 (dBm0) Double -5

level 10 (dBmO) Double 0

upper SPL limit (dBPa) | Double 10 Highest SPL for which the distortion is

displayed and checked in the first test run.
Pushing “Add measurement” causes all levels
to be measured and displayed

CDMA

Receiving Distortion with Activation Signal

Boolean true

Adapts the timing of the test for the
CDMA2000 codecs

Table 24 Parameters for receiving distortion test with activation signal

Name Type Value Explanation

equalization String DF Equalization of the artificial ear
(DRP, ERP, DF or FF)

weighting String CCITT Can be CCITT or AWE

handsfree Boolean False Use devices configured in
handsfree settings

lower frequency Double 100 Lower end of analysis frequency

boundary (Hz) range

upper frequency Double 6000 Upper end of analysis frequency

boundary (Hz) range

test tone duration (ms) | Double 360 Duration of the sine tone

settling time (ms) Double 50 Start of the analysis after start of
the test tone

highest tested level Double 10 Result is not checked if the

(dBPa) measured level exceeds this value

average count Byte 5 Number of measurements to be
averaged

use activation signal Boolean | True Switch activation signal on/off

activation signal String CSS_Act_48kHz | If no signal is specified, the
activation signal specified in the
“Options” menu is used

adapt activation signal to | Boolean True Allow to reduce the level of the

range activation signal if it exceeds the
generator range

sweep 1 frequency (Hz) | Double 1020 Test tone frequency for level
sweep

number of test tone Parameter | 8

levels count

test tone level 1 (dBm0) | Double 0

test tone level 2 (dBm0) | Double -3
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Name Type Value Explanation
test tone level 3 (dBm0) | Double -10
test tone level 4 (dBm0) | Double -16
test tone level 5 (dBm0) | Double -20
test tone level 6 (dBm0) | Double -30
test tone level 7 (dBm0) | Double -40
test tone level 8 (dBm0) | Double -45

number of activation
levels count

Parameter | 8

Must be equal to number of levels

activation level 1 (dBm0) | Double 0

activation level 2 (dBm0) | Double -3

activation level 3 (dBm0) | Double -10

activation level 4 (dBm0) | Double -16

activation level 5 (dBm0) | Double -20

activation level 6 (dBm0) | Double -30

activation level 7 (dBm0) | Double -40

activation level 8 (dBm0) | Double -45

sweep 2 test tone level Double -16 Test tone level for frequency
(dBm0) sweep

sweep 2 activation level | Double -16 Activation level for frequency
(dBm0) sweep

number of frequencies

Parameter | 5

count

frequency 1 (Hz) Double 315

frequency 2 (Hz) Double 408

frequency 3 (Hz) Double 510

frequency 4 (Hz) Double 816

frequency 5 (Hz) Double 1020 Show spectrum on the screen

show spectrum Boolean | True Store spectrum until the
measurement is closed, to be
viewed after completion of the test

memorize spectrum Boolean True Maximum number of frequency

Sidetone Masking Rating

points in the spectrum curves (has
no influence on the FFT size!)

Table 25 Available parameters for STMR measurements

Name Type Value | Explanation

DRP Boolean | false | If “false”, the DRP-ERP correction is taken into
account

wideband Boolean | false | Selects wideband measurement (100 Hz to 7
kHz). Not available in the current version.

STMR upper limit (dB) Double |23 Upper limit for STMR limit check

check STMR upper limit | Boolean | true Upper limit is checked if “true”

STMR lower limit (dB) Double |13 Lower limit for STMR limit check

check STMR lower limit | Boolean | true Lower limit is checked if “true”

CDMA Boolean | true Adapts the timing of the test for the CDMA2000

codecs

Sidetone Masking Rating with Speech “Single Talk”

Table 26 Parameters for STMR measurements with ST speech

Name ‘ Type | Value

| Explanation

signal file name
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Name Type Value Explanation

analysis delay (s) Double |0 Start of the analysis after start of the
signal

analysis length (s) Double |35.4116 Length of the analysed portion of the
signal

selective Boolean | False Time-selective analysis of the
spectrum

curve equalisation String ERP Equalisation applied to frequency
response

STMR equalisation String ERP Equalisation applied to STMR
calculation

wideband Boolean | True Binaural measurement for binaural
headsets

unsealed Boolean | True False: Apply leakage correction

LRGP method Boolean | False Enforce use of type 1 or type 3.2 ear

HATS method Boolean | False Enforce use of type 3.3 or type 3.4
ear

Autoselect Boolean | False False: Use Annex A of P.79
True: Use Annex G of P.79

binaural Boolean | False Binaural measurement for binaural
headsets

STMR upper limit (dB) | Double |23 Upper limit for STMR limit check

check upper limit Boolean | True Upper limit is checked if “true”

STMR lower limit (dB) | Double |15 Lower limit for STMR limit check

check lower limit Boolean | True Lower limit is checked if “true”

Sidetone Delay with Cross-Correlation

Table 27 Parameters for sidetone delay tests with cross-correlation

Name Type Value Explanation

test signal String CSS_48kHz | The file cannot be changed by the operator
signal level [dBPa] Double |-4.7 SPL at MRP

initial delay [ms] Double |49 Start of the analysis after start of the signal
correlation length Integer | 2048 Length of cross-correlation result

[samples]

analysis length [ms] Double | 200 Length of cross-correlated signals

upper limit [ms] Double |5 Upper limit for sidetone delay limit check
check limit Boolean | True Upper limit is checked if “true”

binaural measurement | Boolean | False Binaural measurement for binaural headsets

Stability Margin
Table 28 Available parameters for stability margin tests

Name Type ‘ Value ’ Explanation

loop gain (dB) Double 6 Specifies the gain applied
between decoder output and
encoder input for the stability

test
Stability Loss
Table 29 Parameters for stability loss test
Name Type Value Explanation
wideband Boolean | True Bandwidth of the speech codec
handsfree measurement | Boolean | False Use devices configured in
handsfree settings
play training sequence Boolean | True Switches training signal on/off
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Name Type Value Explanation

signal name String StabLossWB.arb | The file cannot be changed by the
operator

act. level to peak ratio Double 4.927 Property of the test signal file

[dB]

signal level [dBmOQ] Double -3 Level of the test signal at the
encoder input

pre-delay [ms] Double 85 Start of the analysis after start of
the signal

lowest measured Double 100 Lower end of analysis frequency

frequency [Hz] range

highest measured Double 8000 Upper end of analysis frequency

frequency [Hz] range

max. age of delay values | Double 0.5 Not used

[hrs]

maximum spectral Integer 256 Maximum number of frequency

resolution points in the spectrum curves (has
no influence on the FFT size!)

stability loss lower limit | Double 6 Lower limit for stability loss limit

[dB] check

check stability loss lower | Boolean | True Lower limit is checked if “true”

limit

stability loss upper limit | Double 100 Upper limit for stability loss limit

[dB] check

check stability loss upper | Boolean | False Upper limit is checked if “true”

limit

show noise curve Boolean | True Show spectrum of second
measurement without test signal

training signal name String ST_100- The file cannot be changed by the

8000Hz_FS operator

act. level to peak ratio Double 19.331 Property of the training signal file

[dB]

training signal level Double -16 Encoder input level

[dBmO]

CDMA Boolean | True Defines 0 dBFS = 3.17 dBmO

Delay Measurement with Cross-Correlation

Table 30 Parameters for the delay measurement with cross-correlation

Name Type Value | Explanation

test signal String | five The file cannot be changed by the operator

signal level 1 (dBPa) Double |-4.7 SPL at MRP

signal level 2 (dBm0) Double |-16 Encoder input level

initial delay (ms) Double |0 Start of the analysis after start of the signal

correlation length Integer | 32768 | Number of samples submitted to cross-

(samples) correlation

analysis length (ms) Double | 1800 Length of cross-correlation result

undersample factor Integer |4 Undersampling before cross-correlation

ingore initial peaks (ms) | Double |0 Suppression of sidetone for loopback on
network side

minimum S/N factor Double |1.2 Ratio between highest and second-highest
cross-correlation peak

path String | Nloop | Signal path (one of Mloop, Nloop, Rcv, Snd,
Snd+Rcv)

CDMA Boolean | True Defines 0 dBFS = 3.17 dBm0

hands free Boolean | False Use devices configured in handsfree settings

binaural measurement Boolean | False For binaural headsets

store curves Boolean | True Show cross-correlation curves in the report

subtract roundtrip delay | Double |0 Delay contribution of system simulator

(ms)

unused Double |0
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Name Type Value | Explanation

snd delay upper limit Double |60

(ms)

check snd delay upper Boolean | False

limit

snd delay objective (ms) | Double |50

check snd delay Boolean | False

objective

rcv delay upper limit Double |70

(ms)

check rcv delay upper Boolean | False

limit

rcv delay objective (ms) | Double |55

check rcv delay objective | Boolean | False

roundtrip delay upper Double |220 Upper limit for calculated roundtrip delay
limit (ms)

check roundtrip delay Boolean | True Upper limit is checked if True

upper limit

roundtrip delay objective | Double | 185 Objective upper limit for roundtrip delay, does
(ms) not contribute to total verdict

check roundtrip delay Boolean | True Objective upper limit is checked if True
objective

interaural diff. upper Double |5

limit (ms)

check interaural diff. Boolean | False

upper limit

interaural diff. objective | Double |2

(ms)

check interaural diff. Boolean | False

objective

Echo Control Characteristics

Table 31 Parameters for echo control characteristics test

Name Type Value Explanation

handsfree Boolean False Use devices configured in
handsfree settings

CDMA Boolean True Defines 0 dBFS = 3.17 dBm0

max. delay age (h) Double 0 Not used

crosscorrelation length Integer 8192 Length of cross-correlation

(samples) result

crosscorr. analysis length Integer 16384 Number of cross-correlated

(samples) samples

near-end signal String EchoControl_Nearend The file cannot be changed
by the operator

near-end level (dBPa) Double -4.7 SPL at MRP

far-end signal String EchoControl_Farend_WB The file cannot be changed
by the operator

far-end level (dBm0) Double -16 Encoder input level

conditioning time (s) Double 23.5 Start of the analysis after
start of the signal

analysis time 1 (s) Double 20 Length of continuous double-
talk section

analysis time 2 (s) Double 15 Length of single near-end
words section

cat. lower limits for String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 1 dt (%) F, G H

check cat. lower lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

analysis 1 dt F, G H

cat. upper limits for String 100,100,100,100,100,100,100,100 For categories A, B, C, D, E,

analysis 1 dt (%)

F,GH

check cat. upper lim. for String
analysis 1 dt

False,False,False, False,False,False, False, False

For categories A, B, C, D, E,
F,GH

level lower limits for Double

analysis 1 dt (dB)

0,0,0,0,0,0,0,0

For categories A, B, C, D, E,
F,GH

check level lower lim. for String
anal. 1 dt

False,False,False, False,False,False, False, False

For categories A, B, C, D, E,
F,GH

level upper limits for Double

analysis 1 dt (dB)
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0,0,0,0,0,0,0,0
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Name Type Value Explanation

check level upper lim. for | String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 1 dt F,G H

cat. lower limits for Double 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 1 st (%) F,G H

check cat. lower lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

analysis 1 st F,G H

cat. upper limits for String 100,100,100,100,100,100,100,100 For categories A, B, C, D, E,

analysis 1 st (%) F,G H

check cat. upper lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 1 st F,G H

level lower limits for Double 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 1 st (dB) F,G H

check level lower lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 1 st F, G H

level upper limits for Double 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 1 st (dB) F,G H

check level upper lim. for | String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 1 st F, G H

cat. lower limits for String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 2 dt (%) F, G H

check cat. lower lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

analysis 1 dt F, G H

cat. upper limits for String 100,100,100,100,100,100,100,100 For categories A, B, C, D, E,

analysis 2 dt (%) F, G H

check cat. upper lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

analysis 2 dt F,G H

level lower limits for String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 2 dt (dB) F,G H

check level lower lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 2 dt F, G H

level upper limits for String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 2 dt (dB) F,G H

check level upper lim. for | String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 2 dt F,G H

cat. lower limits for String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 2 st (%) F,G H

check cat. lower lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

analysis 2 st F,G H

cat. upper limits for String 100,100,100,100,100,100,100,100 For categories A, B, C, D, E,

analysis 2 st (%) F,G H

check cat. upper lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 2 st F,G H

level lower limits for String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 2 st (dB) F, G H

check level lower lim. for String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 2 st F,G H

level upper limits for String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E,

analysis 2 st (dB) F,G H

check level upper lim. for | String False,False,False, False,False,False, False,False | For categories A, B, C, D, E,

anal. 2 st F,G H

handsfree Boolean False For categories A, B, C, D, E,
F, G H

7 Measurements with electric connections

Introduction

Usually the mobile under test is connected via RF connection to the
R&S CMU200 and via acoustic interfaces (artificial mouth and ear) to the
R&S UPV. Therefore no intrusion in the mobile device is required.

There may, however, be cases during the design process of a mobile
phone where the usual interfaces are not available:

- if a mechanic mockup is to be measured just with the acoustic
components but without the rest of the circuitry

- if a circuit of a mobile phone is to be measured without acoustic
components

- if a hands free kit or headset is to be measured without mobile phone

- if the hands free or headset connection of a mobile phone is to be
measured without hands free kit or headset, respectively.
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In these cases either coder and decoder or artificial ear and artificial mouth
may be replaced by direct electrical connections to the R&S UPV. To use
electric connections, select “Electric connection” in the respective item of
the “Options” menu.

Calibration values for electric connections

Electrical connections cannot be calibrated. Instead a virtual sensitivity has
to be entered for each type of electrical connection under “Calibration >
Electric connections > ...".

Electric connection replacing artificial ear

R&S UPV Analyzer input 1 is directly connected to the earpiece amplifier
output.

A nominal sensitivity of the receiver (earpiece speaker) for which the circuit
is intended has to be entered in dB re 1 Pa/V.

Electric connection replacing artificial mouth

R&S UPV generator output 1 is directly connected to the microphone input
of the mobile phone circuit.

A nominal sensitivity of the microphone for which the circuit is intended has
to be entered in dB re 1 V/Pa.

Electric connection replacing encoder

R&S UPV generator output 2 is directly connected to a earpiece or headset
speaker or to the speech input of a hands free Kkit.

A nominal full scale output voltage (output voltage corresponding to digital
full scale) of the circuit intended to drive the speaker or car kit has to be
entered.

Electric connection replacing decoder

R&S UPV analyzer input 2 is directly connected to a microphone or to the
speech output of a hands free Kkit.

A nominal full scale input voltage (input voltage corresponding to digital full
scale) of the respective microphone or speech input has to be entered.

Performing the measurements

After applying the settings in the “Options” menu and after entering
appropriate calibration values for the electric connections in use, the
measurements may be started as usual.

Some parts of the standard require the use of particular artificial ears for
particular measurements. Therefore the checkbox “Allow only selected
measurements” should be unchecked in “Options - Standard”.

For sending tests, the output voltage range in the R&S UPV is set to a large
value in order to be able to drive the speaker of the artificial mouth. In rare
cases sending distortion and/or sending noise results may be degraded
with electric connections if a low microphone sensitivity is entered. In this
case please contact R&S support.
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8 Automatic Test Sequences

@)Telephune Tests

File Data Calibration MeasurementlSequence Report  Options  Help
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Fig. 148 Sequence menu

Creating and Editing a Sequence

The menu item “Sequence - New” first produces a window where a name
for the new sequence has to be entered. Subsequently the sequence
window opens.

@UFU K9y cdmaZ000{R) Mobile Phone Tests {D:\Phone’\Results.xml)
File D[ata Calbration Measurement Sequence Report Options Help
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Edit and Append > ¥ COMA Receiving Handsel, nom Vol

AMPS Receiving Handsed. nom. Vol @ D
(AMPS Receiving Handset with speech "Normal”
(AMPS Sending Handset

(AMPS Sending Handset with speech “Normal bl COMA Distortion Recening
COMA Weighted Tesminal Couplng Loss Delete X | i COMA Sidetone Masking Rating
CDMA Distortion Receiving
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COMA Sending Handset FRun highlighted
COMA |dle channel noize sending

COMA Stabdity margn
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Distortion Recenving

Receiving Handset with speech "Normal” Uncheck. al

Idle channel nowse receiving
Distortion Sending [VS)

Sending Handset with Speech "Nomal"

Idle channel noise sending Save sequence as |

Stabdity margin

Sidetone Masking Rating with Modulated Multisine
o |

! [ 2
Na Standard [Type 32 Low Leak At Ear [CMU / CRTU | Sample test abject 1
| Slatmamsl (ot | | M : | Sy Save sequence | Save and close

Fig. 149 Sequence window

Initially the right checked list box is empty. The list box on the left side
displays all available measurement definitions. A measurement is
appended to the sequence by highlighting it in the list box on the left side
and clicking the “Append” button. Subsequently a measurement, which is
highlighted in the checked list box on the right side, can be moved within
the sequence using the buttons “Move up” and “Move down” and deleted
from the sequence with the “Delete X” button. For non-standard
measurements which allow to change parameters like limit curves, it is
possible to edit the parameters before appending the measurement to the
sequence. This is done by clicking the button “Edit and append”. It is for
example possible to assemble a test sequence which contains stability
margin tests with different loop gains.
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A sequence should be run with option “Show operator instructions”
disabled. This avoids interruption of the execution. If a message to the
operator is to be inserted into the sequence on purpose, e.g. “Set user
volume control to maximum!”, the items provided in the tree view under
“Messages and Control” may be used. Such a message will stop the
execution of the sequence until it is closed by acknowledgement of the
operator.

Remote Control of R&S CMU200 within a Sequence

It is possible to remote control radiocommunication tester R&S CMU200
from the R&S UPV within an automatic test sequence, for example to wait
for a mobile to register, or for originating a call to the mobile. First the
connection interface to the R&S CMU200 has to be set up using menu item
“Options > CMU remote control”. To insert a control instance into a
sequence, choose one of the examples offered in branch “Messages and
Control” of the tree view and edit it if necessary. For details on the remote
control of the R&S CMU200 see the respective operation manuals.

Each control instance consists of a block of an arbitrary number of remote
commands followed by a status query. The query command (e.g.
“SIGN:STAT?”) and the response to wait for (e.g. “SYNC” or “CEST”) can
be specified as well as a timeout for the case that the desired response is
not received. As the R&S CMU200 is organized into subsystems for the
different mobile phone systems, the subsystem has to be specified as a
parameter. Parameter “Auto” causes the control instance to use the
subsystem set with menu item “Options - CMU Subsystem”. Note that the
remote commands are not always compatible between different mobile
phone systems.

In addition, a message to the operator like “Please switch on the mobile!”
can be entered in the “Operator Instruction” field of the parameter window.
Parameter 1 allows to choose whether the message is shown before or
after the block of commands is sent to the R&S CMU200.

When the R&S CMU200 control instance is executed within a sequence, a
window opens, showing the progress of the control action.

Note: By default, the R&S CMUZ200 changes its state when switching
from local control to remote control or vice versa. As a
consequence, synchronicity / registration or an established call
would be lost during the transition. Therefore the command
“SYSTem:GTRMode:COMPatible OFF” has to be issued before
the first real remote control instance. Insert “CMU run this first!”
in your sequence before any other remote CMU remote control.
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Fig. 150 CMU remote control window

“Action” shows the current remote control action. “Target state” shows the
desired query response. “CMU Response” shows the actual response of
the R&S CMU200 to the query. Error information returned from the
R&S CMU200 after the last command / query is displayed in the “Error”
field. The “Communication” box lists all commands and responses issued
during the control process. During the status query, the box “Time left’
shows the time left until the timeout expires.

Opening an Existing Sequence

The menu item “Sequence - Open ...” opens a file selector for specifying
the sequence to be loaded. The sequence window opens with the specified
sequence loaded. The sequence can then be edited and/or run.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked measurements
in the right list box are executed in sequence. The state of the checkboxes
may be altered by marking a measurement and then clicking on the
checkbox.

A running sequence may be interrupted with one of the buttons in the
measurement control window which is visible while a measurement is
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running. “Cancel and continue sequence” cancels the currently running
measurement and resumes execution of the sequence with the next
measurement. “Cancel and stop sequence” aborts both running
measurement and sequence. “Stop sequence after this measurement”
completes the running measurement and stops the sequence afterwards.

&

Measuring
Distortion at -45 dBmd

Cancel and continue zequence

Cancel and stop sequence

Stap zequence after thiz
measurement

Fig. 151 Measurement control window

Running a single measurement out of a sequence

If a measurement is highlighted in the right checked list box it can be run
like a single measurement using the button “Run highlighted”, irrespective
of whether it is checked or not. The measurement runs as if it would have
been started from the “Measurement” menu in the main window. That is,
the measurement window stays open for further actions like storing and
loading of curves and reporting until it is closed by the user. This
functionality allows to assemble subsets of customized measurements
without overloading the list in the “Measurement” menu.

Reporting on Sequence Results

A report on all executed measurements of the last run sequence is
prepared and displayed after the “Report Sequence” softkey has been
pressed. After the sequence window has been closed, a report on the last
sequence can be obtained by pressing the “Report last sequence” softkey
in the main window.
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Result Files

Measurement results are stored together with all associated data in XML
files. Separate files can be used for different projects or operators. They
can be archived together with other project data and re-opened later for
generating reports.

It is recommended to keep result files small and to generate backups at
frequent intervals.

$DUPY-K9y cdma2000(

File Data Calibration T
Cpen results File I

Save resulks m
Save resulks as _1
Mew resulks File 1
Load settings 1
Save settings 1
Save settings as 01

]|

Exit 1

i | T ozszvezn

Fig. 152 File menu

A new (empty) result file can be created with “File > New Result File” from
the main menu.

An existing result file can be opened with “File > Open Result File” from
the main menu.

A currently opened result file can be stored under a new name with “File >
Store results as” from the main menu.

Report Settings

With “Report > Settings” or “Options = Report settings”, a selection can be
made of data which should appear in the reports. Thus, information which is
the same for a larger number of measurements does not have to be printed
with every report again.

Generating a Single Report

A report on a single measurement result can be generated from the window
of a measurement macro by clicking or pressing the softkey “Generate
report”.

From the result overview of the main window, a report on a single
measurement can be generated by marking the row with the selected result
by clicking on the row header to the left, right-clicking into the data grid and
selecting “Generate report” from the context menu.

Subsequently data associated with the selected measurement is

127 E-2



1402.0643.12

Acoustic Measurements on Mobile Phones

assembled, a graph for existing curve data is generated, and the preview
window is opened. Depending on the amount of measurement data, this
may take a few seconds.

Selection Report

A report on a selection of measurements can be generated from the results
overview data grid in the main window by checking the rows with the
desired results in the “Select” column and choosing item “Report Selection
- Report Selected Results”. Rows checked in the “Select” column will be
added to the report. The selection can be toggled by clicking into the
respective “Select” cells.

' Create Repark For Marked Row FAIL RLR -
b Edit Comment of Marked Row PASS |RLR
! Delete Marked Fow FAIL  Sendi
' Save Curve of Marked Row as ... FAIL RLA -
: Report Selection Report Selected Results

? Sork Chronologically Select all

== Deselect all '
1 Sending \WEB

Delete Selected Results
4 Bersivinn WEH ——r

Fig. 153 Results context menu

Generating a Sequence Report

A report on a sequence of measurements can be generated from the
sequence window by clicking or pressing the softkey “Report sequence”.

Once the sequence window has been closed, a report on the last executed
sequence can be generated by selecting “Report > Last sequence” from
the main menu. Reports about previous sequences can be generated as
single reports on the measurements of this sequence, as all results appear
in the overview data grid in the main window.

Preview Window

$Report [_[Ofx]
F S B P W1 ne @ - CRYSTAL REPORTS
Main Report

Verdict: PASS

0+

20 i

Sending sensithity [dB re 1V/Pa)

4| : |

(Current Page No.: 1 Total Page Mo.: 1+ ‘Zoom Factor; 100%
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Fig. 154 Report preview window

The main area of the preview window shows a preview of the report as it
will be printed or appear in an exported PDF file. If the report comprises
more than one page, the pages can be browsed using the buttons

L

Alternatively, a page number can be directly entered in the page number
field

1 M+
To open the print dialog for installed windows printers click
3
To open a file selector for export of the report to Crystal Reports report

format, PDF, WORD, EXCEL, EXCEL-Data only format, Rich Text or
editable Rich Text format, click

iy

The scale of the document in the preview can be adjusted with

-

Page Width
Whale Page
F00°%
1 3005%
200%:
150%
100% "
F=k
7 S0%
25%

Customize. ..

Fig. 155 Scale menu of the preview window

Storing and Loading Curves from Measurement Windows

Measured curves can be stored from and loaded into the graph of a
measurement macro (see above). This allows easy import into
spreadsheets as well as direct comparison of curves measured at different
times or places. Measured curves can also be stored in a R&S UPV limit
file for use as a limit curve either in a R&S UPV sweep graph or in the
graph of a R&S UPV-K9/K92 window. This allows e.g. to derive tolerance
schemes from “golden devices”. The measured curve can be arbitrarily
shifted before being stored.
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Shift Curve by 0= dB

Cancel | )3

3

Fig. 156 Input window for defining a shift of a measured curve for storage
as limit curve

Storing and Loading Curves from the Results Overview

With menu item “Save Curve of Marked Row As ...” in the results context
menu it is possible to export curve data to ASCII files. If more than one
curve is present for the marked result, a selection window prompts to
choose the curve(s) to be saved to a file. The data can be saved in Tab
separated (*.txt) and comma separated (*.csv) format.

ASCII Result Files

When the item “Generate temporary export files” in the “Options” menu is
checked, the standard tests generate “abscurve.exp”, “relcurve.exp” and
“result.exp” files similar to those generated by UPL-B9. These files are

always deleted and overwritten by subsequent tests.

Deleting Results

It may be desirable to delete results of selected measurements from the
result file, e.g. because the measurement was repeated due to a missing
call to the mobile, a wrong setting etc. To delete the result of a particular
measurement, mark the row for the selected measurement in the data grid
of the main window by clicking on the row header to the left, right-click into
the data grid and select “Delete result” from the context menu. After
confirmation by the operator, the selected row of the result overview will be
deleted from the result file together with all associated data.

A set of results may be selected in the “Select” column of the results data
grid and commonly deleted using the context menu item “Report Selection
- Delete Selected Results”.
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Automatic Backup and Restoration of the Results File

In order to speed up the execution of sequences, the result file is only
saved when the program is closed. However, backups of the result file
called “*.xml~1" and “*.xml~2” are stored alternately after termination of
each single measurement and after termination of each sequence (**”
stands for the name of the results file without extension). If the program is
ended without closing it properly, or if the result file is not existing anymore,
the R&S UPV-K9 will by the time of its next start offer to restore the result
file from the latest backup file:

@Newer Backup File Found M= B3

The last session of this program has ended
prematurely. Mot all resulfs have been saved.

Last writing time of results file:
|H1 1/2007 4:12:11 PM|

Last writing time of backup file:
|H1 212007 9:40:08 AM

Wiould you like to backup the contents of the
resulfs file and restore the contents of the backup
file 7

No, keep results file | [ Yes, restore backup file |
.

Fig. 157 Restoration of data from backup file

If it is chosen to restore the result file from the backup, the supposedly
damaged result file is copied do “*.xmI~3” before the backup file is copied
to the original name of the results file.
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Preparations

- Start the K9y test program on the R&S UPV.

- In the “Options” menu, deactivate item “Show operator instructions” and
activate “Generate temporary export files”.

- If it is desired to download screenshots from the R&S UPV to the host,
activate also “Generate temporary image files” in the Options menu.

- Activate “Enable remote control” in the Options menu

- Do all necessary settings and calibrations as would be done for manual
control.

Starting a Measurement

A measurement can be started with remote command:

SYST:PROG:EXEC
'C:\ControlK9.exe D:\Phone\3G2 rcv_handset narrow nom.mdf.mdf

wherein “ControlK9.exe” is the client program controlling the application and
“D:\Phone\3G2_rcv_handset_narrow_nom.mdf’ specifies a file which
defines the test to be executed. A list of files for various tests is given
separately in the spreadsheed file “TestCaseList K9y 300.xls”. The file
name must be separated from the program name by a space character.
Thus it is recognized by the client program as a command line parameter.

Attention: Do not attempt to control the UPV-K9y software locally
while a remotely started test case is running.

Reading the Results

Result values and curves are available in memory buffers in the R&S UPV
firmware according to the following tables:
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Table 32 Assignment of string buffers for result values
String Buffers
1 Title <Tab> Date <Tab> Time
2 Total verdict
3 Result 1 heading
4 Result 1 value
5 Result 1 verdict
6 Result 2 heading
7 Result 2 value
8 Result 2 verdict
9 Margin 1 (upper) heading
10 Margin 1 (upper) value
11 Margin 2 (lower) heading
12 Margin 2 (lower) value
13 Margin 3 heading
14 Margin 3 value
15 Margin 4 heading
16 Margin 4 value
17 Delay heading
18 Delay value
19 Error message
20 Result 3 heading
21 Result 3 value
22 Result 3 verdict
23 Result 4 heading
24 Result 4 value
25 Result 4 verdict
26 Result 5 heading
27 Result 5 value
28 Result 5 verdict
29 Result 6 heading
30 Result 6 value
31 Result 6 verdict
32 Result 7 heading
33 Result 7 value
34 Result 7 verdict

String buffers can be queried using the remote command
SYSTem:MEMory:STRing<i>?

Table 33 Assignment of trace buffers for result curves
Trace Buffers

1 Result 1 (absolute) curve X values
2 Result 1 (absolute) curve Y values
3 Result 1 shifted / upper limit X values
4 Result 1 shifted / upper limit Y values
5 Result 1 lower limit X values
6 Result 1 lower limit Y values
7 Result 1 relative curve X values
8 Result 1 relative curve Y values
9 Result 2 (absolute) curve X values
10 Result 2 (absolute) curve Y values
11 Result 2 shifted / upper limit X values
12 Result 2 shifted / upper limit Y values
13 Result 2 lower limit X values
14 Result 2 lower limit Y values
15 Result 2 relative curve X values
16 Result 2 relative curve Y values
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Trace buffers can be queried using the remote command
SYSTem:MEMory:DATA<i>?

Results are also available in files “D:\Phonelresult.exp”, “D:\
Phone\relcurv.exp” and / or “D:\ Phone\abscurv.exp”, depending on the type
of measurement. If “Options - Generate temporary image files” is
activated, a screenshot of the last finished test is available in “D:\
Phone\lmage.TIF”. The command for the file transfer is (for the example of
the results file)

MMEM:DATA? 'D:\ Phone\result.exp '

All results are stored in the database. However, it is not possible to change
the test object remotely. The results can be identified later by the test time
given in the “result.exp” file.

Determining the Termination of a Measurement

A running test is indicated with bit 13 of the Operation register in the status
system set. It is recommended to configure a service request on the GPIB
for a negative transition of this bit:

STAT:OPER:NTR 8192

STAT:OPER:ENAB 8192

*SRE 128

A service request will be issued as soon as the test has terminated.

To avoid obsolete result files to be downloaded from the R&S UPV, existing
result files can be deleted before the start of the measurement, using the
commands:

MMEM:DEL 'D:\ Phone\result.exp'
MMEM:DEL 'D:\ Phone\relcurv.exp'
MMEM:DEL 'D:\ Phone\abscurv.exp'

Note that an attempt to delete a non-existing file will lead to an entry in the
error queue. The error queue can be flushed using the query “SYST:ERR?”
until the response is ‘0,’No error”. Alternatively existing files can be
overwritten by uploading empty files with the same name. Downloaded files
can then be checked for their size before they are processed further, to
determine whether they are empty dummy files.

For further details on remote control of the R&S UPV via GPIB and on the
remote commands mentioned above please see the user manual of the
R&S UPV.
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11Terminating the Application

The measurement can be terminated from the main window with the “Exit”
softkey. This causes the result file to be written to the hard disk.
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12Appendix A Settings on the Radio Communication Tester

Hardware and firmware requirements:

» The R&S®CMU200 must be equipped with option R&S®CMU-B41,
Audio Generator and Analyzer *.

» Firmware version 3.60 or later must be installed on the R&S®CMU200.

» An XLR-BNC adapter (1 male, 1 female) and two BNC cables for
connecting the R&S®CMU AUX connectors to the R&S UPV are
required. These adapters are part of R&S UPV-K9.

* If option R&S®CMU-B41 was not installed at the factory, internal FM auto-
calibration of the R&S®CMU200 must be run one time after installation.

Set all necessary AMPS settings in the AMPS menu of the R&S®CMU200.
To activate the external speech connection at AUX1 and AUX2, you must
switch AF Gen to ON and select external reference as the modulation
source:

» From the OVERVIEW menu, press AFMod.Gen.

» Press Mod.G.Deviation and set it to ON with the ON/OFF key (the
deviation value has no influence).

AMPS Overview ﬁ &
Control
. R
[T moduiation '139”’ - ] <[y Ho
——— Carier Freq Error - Bl -
m ——
| ——— Total Peak Deviation Boarcasatl M::—n
EEEEEE— DTX ca
——— SAT Frequency Error Bandwidth —
=== SAT Peak Deviation MEC — Analyzer
Dialled Nurnber |-~ Level
——— ST Frequency Error »Meas Contral
——— ST Peak Deviation Repetition Continuous
Stop Condition | Mone MS Signal
——— Audio Peak Deviation » Analyzer Level
——— RMS*SQRT(2) Dev. »gﬁbﬁl
L] Su wal
BS Signal
| = ! Carrier Power «AFiMod Generator | AF Mod
04 Em Control off on e
LeveliDeviation (2000 my 8000 Hz
LU AF Anatyzer Frequency 1004 Hz 1004 Hz AFModGen.
| 0.000 v AF Voltmeter »Filter SATIH
[«]
= eviatio

8000 Hez|

Fig. 158 AMPS overview menu of the CMU200

» Go to the Connection menu and press AF/RF.

» Using the Mod.Source key, select Mod.externRef.
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& AMPS Connection Control [g Signal On

AF Connector Overview RF Connector Setup
RF 30UT RF 2 RF 1

cy

RF
Qutput
Ext. Att.
+00a8 +00a8 +0.0 uB Output
RF
Input
Ext. Att.

RF 4IN RF 2 RF 1

G-

+00a8 +00a8 +0.0 a8

rssvgmf — |

Connection | Other Call | MSSignal | BSSignal | Network AFRF G| Sync. | M 2 |

Fig. 159 Selecting the modulation source for AMPS on the CMU200

Important: If the generator cannot be operated after Mod.externRef is
selected, the generator must first be switched on!

The program allows to measure the sending and receiving characteristics in
the AMPS mode. The measured loudness value as well as the frequency
response are displayed as in the digital mode. The contrast is the difference
between the measured loudness rating of the mobile in analog mode and in
digital mode. When an AMPS test is performed, the program automatically
scans the result data base for matching results in cdma mode (same device
under test, same kind of measurement). If such results exists, the latest of
them is retrieved and used for loudness contrast calculation.

The call must be established in the cdma mode. The standard settings are
SO3 8k Enhanced (low) (EVRC) codec. You should first perform both the
sending and receiving measurements in the cdma mode and then the
analog measurements in the AMPS mode, because the call is interrupted
after fallback from AMPS to cdma.
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(] CDMAZOO N;?:rrs\er. Overview

B CDMA2000nAPCcS Connection Control g

O
Accept All Calls

Speech Service

Service Option 3

8k Enhanced (Low)
200 s

Fig. 160 Voice coder settings for CDMA2000 on the CMU200

For the AMPS measurements in the Handoff menu, select the setting
AMPS fallback. After the HANDOFF key has been pressed, the
R&S®CMU200 makes a handoff to AMPS using the previously (in the
AMPS menu) selected AMPS parameters. The AMPS parameters can also
be set with the Destination Parameter key.

Ch. 1 CDMA200 NF‘)‘:‘:";”‘ Overview Ei l_h ’

= CDMA2000naPcSs Connection Control Connected

AMPS
CDMA2000 Cell. (Fallback)

CDMAZ2000 Cell. |2

Fig. 161 Selecting the fallback target on the CMU200
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- CDMAZOO N;c«:rger‘ Overview

& AMPS Connection Control § Handoff Preparation Call Pending

’

—

1 ¢h

2

Fig. 162 Setting the AMPS parameters for fallback on the CMU200

The connection from the R&S UPV to the R&S®CMU200 for the speech
signal must be changed for this measurement. The generator 2 output from
the R&S UPV must be connected with the AUX1 input of the R&S®CMU,
and the analyzer 2 input of the R&S UPV must be connected with the AUX2
output of the R&S CMU. To do this, remove the cable from the R&S UPV to
the R&S CMU speech connector and make the connections to the AUX
BNC connectors.

CDMA2000® is a registered trademark of the Telecommunications Industry
Association (TIA — USA).
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13Appendix B Settings on the Radio Communication Tester
CMW500

Hardware and firmware requirements:

» Besides the basic hardware, the R&S®CMW500 must be equipped with
option R&S®CMW-B400B, R&S®CMW-B405A, R&S®CMW-B200A,
R&S®CMW-B220A and R&S®CMW-PK80.

» Firmware Base version 3.2.70 or later, CDMA2000 version 3.2.83 or
later and Audio version 3.2.30 or later must be installed on the
R&S®CMW500.

» Two XLR-BNC adapters (1 male, 1 female) and two BNC cables for
connecting the R&S®CMW500 AF1 IN and AF 1 OUT connectors to
the R&S UPV are required. These adapters are part of R&S UPV-K9.

-AXI Audio

io External Analog Speech Analysis  ~

Speech

Analysis

Signaling: No Connection Connector: AR
Input Level Full-Scale (Peak): | 1.000V Output Level Full-Scale (Peak): 1,000V
High Pass Filter  BHz

Fig. 163 Audio measurement settings on the CMW500

The input and output full-scale peak levels must be set to the same values
as entered in “Calibration > Codec - CMW”. “Scenario” must be set to
“External Analog Speech Analysis”.
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Connection Status Base Station Control CDMA2000 1
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~~MS IPvE Prefix

Fig. 164 Example of CDMA2000 signaling settings on the CMW500

For narrowband acoustic tests either service option 3 or service option 68
COPO should be set. For wideband acoustic tests either service option 73
COPO or service option 70 COPO should be selected. The COP (codec
operating point) is set in the Config page of the CDMA2000 signaling

window.
17 Coma2000 Signating Confi )
‘Senice Configuration/Speech Service/Enh. Vs '_ bl mm m CDMAZ2000 1
— TX Meas
—Scenario Standard Cell
~~Enable Speech Codec 12
System CDMA2000 1
E:SIMC. Configuration Rt s
—Accept Speech Calls Accept All Calls -
—Accept Packet Calls Reject ato
Loopback Service
Speech Service
~Voice Coder Codec = I Routing
~~Echo Delay 0.02

%

EHEnh. Variable Rate Codec

-~ Average Encoding Rate
-~ Rate Restriction
Initialize Voice Coder

Test Data Service
-Packet Data Service
Network

Messaging (SMS)
Shortcut Softkey
Message Monitoring

~Encoder Operating Point (Rate ...

0
8.5 kbps ~
Aute -

Initialize |

||‘inry applicable for Service Option S068, SOT0, SO73

[ Connect |
15t SO |

Fig. 165 Example of CDMA2000 signaling configuration on the CMW500

“Enable Speech Codec” must be checked for establishing a speech
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connection with the speech codec from/to AF 1 In and AF 1 OUT
connectors.
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